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1 Troubleshooting Appeon Install
This section contains information about general troubleshooting issues that might be
encountered when installing Appeon for PowerBuilder. If you cannot resolve your problem
with this troubleshooting guide, please contact technical support at http://www.appeon.com/
support.

1.1 InstallShield Errors

1.1.1 Error 1607 or 1628

On the Appeon installation menu, when clicking a component installation link that will
launch InstallShield, the following error may occur: "1607: Unable to install InstallShield
Scripting Runtime" or "1628: Failed to complete installation".

Cause A: This error often occurs if you click Install on the Appeon setup program main page
twice when the Appeon component installation program is already running.

Solution A: Follow the steps below to fix the problem.

Step 1: Check how many installation processes are running. To do this, press Ctrl+Alt+Del
and select Task Manager. Go to the Processes tab in Windows Task Manager. Check
whether setup.exe is running and how many setup.exe processes are running.

Step 2: End all setup.exe processes and restart setup.exe. Do not run the Appeon component
installation program when the component installation program is already running.

Cause B: This error may also occur if previously the Setup program has exited with
exception.

Solution B-1: Restart your computer and attempt to install again.

Solution B-2: End the process of msiexec.exe and IDriver.exe and then run the Appeon
setup program again.

http://www.appeon.com/support
http://www.appeon.com/support
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Figure 1.1: Processes

For more causes and solutions, please refer to http://consumer.installshield.com.

1.1.2 Error 1155

During Setup, the error 1155 occurs, "1155: File ...\Appeon\appeon5.0 not found".

Cause: This error occurs because Appeon Setup failed to detect the ISScript8.msi file that is
used to install the InstallScript engine.

Solution: Find the ISScript8.msi file in the directory \Install\AppeonComponent\ (for
example, \Install\ADT\) and double-click it to run the InstallScript engine installer.

1.1.3 DLL function call crashed error when launching an Appeon setup
program

Cause: This error is not caused by an Appeon installation program. It is often system-related.

Solution: Please go to the following Website and search for the error message. Detailed
information and solutions are provided: http://consumer.installshield.com/default.asp.

1.1.4 Setup crashed when clicking Browse during Appeon Developer
installation

The Appeon Setup program exits when you click the Browse button to select the installation
location for the Appeon Developer.

http://consumer.installshield.com/
http://consumer.installshield.com/default.asp
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Cause: This issue is caused by the idriver.exe file of InstallShield (usually in C:\Program
Files\Common Files\InstallShield\Driver\8\Intel 32). The idriver.exe file might be corrupted
or incompatible.

Solution: Replace the problematic idriver.exe file with the one copied from another machine.

1.2 Install Appeon Server to .NET IIS

1.2.1 IIS configuration

The IIS configuration may affect Appeon Server. Verify the IIS settings according to the IIS
version that Appeon Server is installed.

1.2.1.1 IIS 7.0 or 7.5

If Appeon Server is running on IIS 7.0 or 7.5, verify the .NET Trust Levels is set to Full
(internal) for AEM, Appeon, and Servlet views respectively in IIS Manager. Following is an
example of how to verify the .NET Trust Levels for AEM view, you can follow the similar
steps to verify for Appeon view and Servlet view.

Step 1: Open IIS Manager, click Web Sites > DefaultWebSite > AEM, and double click
.NET Trust Levels.

Figure 1.2: .NET Trust Levels

Step 2: Verify that  Full (internal) is selected.
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Figure 1.3: Full (internal)

1.2.1.2 IIS 6.0

If Appeon Server is running on IIS 6.0, verify the following IIS settings after the Appeon
Server installation:

Step 1: Verify that the running mode of IIS is Worker Process Isolation Mode.

• Open IIS Manager, right click Web Sites and select Properties.

• In the Web Sites Properties window, select the Service tab, and make sure the "Run
WWW service in IIS 5.0 isolation mode" option is not selected.
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Figure 1.4: Service

Step 2: In Web Service Extensions, verify that ASP.NET v4.0.30319 is set to Allowed.
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Figure 1.5: Web Service Extensions

Step 3: Verify that the ASP.NET version of the AEM, Servlet, and Appeon virtual directories
is 4.0.

The Appeon virtual directory is automatically configured during the Appeon Server
installation.

Follow instructions below to check the ASP.NET version of the Servlet virtual directory. The
steps to check the AEM virtual directory are similar.

• Right click Servlet under the Web site and select Properties.

• In the servlet Properties window, select the ASP.NET  tab and check the ASP.NET
version setting.
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Figure 1.6: ASP.NET

Step 4: Verify the application pool settings of AppeonAppPool for Appeon Server. By
default, AppeonAppPool is automatically configured during the Appeon Server installation.
It is not recommended to change the default settings.

During the runtime of an application, information such as user sessions and database
transaction will be stored in the memory. If Appeon Server is restarted, the information will
be lost, which results in the failure of the application. Besides that, in order to guarantee the
completeness of the information, Appeon Server cannot be run in multiple processes. Follow
steps below to configure the application pool for Appeon Server:

• Right click AppeonAppPool and select  Properties.

• In the AppeonAppPool Properties window, make sure the following settings are not
selected in the Recycling tab.
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Figure 1.7: Recycling

• Select the Performance tab. Verify that the Idle timeout setting is not selected, and the
Web garden value is set to 1.
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Figure 1.8: Performance

• Select the Health tab. Verify that the Enable pinging and Enable rapid-fail protection
settings are not selected.
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Figure 1.9: Health

Step 5: Verify the Web site properties.

• Right click the Web site where Appeon Server is installed, and select Properties.

• In the Web site properties window, select the  Home Directory tab. Verify that the
Execute permissions is set to "Scripts only" or "None" (not "Scripts and Executables").
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Figure 1.10: Home directory

1.2.2 Full access rights to IIS Web root

Follow steps below to check if IIS_IUSRS account is granted with full controls to the IIS
Web root folder:

Step 1: Right click C:\Inetpub\wwwroot and select Properties from the popup menu.

Step 2: On the Security tab, select IIS_IUSRS in the Group or user names list box, and
then check if Allow is selected for Full control in the Permissions for IIS_IUSRS list box.
If not, click the Edit button and follow Step 3 to grant full control.
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Figure 1.11: Security

Step 3: Select IIS_IUSRS in the Group or user names list box, and then select the Allow
check box for Full control. Click OK to save the settings.
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Figure 1.12: Grant full control

1.2.3 Enable 32-bit .NET framework on 64-bit Windows

If you have installed a 32-bit Appeon Server on a 64-bit Windows operating system, and
Appeon Server is not working properly, it is probably the 32-bit .NET framework is not
configured successfully by the Appeon Server setup program. You may need to manually do
the following configuration to enable it.

1.2.3.1 IIS 7.0 or 7.5

Step 1: Launch IIS Manager, expand the local computer, click Application Pools in the left
pane, right-click Application Pools in the right pane, and then click Advanced Settings....
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Figure 1.13: Application pools

Step 2: In the Advanced Settings window, set the Enable 32-Bit Applications to True.
Click OK.
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Figure 1.14: Advanced settings

1.2.3.2 IIS 6.0

Step 1: In the command prompt, go to the installation path of the .NET Framework where
Appeon Server installs, for example C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319.

Step 2: Execute the following command. The 32-bit Application pool is successfully enabled
if the Enable32BitAppOnWin64 is shown as True.

cscript.exe C:/inetpub/AdminScripts/adsutil.vbs set
    W3SVC/AppPools/Enable32BitAppOnWin64 "true"
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Figure 1.15: Execute the command

Step 3: Type the following command to install the version of ASP.NET and to install the
script maps at the IIS root and under:

%SYSTEMROOT%\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis.exe -i

Step 4: Make sure the status of ASP.NET version v4.0.30319 (32-bit) is set to Allowed in the
Web service extension list in IIS Manager. For details, refer to IIS 6.0 configuration.

1.3 Install Appeon Server to EAServer

1.3.1 EAServer cannot be started after Appeon Server install

Cause: There are two sets of EAServer 6.1/6.2 installed; one EAServer was installed
independently in the normal installation path, and the other was silently installed with
Appeon Server installation.

Solution: It is recommended that you use the EAServer that was silently installed with
Appeon Server.

Step 1: Open the setenv.bat file in the bin folder under the EAServer installation directory in
a text editor and make sure JAGUAR_HOST_NAME in the file is the same as the computer
name.

Step 2: Verify that EAServer is not started as a Service. If it is started as a service, stop it and
change the starting mode to "Manual".

Step 3: If EAServer runs on Windows, start EAServer from Windows Start > Programs >
Appeon for PowerBuilder 2016 > Appeon Server > InstanceName. If EAServer runs on
UNIX, run the appeonserverstart.sh script in the $JAGUAR/appeon/bin directory.
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1.4 Install Appeon Workspace

1.4.1 "Cannot install application because the certificate for *** is not valid"
when installing Appeon Workspace on iOS 7.1 device

On a device running on iOS 7.1, the following error occurs when downloading Appeon
Workspace from the Appeon Workspace download center or the AEM login page.

Figure 1.16: Install error

Cause:

With the launch of iOS 7.1, Apple requires the enterprise apps manifest file (.plist) to be
served over HTTPS. Attempts to install through HTTP cause the above message.

Analysis:

Actually only the .plist file needs to be served by HTTPS, the .ipa file does not. Therefore,
you do not need to modify the .plist file, but only need to modify the OTA link to point
to the HTTPS link of the .plist file, for example, itms-services://?action=download-
manifest&url=https://app.xxx.com/AWS/6.8.0110.00.plist.

In downloadaws_template.html, the OTA link actually displays as 'itms-services://?
action=download-manifest&url=' + ios_mobile_url, where you need to modify the value of
"ios_mobile_url" to like this: https://app.xxx.com/AWS/6.8.0110.00.plist. With this change,
iOS 7.1 will allow you to download and install Appeon Workspace. In fact, iOS 7.1, iOS 7
and iOS 6.x all support the OTA link over HTTPS, which means if you make this change, it
will work for all iOS devices.

Solution A:

This new requirement for HTTPS on the Web server is introduced by Apple iOS 7.1 and it
cannot be worked around by Appeon Mobile. The solution is either to configure the Web
server to support HTTPS, or use a public HTTPS-enabled Web server like DropBox to work
around this requirement.

Step 1: Configure to allow the .plist file to be accessed by HTTPS.

There are two ways to do this:

• Install the SSL certificate on the Web site, and then add an HTTPS port to the Web site
that hosts Appeon Workspace.

The HTTPS URL of .plist will change to https://app.xxx.com/AWS/6.8.0110.00.plist.

Note: The default HTTPS port is 443. Therefore, the following two URLs work the same:

https://app.xxx.com/AWS/6.8.0110.00.plist

https://app.xxx.com:443/AWS/6.8.0110.00.plist
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It is also important to aware that you cannot use a self-signed certificate to bindings
HTTPS port unless the device trusts the CA it came from. You either need to use a "real"
SSL certificate or you need to import and trust the certificate on any devices that will
install the app.

Figure 1.17: Configure HTTPS port

• If you do not want to apply for an SSL certificate in the Web site, you can work around
this by taking advantage of DropBox to host the .plist file. Detail steps are below.

1. Upload your .plist file to DropBox. Suppose the file name is 6.8.0110.00.plist.

2. Get shared link of your .plist file, such as https://www.dropbox.com/
s/0oef1fmmjsuj5hf/6.8.0110.00.plist.

3. Replace www.dropbox.com with dl.dropboxusercontent.com in the shared link.
So the HTTPS URL of your .plist file will be https://dl.dropboxusercontent.com/
s/0oef1fmmjsuj5hf/6.8.0110.00.plist.

Step 2: Back up the downloadaws_template.html file under the aws folder (C:\inetpub
\wwwroot\appeon\aws), and then change the value of "ios_mobile_url" in this file to point to
the HTTPS URL of the .plist file. For example,

Change from
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var ios_mobile_url = web_server + '/' + filename + '.plist';

To this (when .plist is on your own Web server):

var ios_mobile_url = 'https://app.xxx.com/AWS/6.8.0110.00.plist';

Or to this (when .plist is on DropBox):

var ios_mobile_url = 'https://dl.dropboxusercontent.com/
s/0oef1fmmjsuj5hf/6.8.0110.00.plist';

Step 3: Access AEM using IP address or host name in the IE browser such as http://
demo.appeon.com/AEM. Do not use localhost such as http://localhost/AEM. Once the AEM
login page is opened, Appeon Server will automatically update the downloadaws.html file in
the aws folder.

Now any iOS-based device can successfully download and install Appeon Workspace via this
HTTPS URL.

Note: If you are currently using the version 2013 R2 build 0110.00, then you will need to
be aware that the above changes will resolve the download button in the Appeon Workspace
download center, but will not resolve the download link in the AEM login page, which
means, if you download Appeon Workspace from the Appeon Workspace download center,
this problem is resolved, however if you download Appeon Workspace from the AEM login
page (as shown below), this problem still persists.

Figure 1.18: AEM login page (in 2013 R2 build 0110.00)

Solution B:

If you do not want to configure the SSL certificate on your Web server or use DropBox to
work around the requirement, you can download the .ipa file to the PC through IE browser
(for example, you can download the .ipa file from the Appeon Workspace download center
(e.g. http://hostname/aws/), and then synchronize it from the PC to the iOS device using
iTunes.
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1.5 Install Appeon File Server

1.5.1 Appeon File Server Installation Incomplete

Cause: The Appeon File Server installer was interrupted before Appeon File Server could be
installed, as shown in the following figure.

Figure 1.19: Installation incomplete

Solution A: Restart the installer and try again.

Solution B: Turn on the IIS 6 Management Compatibility features.

For Windows 2008 R2: Go to Control Panel > Administrator Tools > Server Manager >
Roles > Web Server, expand the Role Service node in the right pane, and then select IIS 6
Management Compatibility.

For Windows 7: Go to Control Panel, click Programs and Features, click Turn Windows
features on or off, expand Internet Information Services > Web Management Tools >
IIS 6.0 Management Compatibility > Web Server, and then select IIS 6 Metabase and
IIS 6 configuration compatibility, IIS 6 WMI Compatibility, and IIS 6 Management
Console.

1.6 Install Appeon Server Web Component

1.6.1 Third-party Web Server problems with the SAP Sybase redirector plug-in

If you use a third-party Web server such as Apache or IIS, you may find that the SAP Sybase
redirector plug-in does not work for the Web server.

Cause: It is very likely that a step has been omitted during the configuration of the third-
party Web server or the plug-in.

Solution: Follow the troubleshooting instructions provided by SAP Sybase at http://
www.sybase.com/detail?id=1024955 or refer to the EAServer System Administration Guide.

1.7 Upgrade Installation

1.7.1 "Bad interpreter: No such file or directory" error

When you execute install.sh or upgrade.sh on a Unix/Linux system, the error "Bad
interpreter: No such file or directory" comes up.

http://www.sybase.com/detail?id=1024955
http://www.sybase.com/detail?id=1024955
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Cause A: The installation package is uploaded to the Unix/Linux system in the non-binary
transfer type.

Solution A: Select to transfer the installation package to the Unix/Linux machine in Binary
transfer type.

Cause B: The SH file was edited and saved on a Windows machine.

Solution B: Execute the command dos2unix install.sh/upgrade.sh on the Unix/Linux system,
which can convert the file type so as to make it work on the Unix/Linux system.

1.7.2 Error 14004 "The license file is missing"

Error 14004 saying "The license file is missing" occurs when upgrading the Appeon Server.

Cause: This issue only exists in Appeon 6.5.1 for .NET or earlier versions. When there are
server instances installed before, the server instances will not be upgraded during the upgrade
process.

Solution: Use the Appeon Server Instance Configuration Wizard to delete all installed
instances from the Appeon Server and then re-install these instances. See Installation Guide
for .NET for detailed instructions.

1.8 Frequently Asked Questions

1.8.1 How to install Appeon Server to multiple EAServer instances?

During the Appeon Server installation, you can only install Appeon Server to one EAServer
instance. However, after the installation, you can manually install Appeon Server to other
instances using EAServer Manager:

1. Under EAServer Manager, select Servers > server instance (for example, "server2") >
Installed Applications, right click it and select Install Application from the popup menu.
The Application Wizard launches.

2. Click Install an Existing Application.

3. On the Install Applications dialog, select "AppeonServer" and click OK.

1.8.2 How to bind server instance to CPU?

Appeon Server installation program will not bind the instance to CPU. You must manually
bind it with the following steps:

Open Windows Task Manager, select the Processes tab, select the server process, such as
jagsrv.exe, right click it and select Set Affinity from the popup menu to bind the process to
one or more CPU.

Or you can use the Appeon Server Status Monitor to automatically bind the server instance to
CPU using the "com.appeon.server.monitor.instance.cpus" setting. For detailed instructions,
refer to the Section 3.2, “Configuring Status Monitor” in Appeon Server Configuration Guide
for J2EE.
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1.8.3 How to create EAServer instances?

For detailed instructions, refer to the EAServer document at http://infocenter.sybase.com/
help/index.jsp. Select EAServer 5.3 > System Administration Guide > Creating and
Configuring Servers.

Below are the general steps:

1. Under EAServer Manager, select Servers, right click it and select New Server from the
popup menu. The New Server dialog opens.

2. Input the server name, for example, server2, and click Create New Server. Click OK to
close the Server Properties window.

3. Create HTTP and IIOP listener for the new instance: Select Servers > server instance (for
example, "server2") > Listener, right click it and select New Listener. Input the listener
name, and click Create New Listener. Specify the protocol, port and host for the new
listener.

1.8.4 How to start the server instance?

Use the following command: serverstart.bat -jdk14 -jvmtype server -servername

For detailed instructions, refer to the EAServer document at http://infocenter.sybase.com/
help/index.jsp. Select EAServer 5.3 > System Administration Guide > Creating and
Configuring Servers > Starting the server.

1.8.5 How much better is the performance when multiple instances are used?

Multi-instance scenario supports concurrent users by multiple times when the number of
servers is the same and provides much better performance when the number of concurrent
users is the same. Our tests on a customer project with 100 concurrent users show that the
average response time for two instances binding to two CPUs is eight times faster than that
for single instance binding to single CPU.

1.9 Need more help?
If you could not find a solution for your problem, it could be because it is a new problem or
an intricate problem that happens only under specific circumstance or environment. In both
cases, it is highly recommended that you follow steps below to generate and send the log file
to us for investigation.

Step 1: Go to the Appeon folder in the installation package, open the Product.ini file in
the text editor, find the RecordDllLog parameter in this file and set the value to 1 (this will
enable the logging functionality), by default the value is 0 (which disables logging).

For example:

[DllLog]
RecordDllLog=1

Step 2: Run the installation package and reproduce the installation error.

Step 3: Go to …\System32\AppeonInstallLog (or …\SystemWOW64\AppeonInstallLog\ in
64-bit machine) and find the log files there.

http://infocenter.sybase.com/help/index.jsp
http://infocenter.sybase.com/help/index.jsp
http://infocenter.sybase.com/help/index.jsp
http://infocenter.sybase.com/help/index.jsp
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Each Appeon component will have a separate log file, for example, AppeonADT2014.txt for
Appeon Developer, AppeonDNS2014.txt for Appeon Server.
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2 Troubleshooting Appeon Developer
This section deals with troubleshooting issues in Appeon Developer. If you cannot resolve
your problem with this troubleshooting guide, contact technical support. For technical
support information, visit http://www.appeon.com/support.

2.1 Operating Appeon Developer toolbar

2.1.1 Appeon Developer toolbar does not respond when run by a non-
administrator

When UAC is on, if you run PowerBuilder under a non-administrator login account the first
time after you install Appeon Developer or register the Appeon Developer toolbar (by using
the ADT Register tool), the Appeon Developer toolbar does not respond when you click it in
PowerBuilder. And when you exit PowerBuilder, you will be prompted with the following
dialog box, and then when you open PowerBuilder again, the Appeon Developer toolbar
works normally.

Figure 2.1: Program Compatibility Assistant

Solution A: Run PowerBuilder in the "Run as administrator" mode. After the first time, you
can run PowerBuilder in the normal mode.

Solution B: Choose Windows Start > All Programs > Appeon for PowerBuilder 2016  >
Appeon Developer > Appeon Toolset.

Solution C: Exit PowerBuilder and run it again. The Appeon Developer toolbar works
normally except for the first time. Note that this solution does not work on Windows 8.

2.1.2 "ADT is already running" error

If you immediately click an Appeon Developer toolbar icon after canceling the processing of
the deployment wizard, an "ADT is already running" error message pops up.

http://www.appeon.com/support
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Cause: The Appeon Developer execution program EonADT50.exe is not promptly killed
when the Cancel button is clicked.

Solution: Wait a minute, and then click the toolbar icon.

2.1.3 Exiting Appeon Developer completely after an error

When an error occurs during an operation in Appeon Developer, you may want to exit
Appeon Developer completely before restarting the operation.

Solution: Kill all of the following execution files in the task manager: EonADT61.exe,
EonCIS60.exe, EonADeploy60.exe, EonDWSQL80J.exe (or EonDWSQL90J.exe, or
EonDWSQL100J.exe, orEonDWSQL110J.exe), EonDWSQL80.exe (or EonDWSQL90.exe,
or EonDWSQL100.exe, or EonDWSQL110.exe), EonPerReport60.exe, Eoninfomng60.exe,
EonJsLog60.exe, screnc.exe and EonUFATool60.exe.

2.2 Appeon Developer Configuration

2.2.1 Testing connection fails during DB Type Profile configuration

In Appeon Developer Configuration, when creating or modifying a DB Type profile
after specifying an Oracle database as the data source for the DB Type profile, testing the
connection will fail for the profile. However, the data source can be successfully connected in
the ODBC Data Source Administrator.

Cause: The ODBC driver used for the data source is not a dedicated driver for connecting to
an Oracle database.

Solution: Use either of these drivers for connecting to an Oracle database: Oracle in
OraHome920 or Microsoft ODBC for Oracle.

2.2.2 "Error launching LoadConfig"

The "Error launching LoadConfig" message is displayed when the user changes the settings
in Appeon Developer Configuration or performs Task 2 of Appeon Deployment Wizard.

Cause & Solution: Refer to "Error launching LoadConfig".

2.3 Feature Analysis

2.3.1 "The XML page cannot be displayed" when opening a UFA report

When a UFA report is opened in Internet Explorer, the page displays an error message "the
XML page cannot be displayed". The page also gives the following description in bold
"Microsoft JScript runtime error Automation server cannot create object".

Cause A: The Internet Explorer used to open the UFA report is version 5.5 or earlier.

Solution A: Upgrade to the Appeon-certified Internet Explorer version: Internet Explorer 8.0
or above.

Cause B: The version of Internet Explorer is 6.0 SP2, which by default does not allow active
content to run.
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Solution B: Go to Internet Options > Security in Internet Explorer, make sure the option
"Allow active content to run in files on My Computer" is enabled.

2.3.2 "Error loading ADTObjectList.xml"

After Feature Analysis starts, it hangs and the following error message is displayed
in the analysis status window: "Error loading ADTObjectList.xml". However, upon
verification, the ADTObjectList.xml file exists in the folder: \Appeon\Developer2016\Project
\ApplicationName (indicating the application profile name)\Debug (or Release).

Solution: Delete the entire folder. Run the Feature Analysis again.

2.3.3 "Error loading command string"

While running Features Analysis, or Appeon Deployment, an error message box pops up and
displays "Error loading command string".

Cause: This error typically occurs when the DataWindow syntax is not in the expected
PowerBuilder 9 or later format.

• The application has not been built or upgraded with PowerBuilder 9 or later.

• When the application is upgraded with a higher PowerBuilder version, some "old" syntax
may still be included. This is because PowerBuilder provides backwards compatibility, but
Appeon may not support the "old" syntax.

Solution A: Follow the steps below to fix the problem.

Step 1: Verify that no unsupported identifiers are used in the application.

Step 2: Remove or modify the problematic object(s) that contains "old" syntax from the
PowerBuilder application by following the instructions in How to locate problematic objects
in an application.

Step 3: Terminate Appeon Developer. Terminate the EonADT62.exe process if they are still
running in the Windows Task Manager.

Step 4: Run Feature Analysis/Appeon Deployment again.

Solution B: Try the following steps if the problem is not resolved using Solution A.

Step 1: Delete the application profile in Appeon Developer Configuration.

Step 2: Delete the entire application folder under the Appeon Developer installation
directory: \Appeon\Developer2016\Project\ApplicationName (indicating the application
profile name).

Step 3: Terminate the EonADT62.exe processes if they are still running in Windows Task
Manager.

Step 4: Recreate the application profile in Appeon Developer Configuration.

Step 5: Perform the desired Appeon function (Feature Analysis/Appeon Deployment) on the
application profile again.

Solution C: If the problem is not resolved with Solution B, try the following steps.
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Step 1: Uninstall Appeon Developer from Windows Control Panel > Add/Remove programs,
or run the Uninstall program.

Step 2: Delete the entire Appeon Developer folder where Appeon Developer is installed, for
example, C:\Program Files\Appeon\Developer2016.

Step 3: Reinstall Appeon Developer and reconfigure Appeon Developer's settings in Appeon
Developer Configuration, such as the application profiles, server profiles and deployment
profiles.

Step 4: Set the transaction object mapping to the correct data sources for the application in
AEM > Application > Transactions > Transaction Objects.

Step 5: Verify that Appeon Server (EAServer extended with Appeon Server components) is
running and accepting connections.

Step 6: Perform the desired Appeon function (Feature Analysis/ Appeon Deployment) on the
application profile again.

2.3.4 Feature analysis or deployment comes to a standstill

During Unsupported Feature Analysis or Task 2 of the Appeon Deployment Wizard, the
user can see the "Start searching for related objects..." message normally displayed in the
status window. However, the program does not proceed. The EonADT50.exe process is still
running in the Windows Task Manager.

Cause: One or more of the Appeon Developer configuration files may have become corrupt.

Solution: Follow the steps below to fix the problem.

Step 1: End the EonADT50.exe process using Windows Task Manager.

Step 2: Delete all Appeon-generated application files on both the Appeon Developer machine
and the Web Server.

• On the Appeon Developer machine, delete all files in the directory: \Appeon
\Developer2016\Project\ApplicationName.

• On the Web Server, delete all files in the application's deployment path (specified
in Appeon Developer Configuration > Application Profiles > ApplicationName >
Application Profile Configuration > Basic Settings).

Step 3: Configure the Transaction Objects for the application in AEM Console >
Application > Transactions > Transaction Objects.

Step 4: Run Feature Analysis or Appeon Deployment again.

2.3.5 "This application has requested the Runtime to terminate it in an unusual
way" error, when you deploy or analyze an application

When deploying or analyzing an application, you will receive a system runtime error message
"this application has requested the Runtime to terminate it in an unusual way".

Cause: This is often caused by limited hard drive space.

Solution: Clean up the hard drive space to successfully run Appeon.
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2.3.6 "Error opening DLL Library adtxml.dll for external function"

The application analysis stops and an error occurs. The error message displayed is "Error
opening DLL Library adtxml.dll for external function"

Cause: Selecting the native interface option when you configure the DB type profile in
Appeon Application configuration window.

Solution: To solve the problem, reinstall the Appeon Developer.

2.4 Appeon Debugger

Solutions for the following Appeon Debugger problems:

• "Script Debugger Component Not Found" error

• "Component Not Registered" error

• "Script Debugger Disabled" error

2.4.1 "Script Debugger Component Not Found" error

When clicking the Appeon Debugger button on the Appeon Developer toolbar, the "Script
Debugger Component Not Found: 03513: Please install the Microsoft script debugger" error
occurs.

Cause 1: Appeon Debugger requires Microsoft script debugger to be installed, but no
Microsoft script debugger is installed on the computer.

Solution: Verify that script debugger is installed. If you do not have any script debugger
installed, choose an appropriate one at Microsoft Website.

Cause 2: Microsoft script debugger is installed however it is not correctly installed probably
due to the limited permissions, and as a result, the directory C:\Program Files (x86)\Microsoft
Script Debugger does not exist.

Solution: Right click the Microsoft script debugger installer and then choose Run as
administrator from the popup menu to reinstall Microsoft script debugger. If this solution
does not work, please try the following steps:

1. Go to Internet options > Advanced tab in Internet Explorer, and click the Restore
advanced settings button and then the Reset button.

2. After reset the Internet Explorer settings, go to Internet options > Advanced tab and de-
select the setting: Disable script debugging (Internet Explorer).

2.4.2 "Component Not Registered" error

When clicking the Appeon Debugger button on the Appeon Developer toolbar, the
"Component Not Registered" error occurs.

Cause: Appeon Debugger needs to use Microsoft script debugger. However, although
Microsoft script debugger has been installed, the required components are not registered.
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Solution: Reinstall the Microsoft script debugger.

2.4.3 "Script Debugger Disabled" error

When clicking the Appeon Debugger button on the Appeon Developer toolbar, the "Script
Debugger Disabled" error occurs.

Cause: Appeon Debugger needs to use Microsoft script debugger. However, although
Microsoft script debugger is available to use, script debugging is disabled in Internet
Explorer.

Solution: Enable script debugging in Internet Explorer: Go to Internet Options > Advanced
in Internet Explorer, de-select the option under Browsing: "Disable script debugging" in
Windows 2000 and 2003.

2.5 Package Tool

2.5.1 "Failed to build the native mobile app" error when creating the Android
APK package

When you use the Appeon Package tool to create the Android APK package, the following
error occurs during the packaging process: "Failed to build the native mobile app!".

Solution:

Step 1: Make sure the settings (especially the following ones) are correctly specified in the
Package tool.

• App Identifier should be specified in the format similar to the domain name e.g.
sales.appeon.com. It can only contain letters, or a combination of letters with dots, and/or
numbers without spaces, but cannot start or end with dots and contain numbers between
dots.

• Both the Alias and Alias Password settings should match with the keystore file that you
specified to use. If you use the default keystore file provided by Appeon, the values of both
fields should be appeon.

If the settings are correct, then the JDK under the Appeon developer directory is possibly
destroyed, which causes this error.

Step 2: Run the command below in the cmd window to check if the JDK under the Appeon
developer directory is working.

cd C:\Program Files\Appeon\Developer2016\Java\Jdk1.6.0_24\bin
java

The execution result of the command should look similar to that in the following figure.
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Figure 2.2: JDK Java command

If the execution result is different from what is shown in the figure, the JDK is probably
destroyed. In this case, we would recommend you to reinstall Appeon Developer or copy
a valid JDK into the Appeon Developer directory such as "C:\Program Files\Appeon
\Developer2016\Java\Jdk1.6.0_24". If you choose to copy a JDK to the Appeon Developer
directory, please pay attention to the following two notes:

• The directory structure of the JDK to be copied to the Appeon Developer directory should
be consistent with that of the JDK to be replaced, otherwise Appeon Developer cannot call
JDK properly.

• The version of the JDK to be copied to the Appeon Developer directory cannot be lower
than 1.6.0_24. You can execute the command "java –version" under the bin folder of the
JDK to check its version information, as shown below.
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Figure 2.3: JDK Java version command



Troubleshooting Web Deployment Appeon® for PowerBuilder® 2016

Troubleshooting Page 32

3 Troubleshooting Web Deployment
This section contains information about general troubleshooting issues related to Appeon
Web application deployment. If you cannot resolve the problem with this troubleshooting
guide, please contact technical support at http://www.appeon.com/support.

3.1 Deployment Performance

3.1.1 Unusual deployment duration

In some cases, you may find that the deployment of an application takes longer than you
expected.

Cause: The application has not been fully built in PowerBuilder before Web deployment.

Solution: Perform a "full build" for the application, and then deploy it using the Appeon
Deployment Wizard.

3.2 Failed to deploy applications

You may encounter a deployment failure and an error occurred saying Failed to generate
DWSQL in the Log of Deployment Wizard, as shown in the figure below.

Figure 3.1: Failed to deploy applications

Cause: This is probably caused by using an earlier PowerBuilder version.

Solution:

Step 1: Upgrade your PowerBuilder to the latest PowerBuilder version. For example, if you
are using a PowerBuilder 10.5, then upgrade it to the latest PowerBuilder 10.5 version.

Step 2: Test to ensure that the Database Connection in Appeon Developer Configuration >
DB Type Profiles is successful.

Step 3: (Recommended) Full build your PowerBuilder application.

Step 4: Go to \%Developer%\Project\your_application\release or debug\dwsql\dwsql.log to
get the last record, empty compiled this DataWindow in PowerBuilder (Add a character and
delete this character in the edit source of PB).

Step 5: Deploy your application again.

http://www.appeon.com/support
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3.3 Failed to deploy applications in server console

When deploying an application (such as the Appeon Web application or Appeon file service)
in the server console (such as WebLogic, WebSphere, JEUS etc.), sometimes you receive an
error message, similar to the message below thrown by WebSphere 7 console:

Messages
The EAR file could be corrupt and/or incomplete. Make sure that the application is 
at a compatible Java(TM) 
Platform, Enterprise Edition (Java EE) level for the current version of
 WebSphere(R) 
Application Server.
com.ibm.websphere.management.application.client.AppDeploymentException: 
[Root exception 
is org.eclipse.jst.j2ee.commonarchivecore.internal.exception.SaveFailureException: 
application.htm]

Cause: the WAR/EAR/JAR file compressed via one tool cannot be successfully de-
compressed by the other tool during deployment process in the server console.

Solution A: Use Winzip or WinRAR to compress the files again if Winzip or WinRAR is
installed. Detailed steps are below:

Step 1: Go to the Web root path that you specified in Web Server Profile Configuration
windows in Appeon Developer Config tool.

Step 2: Find the WAR file of the Web application, for example, appeondemo.war.

Step 3: Extract the WAR file to any folder, for example, to C:\appeondemo.

Step 4: Compress all the files in the folder to a WAR file again with the same WAR name
(appeondemo.war). Compression tools such as Winzip and WinRAR are recommended,
please use the tool and zip the files with default settings. Tools such as 7-Zip are not
supported, please do not use the tool.

Step 5: Manually deploy the WAR file in the server console again.

Solution B: Use JDK to compress the files again if JDK is installed. Detailed steps are
below:

Step 1: Go to the Web root path that you specified in Web Server Profile Configuration
windows in Appeon Developer Config tool.

Step 2: Find the WAR file of the Web application, for example, appeondemo.war.

Step 3: Extract the WAR file to any folder, for example, to C:\appeondemo.

Step 4: Compress all the files in the folder to a WAR file again with the same name
(appeondemo.war) by using the following commands:

cd C:\appeondemo
C:\Program Files\Java\jdk1.5.0_15\java.exe  jar –cvf appeondemo.war *.*

Step 5: Manually deploy the WAR file in the server console again.

Solution C:

If you are deploying the Appeon Web application (not the Appeon file service), then you
could also use an Appeon Developer feature to compress files via JDK (prerequisite is that
JDK is installed on the Appeon Developer machine):
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Step 1: Open the Web Server Profile Configuration window from the Appeon Developer
Config tool, in the File Compression Settings for War/Jar group box, select "JDK
Compression" and specify the JDK path. This will enable Appeon Deploy tool to compress
files by using JDK on the Appeon Developer machine.

Step 2: Deploy the application via the Appeon Deploy tool. The WAR/EAR/JAR file
compressed via JDK on the developer machine should be successfully de-compressed by
JDK on the server machine.

3.4 Failed to deploy Web applications in 64-bit JEUS server

A file parsing error occurs in 64-bit JEUS server console when deploying the Appeon6.5-
deployed-Web applications.

Cause: The application configuration file web.xml cannot be parsed by JEUS.

Solution: Step 1: Go to the Web root path that you specified in Web Server Profile
Configuration windows in Appeon Developer Config tool.

Step 2: Find the WAR file of the Web application, find the folder "WEB-INF" and extract
web.xml.

Step 3: Modify the following line in web.xml:

<web-app version="2.4" xmlns="http://java.sun.com/xml/ns/j2ee">

To

<web-app version="2.5" xmlns="http://java.sun.com/xml/ns/javaee">

Step 4: Use the modified web.xml file to replace the old one under "WEB-INF" folder.

Step 5: Manually or automatically deploy the WAR file in JEUS console again.

3.5 Task 1: Application Source Code Export

3.5.1 "Cannot connect to DSN" error when using PB 10.5 with ASA 10/11/12

For users who installed ASA 10, 11, or 12, and installed Appeon Developer to PB 10.5 (by
selecting PB 10.5 or selecting multiple PB versions but the highest version is PB 10.5 when
installing Appeon Developer), the following errors would occur when deploying the Appeon
demo application (as shown in the figure):

00901: Cannot connect to DSN. The database server is AppeonSample.
Failed to generate DWSQL.

Note: These errors would not occur if Appeon Developer is installed to versions higher than
PB 10.5, for example, if the user selected PB 10.5 as well as the other PB versions which are
higher than PB 10.5 (such as PB 11.5 or PB 12.5) when installing Appeon Developer.
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Figure 3.2: Deployment error

Figure 3.3: Deployment log
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And when the user tests the connection with AppeonSample in the ODBC Data Source
Administrator -> System DSN, the following error occurs.

Figure 3.4: Connection error

Cause: This issue is caused by the incompatible versions between the AppeonSample.db file
and the ASA database engine.

Solution: Replace the AppeonSample.db file with the file downloaded from the attachment
of this article in the Appeon support portal: http://support.appeon.com/index.php?/
Knowledgebase/Article/View/72/7/failed-to-connect-the-appeonsampledb-when-using-
pb-105-with-asa-101112.

Note: you can find the location of the AppeonSample.db file from ODBC Data Source
Administrator.

3.5.2 Source Code Export process aborts with a fatal error

Task 1 (Application Source Code Export) is aborted with a fatal error "The memory cannot
be "read"", or "Failure in exporting XML file".

Cause: The fatal error occurs when the PowerBuilder source code contains corrupt
object(s) that cannot be opened in PowerBuilder, or object(s) that are not fully upgraded to
PowerBuilder 9 or later format.

Solution: Remove or modify the problematic object(s) from the PowerBuilder application
by following the instructions in How to locate problematic objects in an application, and
perform the Application Source Code Export again.

3.5.3 How to locate problematic objects in an application

When trying to locate problematic objects in an application, the key is to find which PBL
contains the problematic object(s), and then check the objects in the PBL.

Step 1: In Appeon Developer application profile settings, specify the PBL that contains the
Application object in the application PBL list, and then perform Application Source Code
Export.

Note: Only one PBL is specified in the PBL list in this step.

If Source Code Export produces a fatal error, it means that the PBL specified contains
problematic object(s). Go to Step 3 for checking the objects in the PBL.

http://support.appeon.com/index.php?/Knowledgebase/Article/View/72/7/failed-to-connect-the-appeonsampledb-when-using-pb-105-with-asa-101112
http://support.appeon.com/index.php?/Knowledgebase/Article/View/72/7/failed-to-connect-the-appeonsampledb-when-using-pb-105-with-asa-101112
http://support.appeon.com/index.php?/Knowledgebase/Article/View/72/7/failed-to-connect-the-appeonsampledb-when-using-pb-105-with-asa-101112
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If the Source Code Export is successful, go to Step 2.

Step 2: In the Appeon Developer application profile settings, add one PBL to the PBL list,
and perform Application Source Code Export.

If the Source Code Export produces a fatal error, it means that the PBL that was newly added
contains problematic object(s). Go to Step 3 for checking the objects in the PBL.

If the Source Code Export is successful, repeat Step 2 until the PBL that contains problematic
object(s) is found.

Step 3: (Supposing the PBL that contains problematic object(s) is PBL A) In the
PowerBuilder application, back up PBL A. The backup PBL is PBL B.

Step 4: Remove all the objects from PBL A.

Step 5: Add one of the objects in PBL B to PBL A. Perform the Application Source Code
Export.

If the Source Code Export produces a fatal error, it means that the object that was newly
added is problematic.

If the Source Code Export is successful, repeat Step 5 till the problematic object is found.

3.5.4 "Error: Failure in exporting XML file"

Task 1 (Application Source Code Export) is aborted when the error “Failure in exporting
XML file" occurs.

Figure 3.5: Failure in exporting XML files

Cause A: This error will occur when no database profiles for this application has been
configured in Appeon Developer Configuration > Application Profiles > ApplicationName
> Application Profile Configuration >DB Type.
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Solution A: Follow the instructions in Appeon Developer User Guide to configure the
database type profiles and perform “Full Deployment" on the application with the Appeon
Deployment Wizard.

Cause B & Solution B: Refer to Source Code Export process aborts with a fatal error.

3.5.5 Warning 61537

During Task 1 (Application Source Code Export), a warning message is displayed in the
status box, "61537: Unable to get object [object name]'s PB source code...".

Check whether this object exists in the PBL of the PowerBuilder application. If the object
does not exist, refer to Cause A and Solution A; if the object exists, refer to Solution B.

Cause A: This issue may occur if the object and any references to the object are not removed
completely in the PowerBuilder application. When Appeon Developer searches the object
list, some references can still be found.

Solution A: Follow the steps below to fix the problem.

Step 1: Create an object with the same object name in the PBL where the object was
removed.

Step 2 : Incrementally build the application.

Step 3: Delete the created object.

Step 4 : Try Appeon Deployment again.

Solution B: If for any other reason the issue still occurs, try the steps below.

Step 1: Export and import the object in PowerBuilder.

Step 2: Full build the application.

Step 3: Try Appeon Deployment again.

3.6 Task 2: Application File Generation

3.6.1 Failure in Incremental Deployment

After the user upgrades PowerBuilder to a different build, errors may occur during an
incremental deployment process.

Cause & Solution: Refer to Upgrading to a different Build of PowerBuilder.

3.6.2 "Error launching LoadConfig"

The "Error launching LoadConfig" message is displayed when the user changes the settings
in Appeon Developer Configuration or performs Task 2 of the Deploy Wizard.

Cause: There is one of two possibilities that can occur.

1. The EonADT50.exe cannot be loaded. This can happen when the developer machine does
not meet the minimum hardware requirements specified in Installation Guide for .NET.

2. The EonADT50.exe is loaded but fails to read the .DAT files.

Solution A: Follow the steps below to fix the problem.
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Step 1: End the EonADT50.exe process in the Windows Task Manager

Step 2: Delete the application profile in Appeon Developer Configuration

Step 3: Recreate the application profile and run Appeon Application Deployment/Appeon
Developer Configuration.

Solution B: If the problem persists, follow these steps to rectify it.

Step 1: Delete the application profile in Appeon Developer Configuration.

Step 2: Delete the application folder in the Appeon Developer install directory: \Appeon
\Developer2016\Project\ApplicationName.

Step 3: Recreate the application profile and run Appeon Application Deployment/Appeon
Developer Configuration.

3.6.3 "Failed to transfer command"

Web file generation cannot proceed if the error "Failed to transfer command" occurs.

Cause: EonADT50.exe fails to read the .DAT files.

Solution A: Verify that the EonADT50.exe process is running in the Windows Task
Manager. Try the deployment again.

Solution B: If the problem persists, try the following steps.

Step 1: Terminate the EonADT50.exe process in the Windows Task Manager.

Step 2: Delete the application profile in Appeon Developer Configuration.

Step 3: Recreate the application profile and run Appeon Deployment again.

Solution C: If Solution B is unsuccessful, the following actions should rectify it.

Step 1: Delete the application's profile in Appeon Developer Configuration.

Step 2: Delete the entire application folder in the Appeon Developer install directory:
\Appeon\Developer2016\Project\ApplicationName.

Step 3: Recreate the Application Profile and run Appeon Deployment again.

3.6.4 "Exception at: CString CparseEngine..."

Web file generation cannot proceed when an error message box pops up and displays
"Exception at: Cstring CparseEngine".

Cause: One of the possible causes is that the Application Profile does not contain all the
necessary PBLs, or some referenced objects in the application cannot be found in the
application PBLs.

Solution: Verify that the application can be compiled (Full Build) successfully, and that all
PBLs for the target have been added into the Application Profile. Run Appeon Deployment
again.

3.6.5 "Error loading command string"

During Web file generation the following error might be displayed "Error loading command
string".
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Cause & Solution: See "Error loading command string".

3.6.6 Feature Analysis and deployment freezes

During unsupported Feature Analysis or Task 2 of the Appeon Deployment Wizard, the
user can see the "Start searching for related objects..." message, displaying normally in the
status window. However, the program does not proceed. The EonADT50.exe process is still
running in the Windows Task Manager.

Cause & Solution: See Feature analysis or deployment comes to a standstill.

3.6.7 "Fail to analyze application" and "Fail to analyze Menu Object A in the B
application" errors

Appeon Developer stops the analysis or deployment of the application and reports the "Fail to
analyze menu object A in B." and "Fail to analyze application" errors in the log file.

Cause: There are some unsupported features in the Menu object.

Solution: You can take the following steps to solve the problem.

Step 1: Full build the application without reporting any errors.

Step 2: Check the menu name with understanding the following naming rules:

• Can be reserved words in JavaScript, apart from the word "Object".

• Can have up to 40 characters but no spaces

• Must start with a letter or an _ (underscore) and can include any combination of the
following letters and numbers, and these special characters: Underscore ('_') character, 0-9,
a-z, A-Z, Double-byte characters or characters with Unicode > 255

Step 3: Redeploy the application.

3.6.8 Error "Could not read object"

Appeon deployment may occasionally result in an error stating that it could not read an
object.

Cause: The error can occur if a PBL has not been optimized. The PowerBuilder IDE allows a
PBL to be optimized by eliminating unused objects and space.

Solution: Optimize the application PBLs by right clicking on the PBL and selecting
Optimize. Deploy the application again.

3.7 Task 3: Application Deployment

3.7.1 "Error: Failure in adding an application to [Server Name]"

The application deployment has not completed successfully if you receive an "Error: Failure
in adding an application to Local Appeon Server" message. This typically occurs during Task
3: application deployment.

Cause A: Appeon Server is either not running or cannot be found by Appeon Developer.
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Solution A: Restart Appeon Server and click Retry to re-deploy the application.

Cause B: You did not specify correct deployment username and password in the Appeon
Server profile.

Solution B: Check with the AEM admin whether the deployment security is on for the
Appeon Server, and what are the accounts allowed to deploy applications to the Appeon
Server. Specify an authorized deployment username and password in the Appeon Server
profile, and make sure "Test Appeon Server Settings" is successful.

3.7.2 Unable to write to FTP Server: "Error: Unable to find the destination
directory"

When accessing the FTP server to upload Web files the following error will be displayed
"Error: Unable to find the destination directory".

Cause: The Web files cannot be uploaded to the FTP server because the user specified in the
Web Server profile is not authorized to write to the FTP server.

Solution: If an IIS FTP server is being used, follow the instructions detailed below. If another
type of FTP server is being used, the following instructions will also give you a general idea
of what changes need to be made to the configuration on the FTP server:

Open Administrative Tools > Internet Services Manager, and check the Properties for the
Default FTP Site folder:

• Verify that the Write property is selected in the Home Directory tab.

• Verify that the Granted Access option is selected in the Directory Security tab.

3.7.3 Web application deployment to remote servers does not work

When deploying to both local and remote servers simultaneously, the process fails.

Cause: Appeon does not support simultaneous deployment to both the local and remote
Appeon Server(s). In addition, although you may not be deploying to a local Appeon Server,
problems may occur occasionally when deploying to remote Appeon Server(s) when the local
Appeon Server is running.

Solution: Stand by the following rules when performing a deployment.

• Shut down the local Appeon Server when performing a remote deployment.

• The remote deployment profile(s) should not include a local Appeon Server. Verify that
the deployment contains only one remote Appeon Server or one cluster of remote Appeon
Servers that have been configured in AEM.

3.7.4 "Error: Unable to upload INI file"

Task 3 (Web Deployment) cannot proceed when the error message "Unable to upload INI
file" is displayed in the status window.

Cause: Failure to upload an INI file can result from one of two causes: Appeon Server
has not been started or the appeondb data source is not running. Appeon Developer will
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upload an empty INI file to AppeonDB on the Appeon Server if no INI files are selected for
deployment.

Solution: Follow the steps below to fix the problem.

Step 1: Verify that Appeon Server has been started.

Step 2: Connect to Appeon Server in Sybase Central (EAServer Manager). Right-click
appeondb in the data source folder, and select "Ping". If pinging the appeondb data source
fails, refer to Fail to ping appeondb data source

Step 3: Restart Appeon Server and deploy the application again.

3.7.5 "Unable to cast object of type 'System.String' to type 'System.Byte[]'"

Failed to deploy an application to Appeon Server for .NET which runs in an uncertified-
Appeon-language-environment, for example, Turkish environment. The "Unable to
cast object of type 'System.String' to type 'System.Byte[]'" error is reported in Appeon
Deployment log.

Solution:

Step 1: Find the following command line in the web.config file at C:\Inetpub\wwwroot
\appeon\AEM and then add the "culture="en-US"" attribute.

<globalization requestEncoding="utf-8" responseEncoding="utf-8"
  uiCulture="auto" culture="en-US"/>

Step 2: Save the file changes and restart IIS to make the modification take effect.

Step 3: Deploy the application again.
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4 Troubleshooting Web Applications
This section contains information about general troubleshooting issues when running Web
applications deployed with Appeon for PowerBuilder. If you cannot resolve the problem
using this troubleshooting guide, please contact technical support at http://www.appeon.com/
support.

4.1 Launch Web applications

4.1.1 IE shows "done" status and then stays blank

When trying to launch the Web application, the IE page shows a "done" status on the lower
left hand corner and then it stays blank. The ActiveX has been correctly downloaded and the
"run now, or run after download" screen also successfully displayed, after this screen, all the
files seemed to download but the application login screen never appeared.

Cause: By default, the Web server running on Windows Server 2008 R2 + IIS 7 does not
allow the following two types of files to be downloaded to a browser:

1. Files with file extension, but not specified in IIS

2. Files without file extension

Therefore, you would need to explicitly define these file types in IIS.

Solution:

Step 1: Find out what files of the Web application cannot be downloaded from Windows
Server 2008 R2 + IIS 7.

1. Go to AEM > Application > Client Features > Application name, and then set Allow
user to select run mode to Yes.

Figure 4.1: Set start and exit

2. On the same AEM page, find out where local Web files are stored. For example: C:\Users
\appeon\AppData\Roaming\appeon.

Figure 4.2: Client storage location

http://www.appeon.com/support
http://www.appeon.com/support
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3. Delete the local directory for the Web files. The folder is named after the Web application,
for example, C:\Users\appeon\AppData\Roaming\appeon\localhost_Dotnet_<application-
name>.

4. Access the Web application in IE, and select Run After Download.

Figure 4.3: Select run mode

5. In the Download Info window, make note of the type of files that cannot be downloaded,
as you will then need to specify them in IIS explicitly.

Figure 4.4: Download info

Step 2: Set up the MIME types for files with file extension that cannot be downloaded.

1. Open IIS Manager. Expand the Web Site hosting the Web application, expand the Web
application folder, then click the sub-folder which contains the files that cannot be
downloaded.

The following table lists the sub-folder and what types of application files they contain, so
you can easily determine which folder you will need to configure.

Table 4.1: File type and folder name

File type Folder name

*.dat Located in the meta/merge folder.

*.win, *.udo Located in the ole folder.

*.dll, *.ocx Located in the plugin folder.

*.bmp, *.jpg, *.ico Located in the image folder.
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File type Folder name

f* Located in the merge folder.

Suppose the *.win file cannot be downloaded, then click the "ole" folder.

The following steps take the file extension .win as an example to show you how to create
the MIME type for this file type. You may need to create multiple MIME types if there
were more than one type of file extension listed from step 1.

2. In Features View, double-click MIME Types, then in the Actions pane, click Add,
and then in the Add MIME Type dialog box, set the File name extension to, in this
example, .win, and set the MIME type to application/octet-stream, and click OK.

Figure 4.5: Add MIME type

Step 3: Set up both MIME type and Handler Mapping for files without file extension that
cannot be downloaded.

1. Open the IIS Manager. Expand the Web Site hosting the Web application, expand the Web
application folder, then click the "merge" folder.

2. In Features View, double-click MIME Types, then in the Actions pane, click Add, and
then in the Add MIME Type dialog box, set the File name extension to * and set the
MIME type to application/octet-stream. Click OK.

Figure 4.6: Add MIME type
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3. Click the "merge" folder again and then double click Handler Mapping in Features
View.

The following steps take the file name f### (where “###” is a number) as an example to
show you how to create the mappings for this file group. You may need to create multiple
mappings if there were more than one group of these files listed from step 1.

4. Click Add Module Mapping in the Actions pane, and then in the Add Module Mapping
dialog box, fill in the fields with the following values:

• Request path: f* (or whatever the names were of the objects that were listed in the
"Download info" screen from the first step above.)

• Module: StaticFileModule, DefaultDocumentModule, DirectoryListingModule

• Name: v (you can put whatever name you want here, as long as it does not conflict with
an already existing mapping.)

Figure 4.7: Add module mapping

5. Then click the Request Restrictions … button; in the Mapping tab, check the box and
select File or folder, and in the Access tab, select Read.
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Figure 4.8: Request restrictions

6. Click the OK button to complete the setup, the mapping will be listed as shown below.

Figure 4.9: Web service handler factory

7. Repeat 4, 5, & 6 to add a module mapping for "*", as shown below.

Figure 4.10: Add module mapping
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4.1.2 IE 7 reports "Internet Explorer cannot open the Internet site. Operation
aborted." error

On some machines with Vista and Internet Explorer 7 installed, the "Internet Explorer cannot
open the Internet site http://<Web Site>. Operation aborted." error may occur and cause the
Web application to fail to run.

Figure 4.11: Operation aborted

Cause: This is a bug of Internet Explorer 7 (http://support.microsoft.com/kb/927917).

Solution: Right click the Internet Explorer icon on desktop, choose Run as administrator;
after the Web application runs successfully, restart the Internet Explorer in the normal way.

4.1.3 "Failed to get resource from Appeon Server" error

When you run the Appeon Web application, the "Failed to get resource from Appeon Server"
error occurs, as shown in figure below.

http://support.microsoft.com/kb/927917
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Figure 4.12: Fail toe get resource

Cause A: If you run the Appeon Web application under the administrator group member (not
administrator), the administrator group member will not have sufficient rights to download
the Appeon ActiveX plug-in.

Solution A-1: Add the URL of Appeon Web application to the Trusted Sites zone in Internet
Explorer, because the default security settings of this zone are appropriate for downloading
and installing the Appeon ActiveX plug-in. The following are detailed steps.

Step 1: Click Tools > Internet Options menu in Internet Explorer.

Step 2: Select the Security tab in the Internet Options window. Then click the Trusted sites
icon, and click the Sites button.

Step 3: In the Trusted sites window, input the URL of the Web application to the Add this
website to the zone field. Click Add, and then click Close.

Step 4: Re-open Internet Explorer then run the Web application.

Solution A-2: Right click the Internet Explorer icon on desktop, choose Run as
administrator; after the Web application runs successfully, restart the Internet Explorer in
the normal way.

Cause B: The Enable Protected Mode of Internet Explorer causes this runtime error. When
Enable Protected Mode is turned on, Internet Explorer does not have the write permission
to the %APPDATA%\appeon directory (the default directory where Appeon application
files are stored), which causes the Appeon application files to fail to save on the client after
downloaded from the server.

Solution B-1: Uncheck the Enable Protected Mode option for the appropriate zone under
the Security tab of the Internet Options window.
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Figure 4.13: Enable Protected Mode

Solution B-2: If Enable Protected Mode must be turned on, then you will need to change
the default directory where the Appeon application files will be saved after downloaded from
the server. Go to AEM | Application | Client Features | Client Storage Location and then
input %USERPROFILE%\AppData\LocalLow\appeon in Customized Location. For more
information about the customized location, refer to Section 5.4.6.7, “Client Storage Location”
in Appeon Server Configuration Guide for .NET.

4.1.4 "Unable to validate current license file. Please reinstall Appeon Server"

Web application cannot load in Internet Explorer. The pop up error message is displayed
"Unable to validate current license file. Please reinstall Appeon Server".

Cause: Validation of appeon.license file in AppeonServer.db file may fail if abnormal
operations are performed. You will continue to see the error message if Appeon Server is not
reinstalled.

Solution: Reinstall Appeon Server. Avoid such operations in Appeon Server:

1. Modify the information in appeon.license file

2. Copy components to Appeon Server instead of deploying them.
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4.1.5 Failed to install the Download Center plug-in

When you try to manually install ActiveX plug-in, you prompted with this error "Failed to
install the Download Center plug-in"

Cause: Appeon plug-in is failed to manually install since the system DLL, atl.dll, is never
registered on this machine.

Solution: Login to the computer as Administrator account, open any prompt window and
then follow instructions below:

1. Navigate to the directory C:\WINDOWS\system32 or C:\WINNT\system32;

2. Run the command: Regsev32 atl.dll.

4.1.6 Failed to manually download Appeon ActiveX

Failed to manually download Appeon ActiveX control and encounter the following web
page:

Figure 4.14: Fail to download Appeon ActiveX

Cause: The problem is only found in EAServer 5.x and WebLogic for Unix. One of the
possible causes is the MSI extension is not mapping to a correct MIME type.



Troubleshooting Web Applications Appeon® for PowerBuilder® 2016

Troubleshooting Page 52

Solution: Map the MSI extension to application/octet-stream MIME Type in EAServer 5.x
manager console or WebLogic

Taking EAServer 5.x as an example, you can add the MIME mapping:

1. Go to Servers > Jaguar >Installed Web Applications

2. Right click the EADefault and click the Property item

3. Add or Edit the MIME Type for MSI extension.

Figure 4.15: Add or edit MIME type

4.1.7 Failed to initialize Appeon Weblibrary Component

Appeon Web applications cannot be correctly started and you are prompted with the error
message that "Failed to initialize Appeon Weblibrary Component".

Cause: When you access the web application from a computer at the first time, the Web
application is accessed from the application.html page but index.html. It is not a regular way
to access Web application since in Appeon it is designed to start the web application from
the index.html page which is aiming to download and initialize the Appeon ActiveX. If the
application starts from the application.html, the ActiveX cannot be correctly installed on this
machine and will result the failure of running the Web application.

Solution: Run the web application with correct URL which ends with the index.html page,
for example, http://appeonserver:8000/index.html.
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4.1.8 Failed to download *.* file

When running the Web application, you encounter the "Failed to download *.* file" error.

Cause: The file extension is not added to the MIME type list in IIS.

Solution: Set up the MIME type for the file name extension that cannot be downloaded.

Step 1: Open IIS Manager. Select the Web site hosting the Web application.

Step 2: In Features View, double-click MIME Types, then in the Actions pane, click Add,
and then in the Add MIME Type dialog box, type the file name extension in the File name
extension text box, for example, type .config, and type a MIME type in the MIME type text
box, for example, text/xml, and click OK.

Step 3: In Features View, double-click Request Filtering, and then remove the file name
extension (for example, .config) from the list.

4.1.9 Demo Web applications do not load in Internet Explorer

The index.html page cannot be displayed when launching the demo Web application in the
Internet Explorer browser.

Cause: The URL in the browser's address bar is incorrect.

Solution: Verify that the hostname and port number in the URL are the same as the settings
in the Web Server Profile in Appeon Developer.

4.1.10 Web applications do not load in Internet Explorer

Web applications can be loaded and run properly previously. After being deployed with a
newer Appeon version, the Web applications can no longer be loaded.

Cause: Previously loaded Web application files are cached in the browser, and prevent the
browser from downloading the latest Web files.

Solution: (1) Manually delete the temporary Internet files: go to Tools | Internet Options,
click the Delete Files button. (2) In the Temporary Internet Files Settings dialog, click the
View Objects button, and clear all the objects in the popup folder, which should be \WINNT
\Downloaded Program Files (Windows 2000) or \WINDOWS\Downloaded Program Files
(Windows 2003).

An alternative solution is to check the "Empty Temporary Internet Files folder when browser
is closed" option (under the Security section of the Advanced tab of Internet Options)
to ensure that no cached files remain whenever Internet Explorer is restarted. But this is
recommended for use only during the development stage. During development, it is best
to have the latest Web application loaded in the browser to avoid any problems caused by
cached files. When your Web application is ready for production deployment, this setting
can be disabled (unchecked) so that the Web application can be cached at each Client PC for
better scalability and Client-side performance.

4.1.11 IE browser fails to open Web applications

The Web application fails to load into the browser, but no error messages are displayed. The
screen is blank as shown in the following figure.
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Cause: The application index.html page cannot be opened because of the high security level
setting of Internet Explorer on the Client PC.

Solution: Follow the steps below to fix the problem.

Step 1: Close the blank browser window. Right-click the Internet Explorer icon and select
Properties in the popup menu.

Step 2: Delete the temporary Internet files and cookies from the General tab. Select Delete
all offline content when deleting temporary Internet files.

Step 3: On the Security tab, set the security level to default - Medium for the Internet or a
Local intranet, depending on where the application is deployed.

Step 4: Apply the changed settings to Internet Explorer.

Step 5: Verify that the Internet Explorer on the client is configured using the instructions
described in Section 6.2, “Configuration for Web client PC” in Installation Guide for .NET.

Figure 4.16: IE browser fails to open Web applications

4.1.12 Error "Connect EAServer failed" when loading Appeon demo
applications

Failure to run the Appeon n-Tier NVO demos (e.g., Appeon Code Examples) both on the
Web and in PowerBuilder. The "Connect EAServer failed" message is displayed.

Cause: For Appeon Server connection settings, the host name is set to "localhost" by default,
and the port number is set to "9989" by default. If the actual host name and port number
are different from the default settings, the "Connect EAServer failed" error will occur when
attempting to run the demo application on the Web or in PowerBuilder.

Solution: Here AppeonCodeExamples is used to demonstrate the solution to this problem.

Step 1: Load AppeonDemo.pbw in the PowerBuilder IDE. In the system TreeView, open
appeon_code_examples > ace_window1.pbl > w_distributed_DW.

Step 2: Find the following script in the Open event of the w_distributed_DW object. Verify
that it matches the actual Appeon Server settings enabling the demo application to work
properly with PowerBuilder.
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i_conn.driver = "jaguar"
i_conn.application = "AppeonCodeExamples"
i_conn.location = "localhost:9989"
i_conn.UserID = "jagadmin"
i_conn.Password = ""

Step 3: Follow the instructions provided in Error "Create instance failed" when loading n-
Tier NVO Web applications to verify that the demo applications can work properly on the
Web.

4.1.13 Error "Create instance failed" when loading n-Tier NVO Web
applications

When loading a deployed Web application that uses n-Tier NVOs the following error might
be displayed "Create instance failed".

Cause: If the Web application relies on n-Tier NVOs that are deployed to Appeon Server,
the Web application will not be able to load if the instance of the NVO cannot be created
successfully. A "create instance failed" error caused by the EAServer package being
incorrectly installed will be displayed.

Solution: Follow the steps below to fix the problem (taking Appeon Code Examples as an
example).

Step 1: In EAServer Manager, check whether the AppeonCodeExamples package exists in
the Packages folder.

Step 2: In the PowerBuilder IDE, navigate to p_appeon_code_examples_server_deploy in
appeon_code_examples_server.pbl. View Properties of the EAServer Component Generator
Project.

Figure 4.17: p_appeon_code_example_server_deploy

Step 3: Verify that the EAServer connection settings in the Properties dialog for the
p_appeon_code_examples_server_deploy object reflects the settings of the EAServer where
you will deploy the n-Tier NVOs.

Step 4: Select Deploy ( ) to deploy the EAServer package.

Step 5: In EAServer Manager, right click the EAServer package AppeonCodeExamples,
and select "Generate Stubs/Skeletons" to generate Stubs and Skeletons for the NVO. Select
Generate Java Files, Compile Java Stubs, and Compile Java Skeletons, and leave the
other options at their default values.

Step 6: The Stub/Skeleton files generation progress is displayed. When it completes
successfully, click OK to close the Code Generation status window.
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4.1.14 "Create Session failed"

If you receive a "Create Session failed" error message and find a "SystemException:
NO_PERMISSION" exception in the Jaguar.log, first read Cause A and Solution A which
should rectify the problem; if not, please go to Cause B and Solution B.

Cause A: The error may occur if the OS authentication setting in EAServer is incorrect.

Solution A: Follow the steps below to fix the problem.

Step 1: Run EAServer and start EAServer Manager.

Step 2: Go to the Properties for the server in EAServer Manager.

Step 3: Set the property "com.sybase.jaguar.server.authservice" to false.

Step 4: Restart EAServer.

We suggest either keeping the property authentication disabled or correcting the OS
authentication setting (referring to Getting Started in EAServer System Administration
Guide).

Cause B: The error is caused by either an Internet Explorer/Client configuration problem or
an Appeon Server configuration problem.

Solution B: Verify you are using a minimum of Internet Explorer 8.0. Upgrade to the latest
version if necessary.

• Internet Explorer/Client configuration

The possible causes and solutions are listed in the following table. The most common
cause for the Internet Explorer/Client configuration issue is item #1.

Table 4.2: Internet Explorer configuration

No. Possible Causes Solutions

1 Internet Explorer security
level is set too high.

Go to Internet Options > Security in Internet
Explorer, change the security level to
the medium default-level for the Internet
or Local intranet zone or Trusted Site,
depending on where the Appeon Web
application is deployed.

2 Advanced Internet Options
setting incompatibility.

Go to Internet Options > Advanced in
Internet Explorer, and click the Restore
Defaults button to restore the default
settings for the Advanced options.

Note: Selecting Default Settings will
remove the check from "Use HTTP 1.1
through proxy connections". This setting is
required when the application is accessed
through a proxy server.

3 Some Client-side software,
such as anti-virus software
or a personal firewall, is

Disable suspected software and try again.
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No. Possible Causes Solutions
preventing the required Web
files from downloading.

• The most common causes for the Appeon Server configuration issue are items #1 and #2 in
the following table.

Table 4.3: Other configurations

No. Possible Causes Solutions

1 EAServer service needs to
be reinstalled.

Reinstall the EAServer service using this
command: serverstart.bat -removeandinstall

2 EAServer is being run in
debug mode.

Do not run EAServer in debug mode.

3 AEM configuration files are
corrupt.

Please make sure the following files
at %JAGUAR%\appeon\repository\
%instancename%\config (Windows)
or $JAGUAR/appeon/repository/
$instancename$/config (UNIX) have
not been corrupted. If any file is corrupt,
reinstall Appeon Server to replace them.

• aem-config.xml

• aem-mapping.xml

• applications-config.xml

• mapping.xml

• server-config.xml

4 Software like an anti-virus
program has interfered
with the Appeon Server
installation process.

Uninstall Appeon Server. Verify all the
prerequisites for Appeon Server installation
(as listed in Installation Guide for .NET)
have been satisfied. Disable any software
that may interfere with the installation.
Reinstall Appeon Server.

4.1.15 "Load application failed"

When loading the Web application, the error message "Load application failed" is displayed.

Cause & Solution: Refer to the cause and solution in "Create Session failed".

4.1.16 "Failed to invoke remote procedure" error

When running an Appeon application that is deployed to IIS Web server, the browser only
pops up a "Failed to invoke remote procedure" error message.

Cause: The IIS server requires Scripts and Executables permissions on the applications.
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Solution:

Step 1: Open the Internet Information Service in the Administrative Tools in the IIS Web
server.

Step 2: Go to Default Web Site Properties > Home Directory, and change the Execute
Permissions to "Scripts and Executables".

Figure 4.18: Home Directory

4.1.17 "Automation server could not create object" error on some clients

Web application fails to run on the client that does not have Appeon Developer. The pop up
error message "Automation server could not create object" is displayed.

Cause: Web application is deployed with the "Generate Web Report" option enabled in
Appeon Developer. If the option is enabled, the deployed application shall rely on a DLL in
the Appeon Developer installation folder for generating the Web report.

Solution: Redeploy the application without enabling the "Generate Web Report" option in
the Appeon Developer.

4.1.18 "Object doesn't support this property or method" error

The "Object doesn't support this property or method" error message displays when you access
to the Web application.

Cause: There are two possible causes: 1) The Internet Explorer version may not be compliant
to the Appeon's requirements. 2) The configurations of the Internet Explorer are incorrect.
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Solution: Upgrade the Internet Explorer to Appeon certified version. Configure Internet
Explorer settings according to Section 6.2, “Configuration for Web client PC” in Installation
Guide for .NET. Then follow the steps below:

Step 1: Manually delete the Temporary files and cookies: go to Tools > Internet Options,
click the Delete Cookies button.

Step 2: Click the Delete Files button and check the Delete all offline content box in the pop
up window. Then click the OK button to ensure that all temporary files are deleted.

Step 3: Click the Settings button and the View Objects in the Temporary Internet Files,
clear all objects in the pop up folder.

Step 4: On the Security tab page, set the security level to default - Medium for the Internet or
a Local intranet. Please ensure that you can download and install the ActiveX.

Step 5: On the Advanced page, click the Restore Defaults button and check the Use
HTTP1.1 through proxy connections item. Then click the OK button to save the settings.

4.2 Display errors

4.2.1 Distributed DataWindows are not displayed

A distributed DataWindow does not display on the Web when deployed with Appeon 6.x.
However, it is displayed in PowerBuilder and previously displayed with Appeon 5.0/5.1
without any problems.

Cause: Appeon versions apply different workaround PBLs and DLLs. When the user
upgrades the PowerBuilder distributed application from using Appeon 5.0/5.1 to using
Appeon 6.x, the workarounds PBL and two related DLLs should be updated.

Solution: Follow the steps detailed below to fix the problem.

Step 1: Remove the appeon_workarounds.pbl file from the Library Search Path of the target
PowerBuilder application.

Step 2: Remove EonAXNVO.dll and EonEmfPic.dll from the folder containing the
PowerBuilder application PBL.

Step 3: Add the appeon_workarounds_ax.pbl to the Library Search Path of the
target PowerBuilder application. The file is located in the directory:\Appeon
\Developer2016\appeon_workarounds.

Step 4: Copy the two files EonAXNVO.dll and EonEmfPic.dll from the \Appeon
\Developer2016\appeon_workarounds directory to the folder holding the PowerBuilder
application PBL.

Step 5: Full deploy the application again with Appeon for PowerBuilder.

4.2.2 Corrupt Chinese characters are displayed in a DataWindow

Chinese characters can be entered into a DataWindow and updated to a SAP ASA/SQL
Anywhere database, however, after DataWindow re-retrieve, the characters displayed are
corrupt.
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Cause: Chinese characters cannot be displayed correctly if the application uses a JDBC-
ODBC driver for connecting to a SAP ASA/SQL Anywhere database, and the database field
that contains Chinese characters is Long VarChar type.

Solution: You can use either of the two solutions below.

Change the data type of the database field from Long VarChar into VarChar.

Make sure the character set used in the operating system that runs Appeon Server is the same
as that of the SAP ASA/SQL Anywhere database computer.

4.2.3 Text does not display or text is grayed out

When the application is deployed to the web, some of the text in the UI does not display or
the text is grayed out.

Cause: This issue could be caused by the enabled property of static text.

Solution: In the PowerBuilder painter, the affected static text control might have the enabled
property set to false, so text will be grayed out when the application is deployed. Make sure
you select the enabled property of the affected static text control and incrementally deploy
your application with Appeon Developer.

4.2.4 DropDownListBox does not display completely

When selecting a DropDownListBox object, its content may be hidden.

Cause: When a DropDownListBox/DataWindow is pulled down but the window container is
not large enough, it will automatically shift to display the major content.

Solution: Click the Tab key to recover normal display of the window.

4.2.5 Nested reports over five pages do not display

Nested reports longer than five pages cannot be viewed in the DataWindow of the Web
application.

Cause & Solution: Refer to  Nested reports over five pages do not display.

4.2.6 Nested reports over 50 rows do not display

When retrieving data from a nested report that has more than 50 rows, an error message
displays that "Failed to create SQL Statement due to java.sql.SQLException: [Sybase]
[ODBC Driver][Adaptive Server Anywhere] General error: Resource governor for prepared
statements exceeded".

Cause: This error only occurs to the SAP ASA/SQL Anywhere database. The ResultSet
value that Appeon Server returned exceeds the maximum cursor value that is default in the
SAP SQL Anywhere database.

Solution:

Run the following commands to set the cursor count and statement count to no limit:

Set option public.max_cursor_count = 0
  Set option public.max_statement_count = 0
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4.2.7 MDI windows do not display in full

Some large sheets do not display fully on the Web.

Cause: The MDIClient object in PowerBuilder can open a larger visible scope than on the
Web.

Solution: Set the VScrollBar property for the MDI window to TRUE.

4.2.8 Truncated display of data or controls in a DataWindow or Window

Controls or data is not displayed correctly in DataWindows or Windows.

Cause: In some cases, text or controls in the DataWindow or Window may not be completely
visible. This is because the PowerBuilder units used to size the UI of the application, such as
the DataWindow rows and columns, the Window object, etc. These cannot be converted to
the Web units (pixels) perfectly.

Solution: For the affected DataWindow, resize the UI layout in PowerBuilder to allow
slightly more space for the items that are not fully displaying.

4.2.9 Extra space or padding between MDI client area and toolbar

Extra space or padding appears between the MDI client area and the application toolbar in the
Web application.

Cause: Incorrect calculation of the MDI client area size during the application deployment
will cause extra spaces or add padding between the MDI client area and the application
toolbar in the Web application.

Solution: Modify the X, Y and Height property for the MDI window and the controls in the
MDI window by following the steps below:

Step 1: Estimate the height in PowerBuilder units, for example, 400 PowerBuilder units.

Step 2: Add the following script in the resize event:

String ls1, ls2
Long ll_rate
Setnull(ls1)
Setnull(ls2)
If ls1 = ls2 then          //In JavaScript, ls1 equals to ls2
      ll_rate = 400
else ll_rate = 0         //In PowerScript, ls1 does not equal to ls2
end if

Step 3: Edit additional scripts in the resize event to:

• Subtract the ll_rate value from the Y property of the MDI window.

• Add the ll_rate value to the Height property of the MDI window.

• Subtract the ll_rate value from the Y property of the controls in the MDI window.

• Assign the Height property of the MDI window to the controls that will have the same
height as the MDI.

Long ll_rate
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ll_rate = Y
ll_rate = ll_rate + height
window activesheet
activesheet = GetActiveSheet ( )
activesheet.y = ll_rate

4.2.10 Text displays in large size and is cut off

All the text in the application displays in an unusually large size, so some text cannot be fully
displayed in its container and gets cut off.

Cause: Microsoft Windows display font size is set to large; this often happens when the
screen resolution is set high (for example, 1600*1200). Appeon Web applications use the
small font size as default.

Solution: Go to the Windows Display Properties of the client, in the Settings tab, click the
Advanced button, and set the font size to use "Small fonts".

4.2.11 Unable to display the double-byte characters

Double-byte characters such as Chinese, Korean and Japanese cannot be displayed on the
Web.

Cause: The character set of the system mismatches the character set of the database.

Solution: Go to AEM > Application > Data Transfer > Charset > [Your Application].
Add the corresponding charset for the application. For detailed adding steps, refer to
Section 5.4.7.1, “Charset” in Appeon Server Configuration Guide for .NET or in Appeon
Server Configuration Guide for J2EE.

4.3 Runtime issues

4.3.1 Error 10999 - Keyword not supported: 'dsn'

Data source failed and an error (error 10999) box pops up saying Keyword not supported:
'dsn' as shown in the figure below.

Figure 4.19: Error 10999

Cause: Appeon does not support using ODBC Driver to connect with the SQL Server
database.

Solution: To resolve this, go to AEM, and change the ODBC driver to the Native Driver for
SQL Server.
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4.3.2 Cannot update Transaction Objects for WebLogic servers

When you try to configure Transaction Objects for WebLogic Servers in AEM, the Data
Source column in Configure Transaction Object is empty , and a message appears saying
Load application server data source failed, as shown in the following figure.

Figure 4.20: Transaction objects in AEM

Cause: WebLogic 8.15 and later do not allow anonymous users to query JNDI.

Solution: You can refer to Section 4.3.1.2, “Setting up data source for WebLogic 11g” in
Appeon Server Configuration Guide for J2EE to solve this issue.

WebLogic 8 allows anonymous users to query and get JNDI DataSource, but WebLogic 8.15
and later do not allow anonymous users to query JNDI. In the WebLogic's console, select
the "Anonymous Admin Lookup Enabled" to allow anonymous users to manipulate JNDI,
otherwise the Data Source drop-down box will not have values in Transaction Objects in
AEM.

4.3.3 Error 404 - File or directory not found

You may encounter a 404 - File or directory not found error, when you start to run an
application.

Cause: The Appeon folder is not in the application-related IIS home directory (For example:
your Appeon Server Web Component might be installed in c:\Program Files (x86)\Appeon
\WebComponent2016 by default, if you did not change the path when installing it).

Solution: Copy the Appeon folder to the application-related IIS home directory (for example:
C:\inetpub\wwwroot) to solve this issue.
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4.3.4 Http 404 not found error occurs when using WebSphere as the
Application Server

The webpage cannot be found, when you try to run an application, as shown in the figure
below.

Figure 4.21: The webpage cannot be found

Solution: For WebSphere applications, we recommend you use the JDK Compression (Path)
as the File Compression Settings for War/Jar property on the Appeon Developer Web Server
Profile Configuration page, as shown in the figure below.
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Figure 4.22: Web server profile configuration in Appeon Developer

4.3.5 "Stack overflow error"

The following error displays during application runtime: "Stack overflow error". Click OK.
The message box will close and the Web application will run.

Cause: The application is deployed in Debug mode (Debug mode is specified in the
Application Profile Configuration of Appeon Developer).

Solution: If you deploy your application in Encrypted mode (specified in the application
profile of Appeon Developer), the error message will not be displayed.

4.3.6 "Could not Initialize JavaVM!"

During Web application runtime the following error displays: "Could not initialize
JavaVM!".

Cause: This problem is possibly caused by an incorrect version of the PBVM.

Solution: Update the PBVM in EAServer to the version required by Appeon. Run the Web
application again.

4.3.7 "Failed to get DataWindow syntax from Appeon Server"

During Web application runtime the following error is displayed: "Failed to get DataWindow
syntax from Appeon Server".
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Cause: Before application deployment, DB Type profile is not configured correctly in
Appeon Developer for the application profile.

Solution: Open the Appeon Developer Configuration window, and go to the DB Type
Profiles tab page in the "Application Profile Configuration". It is required that for each
database type that the application runs against, a DB type profile should be configured.

Before you set up the DB type profile, be aware of the following:

1. The purpose of the DB type profile configuration is to convert the SQL statements into the
correct type of database syntax.

2. Specify an ODBC data source or native driver in the DB Type profile for connecting the
correct database type. It is unnecessary for the data source to connect to the actual database
that the application uses. But the database type must be correct, and the specified version
of the database is the same as the database version specified in AEM > Application >
Transactions > Transaction Objects.

3. Make sure the DB type profile connection testing is successful.

Refer to the Appeon Developer User Guide for instructions on configuring DB type profiles.

After the DB type profile configuration, re-deploy the application with the Appeon
Deployment Wizard using the Full Application Deployment mode.

4.3.8 Window loses focus of I-beam cursor

If a window has a group box control with tab order numbers, when you press tab, the
windows lose the focus of the I-beam cursor.

Cause: Incorrect configuration of the group box's tab order.

Solution: Change the group box's tab order to zero.

4.3.9 Receiving "Server busy" error

A "Server busy " error message pops up when running a Web application.

Cause: It is likely that the client is running some other program(s) besides the Web
application, which are taking up large CPU or memory resources.

Solution: When running a large Web application (for example, more than 40 MB), do not run
other resource intensive programs.

4.3.10 "Error occurred while creating an object instance" on the status box

During application runtime the following error may occur: "Error occurred while creating an
object instance".

Cause: Usually, this type of error does not affect running of the Web application. It always
occurs when partial script in the application references an object, which is unsupported and
commented out.

Solution: Remove or work around the unsupported object, and make changes accordingly.
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4.3.11 "Are you sure you want to navigate away from this page?" warning
message

When you try to exit a Web application by clicking the Close button in Internet Explorer, a
warning message will be displayed "Are you sure you want to navigate away from this page".
After clicking Cancel in the warning message box and further running the application, if you
click the Close button in the browser again, Internet Explorer crashes.

Cause: Some add-on program such as SnagIt from TechSmith Corporation has been installed
to Internet Explorer.

Solution: Right-click on the Internet Explorer toolbar and disable the add-on program from
the popup menu.

4.3.12 DropDownDataWindow value incorrectly selected

When the user makes a selection in the DropDownDataWindow, the value in the first row
will always be automatically selected. However, after this has happened, the DataWindow
will proceed to function properly.

Cause: The DropDownDataWindow has not been assigned an initial value.

Solution: Either of these two solutions will rectify the problem.

• Try to select the value for a second time and the value displayed will be the value you
specified.

• Assign an initial value to the DropDownDataWindow in the PowerBuilder application.

4.3.13 "Predefined error_message pfc_dwdberror"

The error "Predefined error_message pfc_dwdberror" pops up during the running of a Web
ACF application.

Cause: Several tables are missing in the application. The tables are: messages, security_apps,
security_groupings, security_template, security_users. In PowerBuilder, if the above tables
are missing but the services related with the tables are not used, the application works fine.
Appeon Web application, however, requires importing all the tables to the application
database.

Solution: Export the above-mentioned tables from pfc.db to the application database.

4.3.14 Demo Web application fails to call EJB component

In the Appeon Code Examples demo, the “EJB Component Lookup failed" error message
displays when the NVO calls function of EJB component.

Cause: The environmental variable is too long.

Solution: Reinstall Appeon Server.

Before the installation, be sure to shorten the path for the environmental variable. Another
option is moving some driver files from the %EAServer%\java\lib folder, and moving them
back after the installation.
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4.3.15 Error occurs when running Distributed DataWindow in Appeon Code
Examples Demo

The following error occurs when running Distribute DataWindow in Appeon Code Examples
Demo after Appeon for PowerBuilder is installed.

Figure 4.23: Execute component failed

Cause: EAServer 6.x uses new password mechanism, so Appeon setup program is unable to
set the password of appeonsample and appeonsample2 data sources during Appeon Server
installation.

Solution: Log into EAServer Web Administration Console and modify the password of
appeonsample and appeonsample2 data sources to "sql".

4.3.16 "EonToolset60 Load resource failed"

An EonToolset60 Load resource failed error occurred, when you try to run an application.
And a message pops up saying EonToolset has stopped working - a problem caused the
program to stop working correctly. Windows will close the program and notify if a solution is
available.

Cause: Appeon Developer might not be installed successfully.

Solutions: Make sure that you install Appeon Developer successfully by checking if there
are "multi_language_en.dll", "multi_language_GB.dll", and "multi_language_jp.dll" in the C:
\Program Files (x86)\Appeon\Developer2016\language folder. If not, or if there is any error
when you are installing Appeon Developer, you need to re-install the Appeon Developer.

4.3.17 The SQL statement cannot perform correctly when the Web server is
installed on a VMWare

The SQL statement cannot perform correctly when the Web server is installed on a VMWare,
separating from the Appeon Server.
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Cause: The Network connection Bridged: Connected directly to the physical network
option is by default checked in Virtual Machines Settings.

Solution: Change the network connection from Bridged: Connected directly to the
physical network to NAT: Used to share the host's IP address in Virtual Machine
Settings, as shown below.

Figure 4.24: SQL cannot perform correctly

4.4 Data operation

4.4.1 Retrieved data does not display in DataWindows

While retrieving records for a DataWindow, items are not displayed on the Web.

Cause A: Appeon does not support overlapping controls in a DataWindow. Retrieved data in
the DataWindow column might be covered by a control (for example, the Text control) even
if this control is placed under the data field in PowerBuilder.

Solution A: Remove all controls overlapping the data field. Work around the original
functionality with properties or functions.

Cause B: Appeon Server compresses the data file (.xml) to improve Web performance. Data
in the DataWindow is not displayed if the compressed .xml file is not extracted successfully
on the Client.
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Solution B: Verify that the following property exists in %JAGUAR%\Repository\Server
\Jaguar.props (Windows) or $JAGUAR/Repository/Server/Jaguar.props (UNIX):

com.sybase.jaguar.server.filter-mapping=(url-pattern=/gzip/*,description=adescription of
Test,filter-name=CustomAddHeadersFilter)

If the required property does not exist, the user needs to manually add it in Jaguar.props and
restart EAServer.

4.4.2 Unable to retrieve data from database

No data is retrieved into the DataWindow when running the Web application.

Cause A: If you are using the SAP ASA/SQL Anywhere database, a possible reason is that
the SAP ASA/SQL Anywhere version specified in the Transaction object is different from
what is specified in the data source. The application cannot find DataWindow objects and
fails to retrieve any data from the database.

Solution A: For SAP ASA/SQL Anywhere, version 7.xx, 8.xx, and 9.xx are supported.
Appeon 6.x supports both dynamically mapping the Transaction object to the data source in
scripts, and statically specifying the data source in AEM. The user has to set the correct SAP
ASA/SQL Anywhere version in DBParm or select the correct SAP SQL ASA/Anywhere
version in AEM.

Cause B: If you are using the ASE database and find the following information in the
Appeon log, "Failed to retrieve datastore... Produced the following error: Select error: Stored
procedure '...' may be run only in unchained transaction mode. The 'SET CHAINED OFF'
command will cause the current session to use unchained transaction mode.", a likely cause is
that the connection mode (chained or unchained) set up by the JDBC driver is not the same as
the mode of the stored procedure (chained or unchained).

Solution B: You can modify the PowerBuilder source code using any of the following
workarounds to fix the problem.

• Execute "SET CHAINED OFF" before running stored procedures

• Execute "connection.setAutoCommit(true)" before running stored procedures

• Change the AutoCommit property to true before running each stored procedure

• Use the "sp_procxmode <procname>, anymode" command to set the stored procedure to
run in chained or unchained mode.

Cause C: There are various factors that may cause this problem. Some examples include;
running an incompatible PowerBuilder version with Appeon, data sources, not running or
incorrectly configured, and missing INI files.

Solution C-1: If the application uses an INI file, verify the INI file is added to the Appeon
Developer application profile before deployment. Add the necessary INI file and redeploy the
application.

Solution C-2: If the problem is occurring with an Appeon provided demo application:

• Verify that the PowerBuilder version meets the requirements specified in Installation
Guide for .NET.
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• Verify that appeondb is running - a SQL Anywhere icon with the hover text "Appeondb"
displays in the Windows Task Bar.

• Verify that EAServer has been started.

• Login to EAServer using EAServer Manager and verify that you can ping both the
"appeondb" and "appeonsample" data sources successfully. If the data sources cannot
be pinged successfully, refer to Fail to ping appeondb data source and Fail to ping
appeonsample data source for troubleshooting tips.

• Verify that "<data-cache>appeondb</data-cache>" exists in %JAGUAR%\appeon
\repository\%instancename%\config\server-config.xml (Windows) or $JAGUAR/appeon/
repository/$instancename$/config/server-config.xml (UNIX).

Solution C-3: If the problem is occurring with all applications except the Appeon demo
applications, check the following:

• Verify that the PowerBuilder version meets the requirements specified in Installation
Guide for .NET.

• Verify that the database used for your application is running correctly.

• Verify that EAServer is running.

• Log in EAServer using EAServer Manager and verify that pinging the data source is
successful. If pinging the data source fails, perform the following steps (see Appeon Server
Configuration Guide for J2EE for detailed instructions):

• Verify the data source properties are correctly configured especially the server name,
username and password used to connect to the database.

• Make sure the JDBC radio button is checked in the Driver tab of the Data Source
Properties

• Make sure that the driver string is entered correctly. The string is case sensitive.

• Make sure that the "enable cache-by-name access" option is checked in the Cache tab.

• For an Oracle database, you may need to add the data source property
com.sybase.jaguar.conncache.check and have it set to select 1 from dual.

• If using a data source with the iAnywhere JDBC driver, refer to Section 4.3.7.1, “Data
source parameters for SAP ASA/SQL Anywhere” in Appeon Server Configuration Guide
for J2EE and double-check the settings created.

• Verify the Transaction Object settings in Appeon Enterprise Manager are correct. For
detailed instructions on setting up AEM, refer to Appeon Server Configuration Guide
for .NET or Appeon Server Configuration Guide for J2EE.

• Make sure that the application has been added into the application list displayed in AEM
Console > Application > Transactions > Transaction Objects.
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• Make sure that the application has the correct transaction object name(s) listed, and the
correct transaction object name(s) mapped to the correct data source(s). The transaction
object name is case sensitive.

4.4.3 Database lock

Tables in the database are always locked.

Cause: Because of the inherited features with Web architecture, the chances of the database
locking are indeed increased compared to client/server architecture. For example, on the web:
If there is too much time from the beginning of Data base operations to Commit, a transaction
will consume database resources and increase the chances of the database locking.

Solution:

1. Place the transactions in server NVOs or database procedures for execution.

2. Break the transaction into smaller transactions. Commit each database operations so a
transaction does not take too much to Commit.

Refer to the following coding as an example:

Window open();
//Profile appeonsample
SQLCA.DBMS = "ODBC"
SQLCA.AutoCommit = "False"
SQLCA.DBParm = "ConnectString = ??DSN=AppeonSample; UID=dba; PWD=sql"
CONNECT;

Command Button cb_1:
String ls_emplid, ls_emplname
Ls_emplid = sle_1.text
DELETE employee WHERE s_emplid = :ls_emplid;
COMMIT;

DECLARE cur_empl CURSOR FOR SELECT s_emplid, s_emplname from employee; ;
OPEN cur_empl;
FETCH cur_empl INTO :ls_emplid, :ls_emplname;
DO WHILE sqlca.sqlcode=0
            Ddlb_1.additem("["+ls_emplic+"]"+ls_emplname)
            FETCH cur_empl INTO :ls_emplid, :ls_emplname;

LOOP
CLOSE cur_empl;
Ddlb_1.selectitem(1)
Ddlb_1.triggerevent ("eventchanged")
COMMIT;

4.4.4 Data missing in some DataWindows

Data is missing from some DataWindows.

Cause: There are retrieval arguments used in DataWindow expressions, which are not
supported by Appeon.

Solution: Use Stored Procedure as the DataWindow data source, and put the expression in
the Stored Procedure.
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4.4.5 DataWindows do not respond

During Web application runtime, DataWindows stop functioning.

Cause: The session has timed out.

Solution: Close the current Internet Explorer browser, open a new Internet Explorer browser
and run the demo again. You may want to delay the session timeout or disable session
timeout, if the user session times out frequently.

4.4.6 Manipulation on BLOB files

4.4.6.1 Blob data cannot be correctly manipulated if it is over 4MB

The blob data cannot be correctly updated or obtained if it is larger than 4MB.

Cause: By default, the maximum size of the blob data that can be manipulated is 4096 KB,
so you cannot manipulate Blob data over 4MB with the default settings.

Solution:

Step 1: Go to %appeon home%\AEM\, and add the following script (in bold) in the
web.config XML file. By default, the value of the executionTimeout is 100 seconds, and
the value of the maxRequestLength property is 4096 KB. You can use larger value for these
two properties according to the specific needs.

......
<system.web>
 <httpRuntime executionTimeout="300" maxRequestLength = "10240" />
<httpHandlers>
......

If the blob data is over 30MB, then you will also need to make change to the IIS
maxAllowedContentLength property. The IIS maxAllowedContentLength property
specifies the maximum length of content in a request, in bytes. The default value is 30000000
bytes (which is about 30MB). In this case, follow steps below:

1. Back up the applicationHost.config file which is located in %system32%\inetsrv\config\
(e.g. C:\Windows\System32\inetsrv\config\applicationHost.config).

2. Modify the applicationHost.config file.

Change the value of overrideModeDefault property from Deny to Allow, as shown
below.

  <sectionGroup name="security">
…
     <section name="requestFiltering" overrideModeDefault="Allow" />
…
   </sectionGroup>

Some PC clients have stringent security rules which prohibit users modifying
applicationHost.config in %system32%\inetsrv\config\. To workaround this limitation,
you can copy the file to another location, make changes, and then copy it back to
%system32%\inetsrv\config\ to replace the old file.
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3. Modify the web.config file in %appeon home%\AEM\. You will need to modify the
maxRequestLength property and add the maxAllowedContentLength property, as
shown below.

This is the original script:

…
<system.web>
 <httpRuntime executionTimeout="300" maxRequestLength = "10240" />
<httpHandlers>
…

This is the modified script which allows operation with blob data of 60MB:

…
   <system.webServer>
        <security>
            <requestFiltering>
                <requestLimits maxAllowedContentLength="6291456" />
            </requestFiltering>
        </security>
    </system.webServer>
<system.web>
 <httpRuntime executionTimeout="300" maxRequestLength = "61440" />
<httpHandlers>

Step 2: Restart the IIS server to make this change take effect.

4.4.6.2 Manipulation on BLOB files for Adaptive Server Enterprise (ASE)

4.4.6.2.1 Blob size

To download BLOB data with a data size greater than 32 KB (the default), do the following:

• On Windows, set Text Size on the Advanced page of the Adaptive Server Enterprise
ODBC Driver Configuration window to be greater than the largest expected BLOB.

• On Linux, set the Text Size entry in the obdc.ini file to be greater than the largest expected
BLOB.

4.4.6.2.2 ASE ODBC settings

If your DB is ASE, then you can change the ASE ODBC settings for blob sizing. See the
following for more details:

http://dcx.sybase.com/1101/en/mlserver_en11/ml-basics-ase-5159304.html.

4.4.6.3 Manipulation on BLOB files for SQL Anywhere

When working against the SQL Anywhere database, Appeon Server has problems in
handling the blob files or retrieving data in CrossTab DataWindow.

Cause: if your DB is SAP SQL Anywhere 12 and you have installed SAP SQL Anywhere
12 on the machine, then when installing Appeon Server, Appeon will use the SAP SQL
Anywhere 12 driver to connect to the SQL Anywhere 10/11/12 by default.

Solution: you can use the following ways to switch the driver to the SQL Anywhere 11
database to connect to the SQL Anywhere 10/11/12, or you can uninstall the Appeon Server,

http://dcx.sybase.com/1101/en/mlserver_en11/ml-basics-ase-5159304.html
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install the SQL Anywhere 11, and then install the Appeon Server with selecting SQL
Anywhere 11 driver engine.

Step 1: Backup and delete the following files in C:\inetpub\wwwroot\appeon\AEM\bin.

• iAnywhere.Data.SQLAnywhere.dll

• Server.dll

• code.key

Step 2: Make a copy of the files in C:\inetpub\wwwroot\appeon\AEM\ServerDll\ASA11 and
paste the copies to C:\inetpub\wwwroot\appeon\AEM\bin.

4.4.7 Fail to parse the result meta of the Select statement

Retrieving data in Crosstab DataWindow fails with an error similar to "Failed to parse the
result meta of the Select statement, due to This column's data type cust_id requires the use of
an embedded SQL statement."

Cause & Solution: refer to Manipulation on BLOB files for ASA/SQL Anywhere.

4.4.8 Fail to update data

Data in a DataWindow object is retrieved correctly but cannot be updated.

Cause: An older version of Internet Explorer is used on the Client PC.

Solution: Upgrade Internet Explorer to Internet Explorer 8.0 or above.

4.4.9 Fail to update dynamically generated DataWindow

Dynamically generated DataWindow cannot be updated.

Cause: Uses the former version of Microsoft SQL Server 2005 SP1 with MSFT JDBC
Driver.

Solution:

Step 1: Replace the former version of Microsoft SQL Server 2005 SP1 with MSFT JDBC
Driver with the latest one, which can be downloaded from the Microsoft Website.

Step 2: Execute the stored procedure SQL statement
install_appeon_syntaxfromsql_MSSQL.sql (located in Appeon installation path
%AppeonHome%/sql/dynamicsql) in the SQL Server 2005 database server.

Step 3: Restart the application server.

4.4.10 Update error: Failed to update database due to java.sql.SQLException...
cannot insert the value NULL...

Updating data fails with an error similar to "Failed to update database due to
java.sql.SQLException... cannot insert the value NULL... column does not allow nulls..."

Cause: The number of rows that a trigger in the database counts differs from the number of
the rows that the Update operation sends to the JDBC driver.
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Solution: For SQL Server and ASE database with JDBC driver, use the "SET NOCOUNT
ON" statement before executing SQL statements when you create a trigger object.

For example:

CREATE TRIGGER trigger_name
ON { table | view }
[ WITH ENCRYPTION ]
{
{ { FOR | AFTER | INSTEAD OF } { [ INSERT ] [ , ] [ UPDATE ] }
[ WITH APPEND ] [ NOT FOR REPLICATION ]
AS
set nocount on  
[ { IF SELECT ( column )[ { AND | OR } UPDATE ( column ) ][ ...n ]
| IF ( COLUMNS_UPDATED ( ) { bitwise_operator } updated_bitmask )
{ comparison_operator } column_bitmask [ ...n ]} ]
Xsql_statement [ ...n ]
}
}

4.4.11 "Error converting data type A to B"

Executing a certain stored procedure is successful in PowerBuilder but gives an "Error
converting data type A to B" error message on the Web, where A and B stands for different
data types.

Cause: The procedure contains an output parameter that is A, but the corresponding variable
used to call the procedure is a B. JDBC driver may handle such a case differently from the
ODBC driver or native driver used in PowerBuilder.

Solution: Make sure the type of the calling variable is exactly the same as the type of the
output parameter.

4.4.12 Fail to update DataWindows with newly entered Korean characters

After Korean characters have been entered into a DataWindow the update is not successful.
The following error message is displayed "Failed to update primary buffer".

Cause: The length of the Korean characters that are inputted is longer than the length
specified for the field in the database table.

Solution: Specify a larger value for the length of the field in the database table.

4.4.13 SelectBlob and UpdateBlob have different results for non-binary fields

The SelectBlob and UpdateBlob functions have different results on the Web from using
PowerBuilder, when some non-binary fields are manipulated.

Cause: In some conditions, PowerBuilder automatically removes the spaces before and after
the non-binary characters when using SelectBlob and UpdateBlob. However, such operation
does not occur to the Web, which leads to different results.

Solution: Appeon recommends you to directly use Select and Update functions to manipulate
Blob type fields.

4.4.14 How to solve the messy code issue when retrieving data in Oracle

If you run into the messy code issue when retrieving data in Oracle, please try the solutions
below:
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Step 1: Set the NLS_LANG (equal to the database server) on the machine where the Appeon
Server is installed.

Step 2: Go to the Register on both Oracle Server and the Server on which Appeon Server is
installed to check whether the NLS_LANG is the same in the directory of:

HKEY_LOCAL_MACHINE>SOFTWARE_ORACLE.

Step 3: Try to use the following solution to check whether the Web application can solve the
Hebrew data issue.

1. Locate Web.config under C:\Intetpub\wwwroot\appeon\AEM on the machine with
Appeon Server installed.

2. Open Web.config with notepad and modify in the "globalization" line as shown below.

<globalization requestEncoding="utf-8" responseEncoding="utf-8" 
uiCulture="auto" culture="auto"/>

3. Save the changes to the file.

4. Restart IIS.

4.5 IWA issues

4.5.1 Cannot install IWA app via Microsoft Edge

If you are logged in as a non-administrator user, you may fail to install the IWA app using the
Microsoft Edge browser.

Solution: Go to the installation directory of the IWA Runner (such as C:\Users\%username%
\AppData\Local\Appeon\Appeon IWA Runner), right click the CheckNetIsolation.bat file
and then select Run as administrator to run this file. After that, try to install the IWA app
again.

4.5.2 IWA Runner installation repeatedly occurs

On some particular platforms such as Windows 8 Single Language and Windows 8.1 Pro 32-
bit, IWA Runner is repeatedly installed every time when you try to run an IWA app.

Solution: Add the application URL to the trusted sites in Internet Explorer, and then try to
run the IWA app again.

4.6 Others

4.6.1 Appeon Performance Analyzer continually popping up

The Performance Analyzer window keeps prompting, saying "Installation Complete. Please
Start the Web application", when starting the Appeon Performance Analyzer.

Cause: The enable third-party browser extensions* option of the Internet Options is
unavailable.
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Solution: To solve this, go to Internet Explorer > Tools > Internet Options > Advanced,
check the Enable third-party browser extensions* check box under Settings, and then
click Apply or OK to save the settings, as shown in the figure below.

Figure 4.25: Internet options

It is selected by default; however check to make sure that it is selected before you start the
Appeon Performance Analyzer.

4.6.2 ASE Chained mode issue

A PowerBuilder application can execute ASE stored procedures successfully. However, when
the PowerBuilder application is converted to the Web, the following error may occur:

"Select error: Stored procedure 'dbo.up_edw001_001' may be run only in unchained
transaction mode. The 'SET CHAINED OFF' command will cause the current session to use
unchained transaction mode".

Cause: There are three ASE stored procedure (SP) modes: chained, unchained and anymode.
There are two ASE transaction modes: chained and unchained. For Web applications:

1) If the transaction mode is chained, the SP running mode must be chained or anymode.
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2) If the transaction mode is unchained, the SP running mode must be unchained or anymode.

3) If the transaction mode and SP mode do not match the requirements in 1) or 2), the error
occurs.

Solution: Appeon provides two stored procedures that help modify the modes of ASE
stored procedures to ensure that the stored procedures meet the requirements in 1) or 2).
The following files are located in the "\sql\asechain_sql" folder under the Appeon Server
installation directory.

• readme.txt

• install_appeon_rebuildchainmode.sql: modifies the modes of ASE stored procedures

• uninstall_appeon_rebuildchainmode.sql: restores the original modes of ASE stored
procedures

Follow the instructions in the "readme.txt" for the method of modifying the stored procedure
modes with the two SQL files.

4.6.3 Windows open relatively slow

While accessing the Web application, Windows open slowly.

Cause: The hardware does not meet the minimum requirements needed to install Appeon.

Solution: Verify that the hardware configuration meets the minimum requirements stated in
Chapter 3, Installation Requirements in Installation Guide for .NET.

4.6.4 Web application is very slow if use SQL Anywhere 10 and Appeon Server
for .NET

When using Appeon Server for .NET, SQL Anywhere 10 users will encounter performance
difficulty in data manipulation.

Cause: The problem is caused by ADO.NET driver.

Solution: To resolve the performance issue you need to enable ODBC connection pooling in
ODBC DataSource Administrator with the instructions below:

Step 1: GO to Control Panel > Administrative Tools > ODBC DataSource Administrator
and Select the Connection Pooling tab page.

Step 2: Select SQL Anywhere 10 and click the Enable option in the PerfMon frame.
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Figure 4.26: Connection Pooling

Step 3: Click the Apply button to make this configuration take effort.

Step 4: Double click the SQL Anywhere 10 and Enable Pool Connection for this driver as
shown below.

Figure 4.27: Set Connection Pooling Attributes

4.6.5 ASA/SQL Anywhere engine crashes when you insert data into AppeonDB

ASA/SQL Anywhere engine crashes when you try to insert data to AppeonDB.

Cause: It may be caused by an SQL Anywhere bug.

Solution: Upgrade your ASA/SQL Anywhere 10 to the build 3835 or above, which you can
find at http://downloads.sybase.com.

4.6.6 Server NVO cannot be activated when the Web application is running

The server NVO can be successfully activated when it runs in PowerBuilder. However, when
the application is converted to the Web, the server NVO cannot be successfully activated.

http://downloads.sybase.com
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Cause: This often occurs when the server NVO is being deployed and the Allow NULL
values in method parameter option is selected.

Solution: Please follow the steps below:

Step 1: Double click the componentobject and open the Properties pages.

Step 2: In the General tab page, unselect the "Allow NULL values in method parameter"
option and redeploy the NVO.

Step 3: Open the EAServer Manager, generate the stub and skeleton for the deployed NVO.

Step 4: Restart the EAServer and rerun the Web application.

Note: Refer to the Migration Guidelines for Appeon Web (Web only) to deploy the server
NVO.

4.6.7 An item which usually requires one click must be clicked twice to be
selected

When running a Web application, you need to click twice to successfully select an item,
such as, selecting a radio button on the download page, which normally should require only
one click. This problem occurs only at the first selection and in the following environment:
Windows 2003 and Internet Explorer SP2.

Cause: This problem exists with patch kb912945 and patch kb912812 of Internet Explorer
SP2.

Solution: Currently there is no better solution than uninstalling patch kb912945 and patch
kb912812.

4.6.8 Special characters in URL cause missing parameters when being
redirected

If special characters (+, /, #, ?, %, &, etc.) are contained in the URL, parameters after the
special character will be lost when the URL is being redirected.

Cause: This problem occurs if index.html is used as the entry of application.

Solution: There are two solutions:

• Use index.htm instead of index.html as the entry of the application. For example, http://url/
index.htm?parameter. Do not use http://url/index.html?parameter, or http://url/?parameter.

• Use MSDN to convert the special characters when inputting the URL.

4.6.9 Weblibrary and cedownloadcenter DLLs cannot be updated

After the Appeon EBF 1045 patch is applied to the Appeon Server, for some users, when
the Appeon Web application is accessed, the Weblibrary and cedownloadcenter DLL files
in the "C:\Windows\Dowloaded Program Files" directory are not updated to the Appeon for
PowerBuilder 6.5.1045.0 version.

Cause: The application URL must be started by the entry page (index.html or index.htm or /),
otherwise, the Appeon plug-in cannot be initialized properly.

Solutions: The problem can be solved by removing 'x32_application.htm' from the URL.
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5 Troubleshooting Appeon Server
This section contains general information regarding troubleshooting problems related to
Appeon Server and AEM - the Appeon Server Manager. If you cannot resolve the problem
using the troubleshooting guide, please contact technical support at http://www.appeon.com/
support.

5.1 Loading AEM

5.1.1 AEM Web page cannot display or cannot display correctly in IE 9

When IE 9 is running in Compatibility View, AEM Web page displays correctly, but when
IE 9 is not running in Compatibility View, AEM Web page cannot display (returning a 406
error) or cannot display correctly.

Cause: The MIME type requested by IE 9 does not match with the MIME type specified
in the Web site. For example, in Windows 2003, the default MIME type for IIS is ".*
application/octet-stream"; when IE 9 is running in Compatibility View, it requested the
MIME type "*/*" when visiting the Web site, so it can successfully displays the Web page,
but when IE 9 is not running in Compatibility View, it requested the MIME type "text/css",
while this type is not specified in the Web site, so visits to file of this type are rejected.

Solution: Add a MIME type ".css text/css" in the Web site. Detailed steps are: open the IIS
Manager, right click the default Web site, select Properties from the popup menu, then click
the HTTP Headers tab, and then click the MIME Types button to add a MIME type.

5.1.2 Cannot log into AEM in IE 10

When IE 10.0 is running in Compatibility View, AEM Web page displays correctly, but
when IE 10.0 is not running in Compatibility View, AEM Web page cannot display correctly
after you logged in with the correct user name and password.

Cause: An IE limitation.

Solution A: Run the IE 10 in Compatibility View to log into AEM.

Solution B: Install the following hotfix patch and then try again.

Click here to download and install the hotfix patch.

5.1.3 Server Error in '/Servlet' Application

AEM does not show up when accessing AEM in Appeon Server, and errors like "Server
Error in '/Servlet' Application" occur saying "The file '/servlet/logon.aspx' has not been pre-
compiled, and cannot be requested." or "Error occurred when loading c:\inetpub\wwwroot
\Appeon\AEM\config\common.comfig file!", as shown in the following figures.

http://www.appeon.com/support
http://www.appeon.com/support
http://support.microsoft.com/kb/2600088
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Figure 5.1: Server Error in '/Servlet' Application 1

Figure 5.2: Server Error in '/Servlet' Application 2

Figure 5.3: Server Error in '/Servlet' Application 3
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Figure 5.4: Server Error in '/Servlet' Application (configuration error)

Cause A: The user does not have enough permission.

Solution A:

Step 1: Grant proper rights to .Net Framework with the two commands in the CMD window.

1. Navigate to C:\WINDOWS\Microsoft.NET\Framework\v2.0.****.

2. Execute the command line "aspnet_regiis -ga users".

3. Execute the command line "aspnet_regiis -i".

4. Restart the IIS (resetiis.exe).

Step 2: Grant Internet Guest Account and IIS Process Account proper rights to manipulate the
Web Root folder.

1. Go to the C:\Inetpub folder, then right click the wwwroot folder, and then select the
Security tab under the Properties item.

2. Add IIS_WPG group, if it is not listed in the "Group or user names" box.

3. Allow the IIS_WPG group to get the Full Control permission.

4. Restart the IIS.

Step 3: If these errors still occur, please re-install the Appeon Server.

Cause B: The Identity of Process Model of AppeonAppPool in IIS manager is not the
LocalSystem.

Solution B: Configure the Process Model settings of the AppeonAppPool in IIS manager.

Step 1: Open IIS manager.

Step 2: Click AppeonAppPool, and then click Advanced Settings.

Step 3: Change the Process Model from "NetworkService" to "LocalSystem" as shown in the
following figure.
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Figure 5.5: Process Model

The changed setting is as shown in the figure below.
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Figure 5.6: Process Model - Identity

Cause C: IIS settings should be different according to 32-bit OS or 64-bit OS.

Solution C:

If you are using 32-bit OS, go to IIS manager > Application Pools > AppeonAppPool
> Advanced Settings, in the Advanced Settings window, make sure the 'Enable 32-bit
application' is set to 'True'.

If you are using 64-bit OS, go to IIS manager > Application Pools > AppeonAppPool
> Advanced Settings, in the Advanced Settings window, make sure the 'Enable 32-bit
application' is set to 'False'.

Cause D: The config file is not the machine.config.default (.NET* only).

Solution D:

Step 1: Use the machine.config.default to replace the machine.config. Both of them are
located at Windows\Microsoft.NET\framework\v2.0.xxxxx\CONFIG.

Step 2: Login to AEM and do corresponding modification according to the prompts.

Step 3: Delete all files in %Appeon%/AEM/bin/config.
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Step 4: Re-log in to the AEM to make sure the problem is resolved.

Cause E (Figure: Server Error in '/Servlet' Application (configuration error)): The .NET
framework version or the ASP.NET version is not matched with the upgraded Appeon for
PowerBuilder.

This error probably occurs when you launch AEM or AEM with multiple instances after you
upgrade your Appeon for PowerBuilder 6.x to Appeon for PowerBuilder 6.6.x.

Solution E:

• For IIS 7.0 and later:

Step 1: Open IIS Manager by choosing Start > All Programs > Appeon for
PowerBuilder 2016 > Appeon Server for .NET > Internet Information Services (IIS)
Manager.

Step 2: Expand your computer (for example, WANGMINGLI-PC (wangmingli-pc
\wangmingli in the following figure), and then click Application Pools.

Figure 5.7: Application pools

Step 3: Select the application pool in the Application Pools panel, and then click Basic
Settings in the Actions panel. The Edit Application Pool window appears.

In the Edit Application Pool window, select the matched .NET Framework version (.NET
Framework v4.030319) from the .NET Frame version dropdown list box, and then click
OK to save the changes.
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Figure 5.8: Edit application pool

Step 4: Relaunch your AEM.

• For IIS 6.0:

Step 1: Open IIS Manager by choosing Start > All Programs > Appeon for
PowerBuilder 2016 > Appeon Server for .NET > Internet Information Services (IIS)
Manager.

Step 2: Expand your computer (for example, WANGMINGLI-PC (wangmingli-pc
\wangmingli in the following figure), click Web Sites, and then select your web site (for
example, web81).
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Figure 5.9: IIS manager

Step 3: Right-click AEM, and then select Properties from the popup menu.

In the AEM Properties window, select the matched ASP.NET version (4.030319) from
the ASP.NET version dropdown list box, and then click OK to save the changes.
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Figure 5.10: AEM properties

Step 4: Repeat Step 3 to specify the ASP.NET version for Appeon and Serverlet
respectively.

Step 5: Relaunch your AEM.

5.1.4 Object reference not set to an instance of an object

When running AEM, Web page displays the error "Object reference not set to an instance of
an object", as shown in figure below.
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Figure 5.11: Object reference not set to an instance of an object

Cause: The language settings of IE Internet Options is empty.

Solution: Add a language to the language settings of IE Internet Options, as shown in figure
below.

Figure 5.12: Language Preference
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5.1.5 Fail to pre-compile AEM

Pre-compiling AEM fails.

Cause & Solution: Refer to Demo Web application fails to call EJB component.

5.1.6 The AEM Web page cannot be displayed

Unable to access AEM's Web page.

Cause A: EAServer is not running

Solution A: Verify that EAServer is running and accepting connections

Cause B: The URL for AEM is incorrect

Solution B: The URL format should be http://hostname:portnumber/AEM. Verify that the
hostname is correct and that the portnumber is available. They are specified through the
appeonserverhttp listener in EAServer Manager.

The appeonserverhttp listener and the appeonserveriiop listener are created automatically
with Appeon Server installation. If they are not created successfully or not configured
correctly, they need to be manually added or modified.

If the problem is not resolved, please check whether the Jaguar.log is empty (at %JAGUAR
%\bin\ in Windows or $JAGUAR/bin/ in UNIX). If the Jaguar log is empty, refer to Cause C
and Solution C to rectify the problem.

Cause C: there are two possible causes for the problem:

The EAServer hosting AEM is not running correctly.

The application.properties file (at %JAGUAR%\Repository\WebApplication\AEM\WEB-
INF\classes\resources\ in Windows or $JAGUAR/Repository/WebApplication/AEM/WEB-
INF/classes/resources/ in UNIX) has not been successfully loaded into the Internet Explorer
browser (which usually happens the first time AEM is started).

Solution C: follow the steps below to fix the problem.

Step 1: Restart EAServer and verify that it is accepting connections.

Step 2: Verify that at least one of the Appeon Web demo applications can run correctly.

Step 3: Launch AEM with Internet Explorer. If AEM is not loaded successfully, please click
the Refresh button in the browser to load the application.properties file.

5.1.7 Error "500 Servlet jspservlet: ..."

When the user enters the AEM URL in Internet Explorer, an error message box pops up:
"500 Servlet jspservlet: unable to service request: Cannot find message resources under key
org.apache.struts.action.MESSAGE".

Cause: The AEM program cannot access the URL directly (for example,
http://hostname:portnumber/AEM/logon.jsp) without initializing .jsp files.

Solution: Access AEM at the URL http://hostname:portnumber/AEM (for example, http://
localhost:9988/AEM).

5.1.8 Fail to log into AEM with the default user name and password

Cannot log into AEM with the default user name and password.
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Cause: you may have changed the login username and password of the AEM when you
installed Appeon Server.

Solution: Use the username and password specified when you install Appeon Server.

If you want to restore the default settings, follow the two methods below:

1. Reinstall Appeon Server. During the reinstallation, do not change the login username and
password of AEM.

2. Revise the aem-config.xml file in the "...\Sybase\EAServer\appeon\repository\
%instancename%\config\" folder: replacing the 7th line in the file with the line <user
name="YWRtaW4=" password="YWRtaW4="/>, then restarting Appeon Server to make
the changes take effect.

5.1.9 Security settings in AEM do not take effect

Cause: Configured Security settings in AEM incorrectly.

Solution: The following settings in AEM enable application security so that only assigned
users can open the application. Users need to input user name and password when logging
into the application.

Step 1 - Go to AEM > Server > Server Security > User Management and add User Name
and Password.

Step 2 - Go to AEM > Server > Server Security > Group Management and add Group and
then assign users to the group.

Step 3 - Go to AEM > Application > Client Security > User Authentication and click your
application. Select "Security On" in User authentication.

Note: Make sure your settings are configured efficiently and clear the history in Internet
Explorer before opening the application. Restart EAServer and client machine if necessary.

5.2 Appeon Server

5.2.1 Error 10999 - Failed to start new transaction...

Failed to start new transactions when updating the data by using JBoss as the application
server and an error (error 10999) box pops up saying "Failed to start new transaction due to
com.appeon.server.controller.ControllerException: javax.naming.NameNotFoundException:
TransactionServiceLocal not bound" as shown in the figure below.
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Figure 5.13: Error 10999 - failed to start new transaction

Cause: This is a known issue for using JBoss 5. You may encounter the following errors
when JBoss is deploying the internal EJB component and saving the configuration files into
the internal database localDB.script, which will result in EJB deployment failure, during
launching the JBoss. In this situation, you will encounter the above "Error 10999..." error
during updating the data in the Appeon application.

Caused by: org.hsqldb.HsqlException: length must be specified in type definition:
 VARBINARY
                at org.hsqldb.error.Error.error(Unknown Source)
            at org.hsqldb.error.Error.error(Unknown Source)
            at org.hsqldb.ParserDQL.readTypeDefinition(Unknown Source)
                at org.hsqldb.ParserDDL.readColumnDefinitionOrNull(Unknown Source)
                at org.hsqldb.ParserDDL.compileCreateTableBody(Unknown Source)
                at org.hsqldb.ParserDDL.compileCreateTable(Unknown Source)
                at org.hsqldb.ParserDDL.compileCreate(Unknown Source)
                at org.hsqldb.ParserCommand.compilePart(Unknown Source)
                at org.hsqldb.ParserCommand.compileStatements(Unknown Source)
                at org.hsqldb.Session.executeDirectStatement(Unknown Source)
                at org.hsqldb.Session.execute(Unknown Source)
…

DEPLOYMENTS IN ERROR:
  Deployment "<UNKNOWN jboss.j2ee:jar=profileservice-
secured.jar,name=SecureProfileService,service=EJB3>" is in error due to the
 following reason(s): ** UNRESOLVED Demands 'jboss.ejb:service=EJBTimerService'
 **, ** UNRESOLVED Demands 'jndi:SecureManagementView/remote-
org.jboss.deployers.spi.management.ManagementView' **
  Deployment "jboss.ejb:persistencePolicy=database,service=EJBTimerService" is in
 error due to the following reason(s): org.hsqldb.HsqlException: length must be
 specified in type definition: VARBINARY, **ERROR**
  Deployment "<UNKNOWN jboss.j2ee:jar=profileservice-
secured.jar,name=SecureManagementView,service=EJB3>" is in error due to the
 following reason(s): ** UNRESOLVED Demands 'jboss.ejb:service=EJBTimerService' **
  Deployment "<UNKNOWN jboss.j2ee:jar=profileservice-
secured.jar,name=SecureDeploymentManager,service=EJB3>" is in error due to the
 following reason(s): ** UNRESOLVED Demands 'jboss.ejb:service=EJBTimerService' **

2013-05-14 14:37:58,718 INFO  [org.apache.coyote.http11.Http11Protocol] (main)
 Starting Coyote HTTP/1.1 on http-127.0.0.1-8080
2013-05-14 14:37:58,734 INFO  [org.apache.coyote.ajp.AjpProtocol] (main) Starting
 Coyote AJP/1.3 on ajp-127.0.0.1-8009
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2013-05-14 14:37:58,734 INFO  [org.jboss.bootstrap.microcontainer.ServerImpl]
 (main) JBoss (Microcontainer) [5.1.0.GA (build: SVNTag=JBoss_5_1_0_GA
 date=200905221053)] Started in 34s:266ms
2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) 
Appeon Server (Appeon for PowerBuilder 2013 Edition) started.

2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Edition: Unlicensed Edition
 (Appeon)
2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Universal Product Key: APFA-
DEWN-NTEN-UNTT-TTTT-TTTT-TTTT
2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Universal Maximum Sessions: *

2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Universal Maximum Deployed
 Applications: *

2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Days Remaining: 45

2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Number of CPUs Licensed: *
2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Server ID: Kg==

2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Activation Status: UNACTIVATED
2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Support Date: 
2012-07-20~2013-07-20
2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Clustering Option: Yes

2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Number of Cores Per CPU: *

2013-05-14 14:37:59,140 INFO  [STDOUT] (Thread-17) Type of CPU Licensed: Logic
…

Solution: The steps for resolving this issue are pasted below for your convenience. You
may also refer to this web page for the complete discussion https://community.jboss.org/
message/585994.

Step 1: Open the JBOSS_HOME/server/<servername>/conf/standardjbosscmp-jdbc.xml in a
text editor

Step 2: Search for the "Hypersonic SQL" type-mappping in that file. It will look something
like this:

<type-mapping>
    <name>Hypersonic SQL</name>
    <row-locking-template/>
    ...
    <mapping>
      <java-type>java.lang.Object</java-type>
      <!-- hsqldb only supports directly serializable objects for sql type OBJECT
 -->
      <jdbc-type>VARBINARY</jdbc-type>
      <sql-type>VARBINARY</sql-type>
    </mapping>
...
</type-mapping>

Step 3: Change the sql-type value to 1024.

<type-mapping>
    <name>Hypersonic SQL</name>
    <row-locking-template/>
    ...
    <mapping>
      <java-type>java.lang.Object</java-type>
      <!-- hsqldb only supports directly serializable objects for sql type OBJECT
 -->

https://community.jboss.org/message/585994
https://community.jboss.org/message/585994
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      <jdbc-type>VARBINARY</jdbc-type>
      <sql-type>VARBINARY(1024)</sql-type>
    </mapping>
...
</type-mapping>

Step 4: After this change, restart the server and see if it works.

If the above solution cannot solve this issue, please go to Developer > Configure > [your
application] > DB Settings tab and uncheck "Start transaction when executing stored
procedure" option, then deploy your application and try again.

5.2.2 JBoss console reports "...Stopped deployment appeonserver.jar..." error

The JBoss server console reports the "...Stopped deployment appeonserver.jar..." error (see
figure below) during the startup process.

Figure 5.14: Terminal

Cause A: There is not enough space left on the hard drive. Usually this will be explicitly
indicated by the following message in the log file:

Caused by: java.io.IOException: No space left on device

Solution A: Stop JBoss server. Clean up the temporary files under JBoss server (typically,
%JBOSS_HOME%\standalone\tmp) or clean up the hard drive to get more available space.

Cause B: The deployment has timed out. Usually you will see the following message in the
log file:

"Did not receive a response to the deployment operation within the allowed timeout 
period [60 seconds]. 
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Check the server configurationfile and the server logs to find more about the 
status of the deployment."

Solution B: Increase the timeout value for deployment in WildFly or JBoss EAP by the
following steps:

Step 1: Open the %JBOSS_HOME%\standalone\configuration\standalone.xml file in a text
editor.

Step 2: Locate and modify the "deployment-timeout" setting under the "subsystem" element.
The default value is 60 seconds.

<subsystem xmlns="urn:jboss:domain:deployment-scanner:1.0">
            <deployment-scanner name="default" path="deployments" 
scan-enabled="true" scan-
interval="5000" relative-to="jboss.server.base.dir" deployment-timeout="600"/>

5.2.3 JBoss console hangs during startup process

The JBoss server console hangs during the startup process.

Solution:

Step 1: Go to the %JBOSS_HOME%\standalone\deployments\ folder and delete any file with
a .failed extension, for example, appeonserver.ear.failed.

Step 2: Clean up the temporary files under the %JBOSS_HOME%\standalone\tmp\ folder.

Step 3: Restart JBoss server.

5.2.4 "Remote connection failed: java.io.IOException: Message data for non-
existent channel"

After you operated on the Transaction Object page in AEM, for example, you clicked the
link of the application name or the Update or Test button on the Transaction Object page,
you will find the following error displayed in the JBoss console or the JBoss server log
file. This is a bug in JBoss AS 7.0.2 (for more, please see http://community.jboss.org/
message/641888#641888). However, this error will not have any impact to Appeon Server,
therefore, you can simply ignore it if you confirmed that this error occurs only after you
operate on the AEM >Transactions > Transaction Objects page.

00:40:53,301 INFO  [org.xnio.nio] (pool-4-thread-1) XNIO NIO Implementation 
Version 3.0.0.Beta3
00:40:55,219 ERROR [org.jboss.remoting.remote] (XNIO NIO Read 1) JBREM00200: 
Remote connection failed: 
java.io.IOException: Message data for non-existent channel
00:41:06,290 ERROR [org.jboss.remoting.remote] (XNIO NIO Read 5) JBREM00200: 
Remote connection failed: 
java.io.IOException: Window open for non-existent channel
00:41:06,606 ERROR [org.jboss.remoting.remote] (XNIO NIO Read 6) JBREM00200: 
Remote connection failed: 
java.io.IOException: Window open for non-existent channel
00:41:17,287 ERROR [org.jboss.remoting.remote] (XNIO NIO Read 8) JBREM00200: 
Remote connection failed: 
java.io.IOException: Window open for non-existent channel

5.2.5 AEM cannot access WebSphere data sources when global security is on

If the global security mode is turned on in WebSphere, AEM will not be able to access the
WebSphere data sources.

http://community.jboss.org/message/641888#641888
http://community.jboss.org/message/641888#641888
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Solution: You can take the following steps to work around the problem.

Step 1: Go to the %user.install.root%\properties directory (%user.install.root% indicates the
WebSphere instance installation directory, for example, C:\Program Files\IBM\WebSphere
\AppServer\profiles\AppSrv01\), open the sas.client.props file in text editor, and modify the
following three properties:

• com.ibm.CORBA.loginUserid: set to the WebSphere account username.

• com.ibm.CORBA.loginPassword: set to the WebSphere account password.

• com.ibm.CORBA.securityServerPort: set to the WebSphere IIOP port, if it is not the
default port 2809. This port number is modified by using the BOOTSTRAP_ADDRESS
property in the WebSphere console (as shown below).

Figure 5.15: WebSphere console

Step 2: Save changes in sas.client.props and then restart WebSphere.

Note: After making the above changes, everytime when a data source is created, you will
need to restart WebSphere so the new data source is accessible to AEM.

If the global security mode is turned off, you will need to remove settings of
com.ibm.CORBA.loginUserid and com.ibm.CORBA.loginPassword from the sas.client.props
file.

5.2.6 Appeon Server is dead when dynamically creating a DataWindow

When dynamically creating a DataWindow, the CPU usage in server reaches 100% and the
server cannot respond unless it is restarted. The log file records nothing after the message:
"[com.appeon.server.command.DynamicDWCommand (execute)] Begin to parse and syntax
from sql-statement".

Cause: The Appeon stored procedure "sp_appeon_syntaxfromsql" has a parameter
"tableColumnList" with a value of "varchar(4000)", which limits the total length of all
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columns to 4000 characters. If the total length exceeds this limit, the stored procedure will be
trapped in an endless loop.

Solution:

1) Open the "install_appeon_syntaxfromsql_XXX" file at %appeonserver%\sql\dynamicsql,
and locate the following lines of script:

  create procedure dbo.sp_appeon_syntaxfromsql(
  @tableColumnList varchar(4000),
  @tableList varchar(2000),
  @extraList varchar(40)='1' )

2) Set the "tableColumnList" parameter to a proper value, such as "varchar(8000)".

5.2.7 Appeon Server responds to user requests slowly

It takes time to compile at Appeon Web application startup. However, during application
runtime, it seems that Appeon Server still responds slowly.

Cause A: An excess of temporary files or very large Appeon log files can slow down Appeon
Server's performance.

Solution A: Follow the steps below to fix the problem:

Step 1: In AEM, open AEM Console > Server > Logging, and then check whether the
Never replace log files option is checked. If it is checked, go to the log file directory:
\Appeon\Developer2016\Project\ApplicationName\Debug(or Release)\Log\ and manually
delete the large log files.

Step 2: Clean up all temporary files in AEM Console > Server > Resources >
Maintenance.

Cause B: A large number of dead sessions or transactions will consume server resources, and
affect performance.

Solution B: Kill the dead sessions and roll back the dead transactions in AEM Console >
Server > Sessions > Active Transactions.

5.2.8 AEM cannot interface with a particular Appeon Server

Unable to connect to a desired Appeon Server with AEM.

Cause: The Appeon Server has not been added into the Appeon Server Cluster in AEM or
has not been configured correctly.

Solution: Follow the steps below to fix the problem.

Step 1: Verify that Appeon Server has been added to the Appeon Server cluster in AEM
Console > Server > Resources > Cluster.

Step 2: Verify the correct IP Address or Machine Name of the Appeon Server has been
entered.

• Use the actual machine name instead of "localhost" for Machine Name.

• In EAServer Manager, choose EAServer Manager > Servers > AppeonServerName
> Listeners, and verify that an HTTP (or HTTPS) listener profile has been added with
"Hostname" set as the IP address or machine name of the Appeon Server.
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5.2.9 "Failed to load the remote interface" error

After Appeon Server is installed and started, AEM cannot start, and the Internet Explorer
gives the error "Page not found". When launching an Appeon demo application, the Internet
Explorer gives the error "Failed to load the remote interface". In Jaguar.log, you will get the
error"Unable to service requests for servlet".

Cause: EAServer is corrupt and cannot support the running of servlets.

Solution: Uninstall Appeon Server and EAServer, remove the %JAGUAR% folder
completely, and then reinstall EAServer and Appeon Server.

5.2.10 JDBC/ODBC TDS data type discrepancy on SQL Anywhere

With an SAP ASA/SQL Anywhere database using JDBC, the date, time, and TimeStamp
data types are treated as one DateTime data type.

Cause: ASA/SQL Anywhere does not distinguish date, time, and TimeStamp for JDBC - this
is an unsupported feature. However these data types are fully supported for other database
interfaces, such as ODBC. SAP recommends using the provided iAnywhere or a JDBC-
ODBC bridge to work around this TDS unsupported feature where JDBC is required.

Solution: Use the iAnywhere JDBC bridge driver supplied with SAP ASA/SQL Anywhere
8.0.2 and above. Make sure you apply the latest EBF for the driver so that the latest bug fixes
are installed. Although the SUN JDBC-ODBC bridge driver can also be used to resolve this
issue, the iAnywhere JDBC driver is highly recommended since it is designed to provide
optimal performance and stability with SAP databases and Appeon Server.

5.2.11 Empty/Null value update error if SQL Anywhere/ASE

If the Web application uses an SAP Adaptive Server Enterprise (ASE) database or an ASA/
SQL Anywhere database that is set as ASE-compatible, database updates may fail.

Cause: If the length is 0 or the value of the data is NULL for any data in a database table
where the data is of a string type, such as varchar or char data type, the data retrieved from
the database through a JDBC driver will have a length greater than 0. Rather than a null
value, the data returned will be padded with a series of spaces. As a result of this padding, the
database update will fail.

Solution: You can work around this issue in one of two ways:

1. For SAP ASA/SQL Anywhere and ASE databases, Appeon recommends that you do
not use a Native-protocol/all-Java JDBC driver. There are a number of JDBC-ODBC
bridge drivers that can be used, such as those from SUN or the iAnywhere driver. However,
iAnywhere is one of the best performing and most stable bridge drivers available.

2. For SAP ASA/SQL Anywhere, if it is preferential to use a JDBC driver, you will need to
adjust the database accordingly. Change the SQL Anywhere database setting so it is set to be
incompatible with ASE.

5.2.12 Web application does not run when the database is disconnected by
exception

When the database is disconnected by exception, the Web application stops working. Closing
and re-opening the application does not fix the problem.
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Cause: When the database is disconnected by exception, the status of the data source to the
database remains connected in EAServer. When the application is restarted, EAServer will
not try to reconnect the database.

Solution: Any of the following operations should resolve the problem.

1. Restart EAServer

2. Refresh the relevant data source using EAServer Manager

5.2.13 "Table or view not found" error

Fail to open the window that contains DataWindows with DB connection.

Causes A: The database does not contain the table mentioned in the error message.

Solution A: Search the table in the database and make sure the table does exist.

Cause B: The configuration for the database connection is incorrect.

Solution B: To solve the problem, verify that you have done all the following configuration
steps correctly on Appeon Server machines, Appeon Developer machines, and the Client
machines that plan to run the Web application. Please pay special attention to step 1, 4, and 8.

Configurations on Appeon Server machines:

Step 1: Set up a data source for connecting to the application database. Make sure the data
source can be pinged successfully.

Step 2: Start the server.

Configuration on Appeon Developer machines

(You can refer to Appeon Developer User Guide for details of the following steps):

Step 3: Load the POWERBUILDER application in PowerBuilder 9 and make sure the full
build of the application is successful.

Step 4: Configure an application profile in the Appeon Developer Configuration window. In
this configuration, make sure the application DB profile is configured correctly.

Step 5: Configure an Appeon Server profile in the Appeon Developer Configuration window,
which connects to "tmk.starshoes.com.mx". Make sure the testing connection is successful.

Step 6: Configure a Web Server profile in the Appeon Developer Configuration window,
which connects to the server that you installed "Appeon Server Web Component" too. Make
sure the testing connection is successful.

Step 7: Configure a deployment profile in the Appeon Developer Configuration window,
which connects to the configured Appeon Server profile and Web Server profile.

Step 8: Access to Appeon AEM via the AEM button in the Appeon Developer toolbar, and
set up the transaction object to data source mapping.

Step 9: Deploy your application with the Appeon Deployment Wizard.

Configurations on client machines that runs the Web application:

Step 10: Delete all the temporary files stored in Internet Explorer cache.

Step 11: Delete the Xcelerator plug-in that has been downloaded to the client: delete the
files at \WINNT\Downloaded Program Files (Windows 2000) or \WINDOWS\Downloaded
Program Files (Windows 2003).
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Step 12: Verify the Internet Explorer security settings: for the appropriate zone in the Internet
Explorer Security, make sure the security is set to default.

5.2.14 "Table already exists" error

When you execute the SQL file from Appeon using database tools, an error message may pop
up saying, "Table already exists".

Cause: The SQL file from Appeon will create five PowerBuilder System Tables: pbcatcol,
pbcatedt, pbcatfmt, pbcattbl, and pbcatvld. If the five tables already exist, the error message
will display.

Solution: s Appeon rebuilds the PowerBuilder System Tables to make sure the stored
procedures from Appeon Server will be successfully created. You can click No on the
message window to use the original system tables, or click Yes to rebuild these tables. Your
choice will not affect the execution result.

5.2.15 Appeondb is not started when EAServer starts

After the Appeon Server installation, start EAServer/Appeon Server. EAServer/Appeon
Server starts successfully while Appeondb is not started.

Cause & Solution: Refer to Cannot start EAServer Manager.

5.2.16 Fail to ping appeondb data source

When pinging the appeondb data source, no connection is made.

Cause: Pinging appeondb fails because the data source is not configured correctly.

Solution: Follow these steps below to fix the problem.

Step 1: Verify that the Appeondb system DSN exists in the ODBC Data Source
Administrator (Control Panel > Administrative Tools > Data Sources (ODBC)).
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Figure 5.16: ODBC Data Source Administrator

Select Configure to open the data source configuration window.
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Figure 5.17: Configure data source

Note: AppeonServer.db applies an encrypted password. Test Connection on the ODBC
tab will not be successful since the encrypted password is not available in Data Source
Configuration.

Verify that the Appeondb data source configuration is the same as follows.

• Verify the Appeondb Login (User ID: appeon; Password: empty).
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Figure 5.18: Configure user ID and password

• Verify the Appeondb Database (Database file: the full path to %JAGUAR%\appeon\db
\AppeonServer.db).
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Figure 5.19: Configure the database

Step 2: Right-click the appeondb data source in EAServer Manager and select "Properties" to
open the Connection Cache Properties window.
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Figure 5.20: Select Properties

Verify the properties for the appeondb data source.

• Verify the configuration on the General tab (Server Name: jdbc:odbc:AppeonDB; User
Name: appeon). Make sure that the password keeps the default setting. If you have
modified the Password, the appeondb data source will not work and you will have to
reinstall Appeon Server to restore the default password.
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Figure 5.21: Configure general information

• Verify the configuration on the Driver tab. Select JDBC and specify the driver string as
sun.jdbc.odbc.JdbcOdbcDriver.
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Figure 5.22: Configure Driver

Step 3: Right-click the appeondb data source in EAServer Manager and select "Ping" to test
the database connection again.

5.2.17 Fail to ping appeonsample data source

When pinging the appeonsample data source, no connection is made.

Cause: Ping of appeonsample fails because the data source is not established correctly.

Solution: Follow the steps below to fix the problem.

Step 1: Verify that the AppeonSampleForServer system DSN exists in the ODBC Data
Source Administrator (Windows Control Panel > Administrative Tools > Data Sources
(ODBC)).
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Figure 5.23: System DSN

Select Configure, and click Test Connection on the ODBC tab to check
AppeonSampleForServer connectivity.
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Figure 5.24: Check the data source

If the Appeondb data source does not exist or the connection test fails, try to manually add/
configure the data source.

• Configure the Appeondb Login (User ID: dba; Password: sql).
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Figure 5.25: Configure user ID and password

• Configure the AppeonSampleForServer Database.
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Figure 5.26: Configure database

Step 2: Verify that the appeonsample data source exists in EAServer Manager.



Troubleshooting Appeon Server Appeon® for PowerBuilder® 2016

Troubleshooting Page 114

Figure 5.27: Select Properties

Right-click the appeonsample data source and select "Properties" to open the Connection
Cache Properties window.

• Check the configuration in the General tab (Server Name:
jdbc:odbc:AppeonSampleForServer; User Name: dba; Password: sql).
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Figure 5.28: Configure general information

• Check configuration in the Driver tab, and verify that the same settings are used. Select
JDBC and specify the driver string as "sun.jdbc.odbc.JdbcOdbcDriver".
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Figure 5.29: Configure Driver

Step 3: Right-click the appeonsample data source in EAServer Manager and select "Ping" to
test the database connection again.

5.2.18 Fail to ping data sources for SQL Server 2000

Cause A: The data source is not configured to use MS SQL Server Native Driver.

Solution A: Use MS SQL Server Native Driver for this application.

Cause B: The Database Host is incorrectly specified.

Solution B: Use Localhost, IP Address and machine name as the input parameter for the
"Database Host".

Cause C: The SQL Server database is not updated.

Solution C: Upgrade to SQL Server 2000 SP3 or above. The latest Service Pack (SP4)
for SQL Server is available at http://www.microsoft.com/downloads/details.aspx?
familyid=8e2dfc8d-c20e-4446-99a9-b7f0213f8bc5&displaylang=en.

5.2.19 "com.sybase.jaguar.util.JException: [Microsoft][SQLServer 2000 Driver
for JDBC]Error establishing socket."

Cannot get connection for cache and display the error message
"com.sybase.jaguar.util.JException: [Microsoft][SQLServer 2000 Driver for JDBC]Error
establishing socket".

http://www.microsoft.com/downloads/details.aspx?familyid=8e2dfc8d-c20e-4446-99a9-b7f0213f8bc5&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=8e2dfc8d-c20e-4446-99a9-b7f0213f8bc5&displaylang=en
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Cause: The driver from Microsoft cannot handle windows integrated authentication.

Solution:

Step 1: Make sure that SQL Server is set to mixed authentication. To do this, open enterprise
manager, right click on server/properties.

Step 2: Keeping the server properties dialog up, go to the general tab and push the network
configuration button. Enable TCP/IP (it is disabled by default).

Step 3: Add an SQL Server login account (not a Windows account).

Step 4: Use the login setup in Step 3.

You can find detailed information from the following Website: http://support.microsoft.com/
default.aspx?scid=kb;en-us;313178

5.2.20 "java.sql.SQLException:[Microsoft][ODBC SQL Server
Driver]Connection is busy with results for another hstmt" Error when using the
Microsoft SQLServer database

The data source can be pinged successfully. The DataWindows cannot open when you run
the application on the Web. The error messages "java.sql.SQLException:[Microsoft][ODBC
SQL Server Driver]Connection is busy with results for another hstmt" displays on the Web.

Cause: Use the JDBC-ODBC bridge driver when setting up the data source for Microsoft
SQL Server.

Solution: Use the JDBC driver:

1. Before you configure a JDBC data source, there are a few preparations that need to be
done. Refer to Section 4.2.4, “JDBC driver preparation” in Appeon Server Configuration
Guide for J2EE.

2. If you change any setting of the data source, restart EAServer to apply the changes.

5.2.21 Error converting data type varchar to datetime

If the output parameter of a stored procedure is varchar, when the variable of the datetime
type calls the parameter, the following error message displays in the SQLCA Information:
"Error converting data type varchar to datetime".

Cause: The varchar parameter fails to be converted to datetime, because the parameter length
is too short in the database; for example, varchar(10).

Solution: Modify the code.

Call the varchar parameter with a string variable.

5.2.22 "ORA-01461" error in AEM when test a data source

Failed to test the data source in AEM and prompted with "ORA-01461 error".

Cause: This is an oracle JDBC driver error.

Solution: Update to the latest driver released in Oracle Web site.

http://support.microsoft.com/default.aspx?scid=kb;en-us;313178
http://support.microsoft.com/default.aspx?scid=kb;en-us;313178
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5.2.23 "oracle 9i failed: System.Data.OracleClient requires Oracle client
software version 8.1.7 or greater"

Failed to test the data source in AEM and prompted with the error messages "oracle 9i failed:
System.Data.OracleClient requires Oracle client software version 8.1.7 or greater".

Cause: Oracle 9i Client software requires that the login user have the Authenticated User
privilege to the Oracle Home in the client hosting machine.

Solution: You can follow the instruction below to finish the right grant:

Step 1: Login to Windows as a user with Administrator privileges.

Step 2: Launch Windows Explorer from the Start Menu and navigate to the
ORACLE_HOME folder. This is typically the "Ora9i" folder under the "Oracle" folder (i.e.
D:\Oracle\Ora9i).

Step 3: Right-click on the ORACLE_HOME folder and choose the "Properties" option from

the drop down list. Then the Properties window should appear.

Step 4: Click on the Security tab of the Properties window.

Step 5: Click on Authenticated Users item in the Name list.

Step 6: Uncheck the Read and Execute box in the Permissions list under the Allow column.

Step 7: Re-check the Read and Execute box under the Allow column (this is the box you just
unchecked).

Step 8: Click the Advanced button and in the Permission Entries list make sure you see the
Authenticated Users listed there with:

Permission = Read & Execute

Apply To = This folder, subfolders and files

Double check the Apply onto drop-down box and make sure it is set to This folder,
subfolders and files.

Step 9: Click the OK button until you close out all of the security properties windows. The
cursor may present the hour glass for a few seconds as it applies the permissions you just
changed to all subfolders and files.

Step 10: Reboot your computer to assure that these changes have taken effect.

5.2.24 Procedure 'appeon_procdataobjects' not found

Web application cannot run properly on the Web and the "Procedure
'appeon_procdataobjects' not found" error is reported in AppeonServer log file.

Cause: A possible cause of the error is you configured DataWindow data cache in AEM but
forgot to execute corresponding SQL to make this feature take effect.

Solution: Execute the corresponding SQL according to the instructions in Section 5.4.8.3,
“DataWindow Data Cache” in Appeon Server Configuration Guide for .NET or in Appeon
Server Configuration Guide for J2EE.

5.2.25 EAServer 6.x startup error

The following errors occur when starting EAServer 6.x from the DOS mode.
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Figure 5.30:

Cause: More than one EAServer 6.x instance is running, and the port that Appeon requires is
occupied by the running instance, this causes Appeon Server to fail to generate the complete
configuration file during startup.

Solution: Please go to {EAServer6}\appeon\repository\{instance_name}\config folder and
verify that it contains the following 10 files:

aem-config.xml

aem-mapping.xml

appeoncache.conf

applications-config.xml

cluster-config.xml

threadqueue.xml

server-config.xml

mapping.xml

log4j.properties

cluster-mapping.xml

If any of the above files is missing, please delete the entire {EAServer6}\appeon\repository
\{instance_name}\ folder (including files in it) and start EAServer again.

5.2.26 Fail to start Appeon Server on JEUS

Appeon Server cannot be started at the first time.
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Cause: The JEUS server is not correctly configured.

Solution:

Step 1: Make sure the node is successfully booted, as shown in the following figure. In the
JEUS Web Manager, select the node name in the JEUS Node Tree pane, and then click
Control on the right pane. Select the node name check box in the Boot tab and click OK.

Figure 5.31: JEUS Manager - Control

Figure 5.32: Prompt message

Step 2: Make sure the Engine Container is on Running status via clicking the node name >
Engine Containers.
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Figure 5.33: Engine Container

5.2.27 Status Monitor exits after restarting Appeon Server for WebLogic in
Linux

In Linux environment, when Appeon Status Monitor detects that Appeon Server for
WebLogic shuts down, it will restart Appeon Server for WebLogic, but it can only restart
Appeon Server for only one time, after that, Status Monitor will stop running, and cannot
restart Appeon Server for WebLogic when it shuts down again.

Cause: It is a bug of Appeon Status Monitor.

Solution: Modify the $appeon/bin/appeonserverstart.bat file, by changing script

"$WEBLOGIC/startWebLogic.sh"

To

gnome-terminal –e "$WEBLOGIC/startWebLogic.sh"

5.2.28 The data source test will fail if the Shared memory is checked

If you are running a SQL Anywhere network server engine (for example, using dbsrv11.exe
or running a network service), then the ODBC DNS cannot have Shared memory checked or
else the data source test will fail.
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Figure 5.34: Shared memory caused error

Solution: Uncheck the Shared memory checkbox on the Network tab.

5.2.29 "Library used incorrectly" error

The "Library used incorrectly No transaction is active on this connection" error occurs when
performing an update to the appeondb database in the Web application (such as calling
SetProfileString to write INI settings to appeondb).
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Figure 5.35: Error

And the following message is recorded in the appeonerror.log file.

2014-05-13 17:58:27.274 : Library used incorrectly
No transaction is active on this connection
   System.Data.SQLite.SQLiteTransaction.IsValid(Boolean throwError)
   System.Data.SQLite.SQLiteTransaction.Rollback()
   Appeon.ApplicationDB.DataAccess.AddInit(Int32 id, String applicationName, String
 content)
   Appeon.Server.Commands.SaveRegistryIniFileCommand.Execute()

Cause: The hard drive where Appeon Server is installed is running out of disk space, which
causes Appeon Server to fail to write to the appeondb database.

Solution: Free up the hard drive space to have at least 500 MB available space and then
restart Appeon Server.

5.3 Appeon Server Cluster

5.3.1 Loading application is slow when Appeon Cluster works in virtual
machines

After configuring the Appeon Server cluster to work in virtual machines, it is very slow to
open the Web application from the Web Server.

Cause:

When receiving the requests from the client, the Web Server needs to search for the available
application servers. During this time if one of the application servers is shut down, then the
Web Server will not search for the next application server until the session times out.

Solution A (Recommended):

We strongly recommend clustering Appeon Server across physical machines instead of
virtual machines, because physical machine is more stable and faster in performance and
network communication.

Solution B:

If Appeon Server cluster must work in virtual machine, please check and make sure all
application servers are turned on.

5.3.2 Retrieving data is slow when Appeon Cluster works in virtual machines

After configuring the Appeon Server cluster to work in virtual machines, it is very slow to
retrieve data from the database.

Cause: The slowness is caused by the network card “Broadcom" installed to the host server
and used by the host server to communicate with the virtual machines.
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Solution A (Recommended):

We strongly recommend clustering Appeon Server across physical machines instead of
virtual machines; this can avoid communication between the host server and the virtual
machines.

Solution B:

Step 1: Change the network card of the host server from Broadcom to Realtek, such as
Realtek PCle GBE Family.

Step 2: (Optional) Disable the "Large Send Offload" property (if available) to further
improve the network card performance. This property is available for certain network cards
only, not all. See below for detailed steps.

Step 3: (Optional) Change the network card type of the virtual machine to "AMD PCNet
Family" to gain further improvements. See below for detailed steps.

To configure the "Large Send Offload" property, follow steps below:

1) In the Local Area Connection Properties window, select Client for Microsoft
Networks, and then click the Configure button.

Figure 5.36: Local Area Connection Properties

2) Click the Advanced tab, select Large Send Offload V2 (IPv4) and set its value to
Disabled, and then disable Large Send Offload V2 (IPv6) in the same way.



Troubleshooting Appeon Server Appeon® for PowerBuilder® 2016

Troubleshooting Page 125

Figure 5.37: Advanced tab

To change the network card type of the virtual machine to "AMD PCNet Family" follow
steps below:

For VMWARE 6 and earlier versions:

1) Open the .vmx file under the directory which has the virtue machine installed.

2) Modify the value of ethernet0.virtualDev to "vlance" ethernet0.virtualDev=" vlance"; or
directly delete this parameter.

For VMWARE 7 and later versions:

1) Open the .vmx file under the directory which has the virtual machine installed.

2) Add all parameters related to ethernet[n] and pciBridge[n], except
ethernet[n].generatedAddress. You may need to refer to the .vmx file of VMWARE 6 (as
shown below) to find out all the related parameters.

Note: Please do not copy ethernet[n].generatedAddress, because it is used for defining the
MAC address.
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Figure 5.38: Copy address
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6 Troubleshooting PowerBuilder and EAServer
This section contains information about PowerBuilder and EAServer issues that may
typically occur when using them with Appeon. If you cannot resolve the problem with this
troubleshooting guide, please contact technical support at http://www.appeon.com/support.

6.1 PowerBuilder issues

6.1.1 Nested reports over five pages do not display

Nested reports longer than five pages cannot be displayed in DataWindows in the deployed
Web application.

Cause: A PowerBuilder limitation.

Solution: SAP recommends that you view/print the nested reports longer than five pages in
PDF format.

6.1.2 Upgrading to a different Build of PowerBuilder

When updating the PowerBuilder version to another Build, objects in the original
PowerBuilder application occasionally fail to be automatically migrated to a new Build.

Cause: A PowerBuilder limitation.

Solution: Perform a "Full Build" on existing PowerBuilder applications after a Build upgrade
has been made to PowerBuilder.

6.1.3 Data range issue with n-Tier NVOs

If the data used in the PowerBuilder NVO is beyond the range that the corresponding Java
code can support, there will be errors when it is deployed to the Web.

Cause: PowerBuilder NVOs and the generated Java components support different data
ranges. For example, in PowerBuilder, the supported range for an Unsigned Integer is
0-65,535, whereas the corresponding Java component will only support a range no larger than
32,767.

Solution: Use a different data type, or keep the data value within the scope that both
PowerBuilder and Java support.

6.2 EAServer issues

6.2.1 java.io.IOException: Keystore was tampered with, or password was
incorrect

When starting EAServer, an error occurs: java.io.IOException: Keystore was tampered with,
or password was incorrect.

Solution: Go to %JAGUAR%\Repository\Instance\com\sybase\djc\server\ApplicationServer,
for example, C:\Program Files\Sybase\EAServer6\Repository\Instance\com\sybase\djc\server
\ApplicationServer, open the instance properties file (for example, EAServer.properties) in a
text editor, and change the password from * to changeit. There are two areas that should be
changed, as shown in the bold text below.

http://www.appeon.com/support
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#Instance Properties
#Fri Feb 14 13:33:05 CST 2015
keyStorePassword=changeit
systemExcludeModules=none
httpListeners=http1,https1,https2,appeon_http
startResources=none,com.sybase.djc.sql.DataSource\:test2
createTables=true
iiopListeners=iiop1,iiops1,iiops2,appeon_iiop
scheduledTasks=AutoDeploy,AutoRefresh,CheckMemoryUsage,LocalRestart,LocalStop
rmiListeners=rmi
excludeModules=none
keyStore=${djc.home}/Repository/Security/keystore.jks
jtdsListeners=jtds
trustStore=${djc.home}/Repository/Security/truststore.jks
ant.project=default-application-servers
startModules=all
serviceComponents=ConnectorWorkManager,HelpServer,MBeanServer,JaguarServer
trustStorePassword=changeit
createTablesOnInit=true

6.2.2 "License error: 10999 ..." when starting Appeon Server in 64-bit OS

After installing Appeon Server to EAServer running on 64-bit OS, the following error occurs
when Appeon Server starts.

Figure 6.1: License error

Cause A & Solution A: Same as the error "Cannot find the language resource file
(dblgzh11.dll, dblgen11.dll)".

Cause B: EAServer is not running in 64-bit mode.

Solution B: See below for how to configure and run EAServer 6.x on a 64-bit OS.

Step 1: Download and install the 64-bit version of JDK.
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1. Download jdk-1_5_0_15-windows-amd64.exe.

1. Go to http://java.sun.com/products/archive/j2se/5.0_15/index.html.

2. Click "Download JDK", and then click "Yes".

3. Select "Windows x64" platform.

4. Select "I agree to the Java Development Kit 5.0 Update 15 License Agreement" to
continue.

5. Click "jdk-1_5_0_15-windows-amd64.exe" and save the file.

2. Download jdk-6u10-rc2-bin-b32-windows-amd64-12_sep_2008.exe.

1. Go to http://java.sun.com/javase/downloads/ea/6u10/6u10rcDownload.jsp#6u10JDKs.

2. Click "jdk-6u10-rc2-bin-b32-windows-amd64-12_sep_2008.exe" and save the file.

3. Install JDK by running the downloaded file: jdk-1_5_0_15-windows-amd64.exe, and
jdk-6u10-rc2-bin-b32-windows-amd64-12_sep_2008.exe

Suppose the installation directory is %Sybase%\shared\jdk-1_5_0_15, and %Sybase%\shared
\jdk-1_6_10.

Step 2: Configure the JDK location in set-java-home.bat (or set-java-home.sh in UNIX). For
example,

set DJC_JAVA_HOME_15=%Sybase%\shared\jdk-1_5_0_15

or

set DJC_JAVA_HOME_16%Sybase%\shared\jdk-1_6_10 3.

Step 3: Configure the maximum or minimum heap size in djc-set-env.bat (or djc-set-env.sh in
UNIX). For example,

set DJC_JVM_MAXHEAP=1024M
set DJC_JVM_MINHEAP=256M

Step 4: If you will always run EAServer in 64-bit mode, set up these flags in local-setenv.bat
(or local-setenv.sh in UNIX). For example,

DJC_RT_DEFAULT=15
DJC_JDK_DEFAULT=15
DJC_ARCH_64=true

To use JDK 1.6, replace "15" with "16".

Step 5: Start EAServer using the -arch64 flag. For example,

run-server.bat –jdk15 –rt15 –arch64 -jvmtype server
run-server.sh –jdk15 –rt15 –arch64 -jvmtype server (UNIX)

or

run-server.bat –jdk16 –rt16 –arch64 -jvmtype server 
run-server.sh –jdk16 –rt16 –arch64 -jvmtype server (UNIX)

http://java.sun.com/products/archive/j2se/5.0_15/index.html
http://java.sun.com/javase/downloads/ea/6u10/6u10rcDownload.jsp#6u10JDKs
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6.2.3 Errors occur when calling n-Tier application of EAServer with 64-bit JDK

In the following environment: EAServer 6.3.1.04 with 64-bit JDK + PB 11.5.1 Build 4011,
when calling the n-tier application in PB, the ConnectToServer and CreateInstance functions
return correct values, but when calling the NVO function, the following error occurs.

Error: CORBA System Exception: CORBA_UNKNOWN at line 19 in clicked event of object
 cb_1 of w_main.

When user runs the "N-Tier Support" feature in the Appeon Code Example demo, the
following error occurs.

Error -1
Execute component failed. Error message =
 java.lang.reflect.InvocationTargetException.

Cause: PBVM and component do not support 64-bit Java server.

Solution: Uninstall Appeon Server and EAServer, then install EAServer with 32-bit JDK,
and install the 32-bit version of Appeon for PowerBuilder. When installing EAServer, you
will be offered to install JDK or use an existing local JDK. If you select to install JDK from
EAServer, it will be a 32-bit JDK.

6.2.4 "Cannot find the language resource file (dblgzh11.dll, dblgen11.dll)"

On a 64-bit machine, when starting the 64-bit EAServer which will then automatically start
SAP ASA/SQL Anywhere, you receive an error related with SAP ASA/SQL Anywhere
"Cannot find the language resource file (dblgzh11.dll, dblgen11.dll)."

Cause: The error is caused by a bug in EAServer. The SAP ASA/SQL Anywhere installed
by EAServer has an extra sub-folder called client\lib32, and some DLL files (such as
dblgzh11.dll, dblgen11.dll) were placed to this folder instead of the \win32 folder (\win32
is where files are normally placed by the SAP ASA/SQL Anywhere independent setup
program). However, when EAServer is starting, it calls files under \win32, not under client
\lib32, when it cannot find files under \win32, it reports the error.

Solution: Copy the DLL files from the \ASA110\client\lib32 folder (not \lib64 folder,
though \lib64 folder also exists, but copying files from it cannot resolve the error) to the
\ASA110\win32 folder.

6.2.5 "Connection failed:..." error when installing EAServer in a 64-bit OS

When installing EAServer 6.3.1 in a 64-bit Windows 2008 OS, error occurs: "Connection
failed: dbicu libraries are required but not installed" or "Connection failed: Cannot convert
between requested character sets 'GBK' and 'UTF-8'".

Figure 6.2: dbicu libraries error
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Figure 6.3: Character error

Solution: Add the following two values to the Path environment variable: %JAGUAR%
\ASA110\client\lib32; %JAGUAR%\ASA110\client\lib64.

6.2.6 Cannot start EAServer Manager

Fail to start EAServer Manager.

Cause: EAServer Manager will not start when the CLASSPATH and/or PATH system
environment variables are too long. The EAServer batch files (serverstart.bat, jagmgr.bat,
etc.) configure the CLASSPATH environment variable. The Appeon installation program
adds several entries to these path variables, which can make it too long for EAServer
Manager to handle on some system configurations. When the CLASSPATH variable is over
260 characters, the batch files may fail, preventing EAServer Manager from starting properly.

Solution: There are three workarounds, the user can select one:

1. Usually the EAServer installation path is "C:\Program Files\Sybase\EAServer". If the
path is shortened (for example, "D:\EAServer"), the CLASSPATH variable length will be
reduced.

2. Use the Control Panel to edit the user and system CLASSPATH variables, and remove
unnecessary entries:

Step 1: In Windows launch System Properties from the Control Panel and navigate to the
Advanced tab.

Step 2: Click Environmental Variables, and find the CLASSPATH variable.

Step 3: Edit the CLASSPATH variable and reduce the length of the string to less than 260
characters.

It is recommended that you backup the Variable Value for the CLASSPATH before
modifying the variable, as this allows you to restore it later.

Step 4: Restart the computer.

3. Create a batch file for setting the CLASSPATH to include the necessary classes:

Step 1: Create a batch file called user_setenv.bat in the EAServer bin directory (%JAGUAR
%\bin). %JAGUAR% indicates the EAServer installation directory, for example, C:\Program
Files\Sybase\EAServer\.



Troubleshooting PowerBuilder and EAServer Appeon® for PowerBuilder® 2016

Troubleshooting Page 132

Step 2: In this file, set the CLASSPATH to include only those classes that you require and
that are not added to CLASSPATH in EAServer batch files.

For more information, refer to SAP's EAServer Troubleshooting Guide available at http://
sybooks.sybase.com/nav/base.do.

6.2.7 Starting EAServer fails

Unable to start EAServer.

Cause: The Message Service is configured in EAServer, but the message service database is
not running.

Solution: Either start the message service database, or disable the message service. For more
information, refer to the EAServer user documentation.

For more information, refer to SAP's EAServer Troubleshooting Guide available at http://
sybooks.sybase.com/nav/base.do.

6.2.8 EAServer cannot start with the prompt that "the system 'admin' password
has not yet been set"

Cause: You must set a valid password for EAServer 6.1, otherwise, errors will occur when
EAServer 6.1 is started, because EAServer 6.1 does not allow null password.

Figure 6.4: System password error message

Solution: Take the following steps to set password for EAServer 6.1:

Step 1: Run the following command in the DOS window. Note %EAServer% stands for the
installation path of the EAServer.

http://sybooks.sybase.com/nav/base.do
http://sybooks.sybase.com/nav/base.do
http://sybooks.sybase.com/nav/base.do
http://sybooks.sybase.com/nav/base.do
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%EAServer%\bin\set-admin-password.bat

Step 2: Input a password that has at least six characters combining both letters and numbers.

Step 3: Make sure you get the following message saying that the password is set successfully,
as shown in the following figure.

Figure 6.5: Password changed message

6.2.9 "Create appeon component failed" error

None of the DataWindows can be retrieved successfully when running the Appeon demos.
The error message is displayed as "Create appeon component failed".

Cause: Installing the XML option or EJB option for ASE sets a license restriction to
EAServer. If the XML option or EJB option for ASE is installed, when EAServer is started,
it shows "SAP Enterprise Application Server (ASE Edition)"; also the lmgrd.log file in the
SySAM directory lists ASE_EJB as an included option.

Solution: Remove the ASE_XMLMGMT key from the SySAM license manager and then
restart the manager.

6.2.10 Pinging data source fails when using the ASA/SQL Anywhere JDBC
driver

A data source is created but fails to function and creates an error beginning with "Ping of
Data Source failed¡-" The database uses SAP ASA/SQL Anywhere; iAnywhere JDBC-
ODBC Bridge Driver is used for the data source.

Cause: The ASA/SQL Anywhere JDBC driver and EAServer possibly fail to locate the
dbjodbc8.dll file.

Solution: Follow the suggested steps to rectify your problem.
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Step 1: Upgrade ASA/SQL Anywhere to ASA/SQL Anywhere 8.0.2 build 4361 or ASA/SQL
Anywhere 9.

Step 2: Navigate to \Sybase\SQL Anywhere 8\java\jodbc.jar, and copy the jodbc.jar file to the
%JAGUAR%\java\lib folder (Windows) or $JAGUAR/java/lib (UNIX).

Step 3: Navigate to \Sybase\SQL Anywhere 8\win32\dbjodbc8.dll, and copy the dbjodbc8.dll
file into the directory: \Sybase\Shared\jdkversion\ire\bin\. Jdkversion indicates which version
of JDK is used, for example, jdk1.2.2_10, jdk1.3.1_06, or jdk1.4.1_03.

Step 4: Restart EAServer.

Step 5: (Assuming that ase_odbc is the data source which is set up in ODBC
manager and used to connect to ASE database) The ServerName will be similar to
"jdbc:odbc:dsn=ase_odbc"

For more information, refer to SAP's EAServer Troubleshooting Guide available at http://
sybooks.sybase.com/nav/base.do.

6.2.11 Support for non-JDBC drivers

The Web application requires support for non-JDBC drivers.

Cause: Please refer to SAP's EAServer Troubleshooting Guide available at http://
sybooks.sybase.com/nav/base.do.

Solution: Appeon Server uses JDBC. You can also use Appeon Server with ODBC through
JDBC via the iAnywhere, Merant, and Sun drivers.

Appeon Server supports ASE & Oracle Native Drivers through n-Tier Appeon Server
Components by simply:

Step 1: Create an ASE or Oracle Native Data Source.

Step 2: Code a POWERBUILDER NVO that connects to the Native Data Source.

Step 3: Pass an Appeon Server result set or returning arguments to the Client web application
and back via the Appeon DataWindow/DataStore GetFullState, SetFullState, GetChanges,
and SetChanges. In string format instead of BLOB format since JavaScript does not support
the BLOB format.

For information about other possible solutions, refer to SAP's EAServer Troubleshooting
Guide.

6.2.12 Failed to create new data sources

Failed to create a new data source in Sybase Management Console, typically prompted
with the following error message "An error occurred while creating the new data source.
Exception was:javax.management.MBeanException."

Cause: The JDBC driver configuration that you performed before the data source creation
cannot automatically take effect if the EAServer is running as service.

Solution A: Use the foreground EAServer which runs in the console window.

Step 1: Stop the EAServer service from Control Panel > Administrative Tools > Services.

Step 2: Start the EAServer from the Start button or using command line.

http://sybooks.sybase.com/nav/base.do
http://sybooks.sybase.com/nav/base.do
http://sybooks.sybase.com/nav/base.do
http://sybooks.sybase.com/nav/base.do
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Step 3: Configure the data source again.

Solution B: Reinstall the EAServer service to make the JDBC configuration take effect.

Step 1: Stop the EAServer service

Step 2: Uninstall the EAServer service. Change to the EAServer bin subdirectory, and run
service [-servicename service] -remove command, substituting the service name for service.
For example,

C:\Program Files\Sybase\EAServer\bin service -servicename EAServer -remove

Step 3: Install the EAServer service. Stay in the bin folder and run the following command
line,and run service [-servicename service] -install command. For example,

C:\Program Files\Sybase\EAServer\bin service -servicename EAServer -install

Solution C: Manually configure the JDBC driver in the classpath parameter in winservice.ini
file. Take configuring oracle JDBC driver as an example.

1. Go to Administrative Tools > Services.

2. Find your EAServer service and open the Properties window. You can find the service ini
file path from Path to executable. For example,

""D:\Program Files\Sybase\EAServer6\bin\jsl.exe" -ini "D:\Program 
  Files\Sybase\EAServer6\bin\../config/winservice_EAServer.ini""

3. Open the INI file directory and add the path of the "ojdbc14.jar" file to the corresponding
line. For example,

param15 = c:\eas\eas61014\bin\..\lib\eas-server-14.jar;c:\eas\eas61014
  \bin\..\lib;c:\eas\eas61014\bin\..\ant\lib\ant.jar;
c:\eas\eas61014\Shared\jdk1.4.2_10\lib\tools.jar;
c:\eas\eas61014\bin\..\lib\fips\jdk14\sslplus_nio.jar;
c:\eas\eas61014\bin\..\lib\fips\jdk14\sslplus.jar;
c:\eas\eas61014\bin\..\lib\fips\jdk14\EccpressoFIPSJca.jar;
c:\eas\eas61014\bin\..\lib\fips\jdk14\EccpressoFIPS.jar;
d:\jaguar\PowerBuilder\pbjdbc12105.jar;c:\eas\eas61014
\PowerBuilder\pbjdbc12100.jar;
c:\eas\eas61014\PowerBuilder\pbejbclient100.jar;c:\eas\eas61014
\bin\..\genfiles\java\classes;
c:\eas\eas61014\bin\..\lib\ext\jconn3.jar;c:\eas\eas61014
\bin\..\lib\ext\jTDS3.jar;
c:\eas\eas61014\bin\..\lib\ext\pbejbclient100.jar;
c:\eas\eas61014\bin\..\lib\ext\pbejbclient105.jar;c:\eas\eas61014
\bin\..\lib\ext\pbjdbc12100.jar;
c:\eas\eas61014\bin\..\lib\ext\pbjdbc12105.jar;c:\eas\eas61014
\bin\..\lib\ext\ojdbc14.jar



Error Messages Appeon® for PowerBuilder® 2016

Troubleshooting Page 136

7 Error Messages

7.1 Error Message Formats
Appeon for PowerBuilder can send error messages, informational messages, warnings,
notices, and prompts when you perform the Web deployment and run the Appeon Web
applications. The messages will contain the following parts:

• Error number

A five-digit number that uniquely identifies the message.

• Priority

A one- or two-digit number that indicates the severity of the error condition.

• Error message

A string that contains information about the condition that generated the message.

• Possible Cause

A string that contains information about the possible cause for the error.

• Solution

A string that contains information about the solution. But not all of the errors return the
solution.

7.1.1 Error Message Numbers and Descriptions

An error message number is unique in identifying an error message and the error message
description reflects the problem. Some error message description includes placeholders for
information (such as object names) to be inserted in the error message when it is displayed.

In the Error Message column of the error table, a percent sign (%) followed by a character
serves as a placeholder; the specific data is supplied when the error message is generated. The
notation %d is a placeholder for a number; %ls (or %.*ls) is a placeholder for a string. For
example, the actual error message displayed for error 00053 might be:

Remove the garbage control %1 in the %2 object.

When you report an error to Appeon technical support engineers, it is important to include
error numbers, object types, and object names. Otherwise, it can be difficult and time-
consuming for the support engineers to render assistance in resolving the error message.

7.1.2 Error Message Priority

The priority of an error message provides an indication of severity level of problem that
Appeon has encountered. Appeon divides errors into 4 levels according to their severity:

Table 7.1: Error message properties

Error Level Severity Description

0 Not severe. The error has little impact to the functions of the application.
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Error Level Severity Description

1 Quite severe. The error is caused by incorrect configuration, and affects
the running of the application. For example, no data source is set for the
application.

2 Very severe. The error is caused by incompatibility with Appeon product.
For example, the specification of invalid Web URL.

10 Most severe. The error reflects a bug in the Appeon product.

7.2 Errors

7.2.1 Error 00001-09999

Table 7.2: Error list

Errors Priorities Error Messages

00001 1 Appeon Server profile name is empty.

00002 1 Appeon Server name is empty.

00003 1 Appeon Server port is empty.

00004 1 Appeon Server port is out of range.

00005 1 Failed to parse the source code. Line: %1

00006 1 AEM URL is empty.

00007 1 Deployment user name is empty.

00008 1 Data source name is empty.

00009 1 Data source name already exists.

00010 1 The database server is empty.

00011 1 Transaction object name is empty.

00012 1 No database type is specified for the transaction object.

00013 1 No data source is specified for the transaction object.

00014 1 Web server profile name is empty.

00015 1 Web server name is empty.

00016 1 Web server port is empty.

00017 1 Web server port is out of range.

00018 1 Web root is empty.

00019 1 The FTP server is empty.

00020 1 The Web server profile name already exists.

00021 1 FTP Port is incorrect.

00022 1 FTP Port is invalid.

00023 1 No selected ODBC data source.

00024 1 Failed to log into application server.

00025 2 Failed to get detailed information of the specified cache.
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Errors Priorities Error Messages

00026 2 Failed to add the transaction object.

00027 2 Failed to edit the transaction object.

00028 2 Failed to delete the data source.

00029 2 Failed to add the data source.

00030 2 Failed to edit the data source.

00031 1 Duplicate transaction object name.

00032 2 Failed to get the cache list from the application server.

00051 1 Failed to get object %1 from the memory stack.

00052 1 The child object %1 of %2 cannot find the parent object %3¡æ£æ

00053 2 Remove the garbage control %1 in the %2 object.

00054 1 Cannot find the container object %2 for %1.

00055 1 Cannot find %1 data type of %2 variable in %3.

00056 2 Cannot find the function object in the template using event ID %1.

00057 1 Failed to get Appeon Server information. Please verify Appeon
Server is running.

00901 1 Cannot connect to DSN. The database server is %1.

00902 1 Failed to get syntax of %1 DataWindow in %2.

00904 1 Failed to load the file: %1.

00905 1 Failed to save the file: %1.

00906 1 You need to configure a proper DB profile for the application before
deploying it.

01001 1 Failed to generate %1 %2.

01002 1 Failed to %1 %2.

01003 1 Failed to analyze %1 %2.

01004 1 It is unsupported to analyze %1 %2.

01005 1 Configuration for Web service object (%1) is incorrect.

01006 1 Error in loading XML file %1.

02002 2 Failed to initialize Appeon Server.

02003 1 Failed to instantiate Appeon Server.

02004 1 Exception: Format returned from Appeon Server is incorrect.

02005 1 Error in deploying %1 file.

02006 1 Failed to delete Web files.

02007 1 Cannot connect to the Web server: %1.

02010 1 Error in generating the WAR file.

02011 1 Unable to find the destination directory.

02012 1 Cannot connect to Appeon Server: %1.
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02013 1 Cannot open the connection.

03001 1 File %1 is invalid.

03002 1 File %1 is not found.

03003 1 Invalid registry information!

03004 1 Flow module is already loaded.

03501 1 Cannot find the PBL file.

03502 1 PBL files have been changed. Please re-deploy the application under
the debug mode.

03503 1 Files in the Web server are not updated. Please re-deploy the
application under the debug mode.

03504 1 The default Web server is not started. Please start Web server.

03505 1 The default Appeon Server is not started. Please start Appeon
Server.

03506 1 Web server configuration settings error. Please check and correct the
settings.

03507 1 Appeon Server configuration settings error. Please check and correct
the settings.

03508 1 No access rights to the Web server. Please check the Web server
permission settings.

03509 1 One or more files do not match. Please re-deploy the application
under the debug mode.

03510 1 Another Appeon Developer tool is running.

03511 1 The application deployed in the Encrypted mode cannot be
debugged.

04001 1 Failed to load the DLL file %1.

04002 1 Cannot find the SRD file %1.

04003 1 Cannot get Web server information from the ADTConfig.xml file.

04004 1 Cannot get Appeon Server information from the ADTConfig.xml
file.

04005 10 Failed to open Deploy.dll. Caused failure to load the deploy module.

04006 10 Failed to instantiate the deploy module.

09999 1 (Display the system error message.)

7.2.2 Error 10001-15055

Table 7.3: Error list

Errors Priorities Error Messages

10001 1 Cannot find the transaction object named %1 in sessions. Please
verify that the request is correct before send it out.
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Errors Priorities Error Messages

10014 2 Internal error. Please contact the system administrator.

10015 2 Error in connecting to AppeonDB.

10016 2 The running Appeon Server does not support the Appeon Xcelerator
deployment option in this version (version %1).

10501 2 Session is terminated by the Appeon system.

10502 2 Session is terminated by AEM.

10504 2 The Web application you attempt to run was removed from the
server. It cannot be run.

10505 2 Transaction has timed out. The transaction is rolled back: %1.

10506 2 Session failed.

10507 1 The server status is %1.

10999 1 Keyword not supported: 'dsn'.

10508 1 Session has timed out.

11001 1 Cannot find the cluster service provider!

11002 0 Error in reading the cluster service provider configuration file!

11006 1 A fatal IOException occurred when retrieving the status of the server
%1.

11007 0 The Appeon configuration file cannot be empty!

11008 1 A fatal IOException occurred when retrieving the configuration file
from the remote server: %1.

11009 0 A ClassNotFoundException occurred when casting the remote
Appeon configuration file content to a String array.

11010 0 An unexpected exception occurred when replicating Appeon
configuration files!

11011 0 A FileNotFoundException occurred when constructing the
FileOutputStream: %1.

11012 0 A SecurityException occurred when denying write access to the file:
%1.

11013 1 A fatal IOException occurred when writing %1 to the local disk.

11014 0 An unexpected exception occurred and caused failure to write
Appeon configuration files to the local disk!

11015 1 A fatal IOException occurred when communicating with servlet I/O.

11016 0 An unexpected Exception occurred and caused failure to read the
local Appeon configuration files!

11017 1 A fatal IOException occurred when reading the specified file: %1.

11020 0 A fatal IOException occurred when synchronizing the method: %1.
The remote server called is: %2.
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Errors Priorities Error Messages

11021 0 An unexpected exception occurred and caused failure to synchronize
the method: %1.

11022 1 A fatal IOException occurred when synchronizing method: %1!

11023 0 A ClassNotFoundException occurred when synchronizing method:
%1.

11024 0 An unexpected exception occurred and caused failure to synchronize
method: %1.

11025 1 A fatal IOException occurred when calling the specified remote
server: %1.

11026 0 An unexpected exception occurred and caused the ClusterNotify
thread to stop!

11027 1 An unexpected exception occurred and resulted in failure to retrieve
status of the server: %1.

11028 10 Application server connection error!

11029 10 Appeon Server is in the process to start. Please wait...

11030 10 The cluster list is empty. Failed to get the cluster information.

11501 0 Failed to clear the cluster configuration information from the
specified server %1!

11502 0 Failed to get session information from the specified server %1.

11503 0 Failed to get transaction information from the specified server %1.

11508 0 The Appeon Server is already configured in AEM.

11509 1 AEM could not interface with the specified Appeon Server. Please
verify that your Appeon Server is running and that the settings are
correct.

11510 0 The specified server has already been in another cluster.

11511 1 Failed to synchronize AEM settings on the following clustered
servers: %1. Please restart or remove these servers to ensure the
cluster runs normally!

11512 0 Error occurred when updating AEM settings on the local machine.
Please read the log for more details.

11513 0 Please add the IP address or name of the local Appeon Server first!

11514 0 Please enter the IP address or machine name of the Appeon Server.

11515 0 Please enter the port number of the Appeon Server.

11516 0 Please input a valid port number with a range from 0 to 65535.

11517 0 IP address or machine name cannot be localhost or 127.0.0.1!

11518 0 Please remove the local Appeon Server from the cluster last!

11519 0 The interval should be a positive integer, greater than 0 and less than
2147483648.
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Errors Priorities Error Messages

11520 0 You must select one option between "Enable Remote Backup" and
"Enable Local Backup".

11521 1 Errors occurred when synchronizing AEM configuration information
to the specified remote server: %1. The method is: %2.

11522 1 Errors occurred in calling the remote method. The method is: *; the
remote server is: *

11523 2 It exceeds the CPU count in the license.

11524 2 The license of the remote Appeon Server does not match with the
license on the local server.

11525 2 The license of the remote Appeon Server is not a cluster version.

12001 10 Failed to get the transaction information from the Appeon Server
configuration file (transaction object name = %1). Please make sure
you have configured this transaction object in AEM correctly.

12006 1 Failed to load the cluster configuration information from file!

12007 1 Failed to save the cluster configuration information into file!

12008 0 Application name is null.

12009 0 Property %1 has already been defined.

12010 0 Argument cannot be null or empty string.

12011 1 Error occurred when loading the application configuration file!

12012 1 Error occurred when loading the server configuration information!

12013 1 Error occurred when loading %1 file!

12014 1 Error occurred when reading the mapping file: %1!

12015 0 ServerConfig object is null.

12016 0 ApplicationsConfig is null.

12017 1 Errors occurred when writing the server-config.xml.

12018 1 Errors occurred when writing the application-config.xml.

12019 1 Errors occurred when loading application configuration!

12020 1 Failed to load the ServerConfig object!

12021 1 Failed to load the ThreadQueues Config object from file %1!

12022 1 Failed to load the mapping object of cluster-mapping.xml.

12025 1 The selected application %1 does not exist in the Appeon Server.

12026 2 The application number exceeds the license limit %1.

12501 10 Post data is null!

12502 10 Session is not found!

12503 10 Cannot read the Msg's total!

12504 10 Call parseAndExecuteCommand: Cannot read FuctionType!

12505 2 Authority is required!
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Errors Priorities Error Messages

12506 10 The input function type (%1) is invalid. No code can be found to
match this type!

12507 10 %1: Cannot read the parameter count!

12508 10 %1: Parameter count mismatch!

12509 10 %1: Cannot read the parameter length!

12510 10 %1: Cannot read the Parameter value!

12511 10 Appeon Server is in the process to start. Please wait...

13001 0 The original DataWindow parameters are not compatible with the
client parameters.

13002 0 Unsupported stored procedure syntax: %1.

13003 10 Unsupported PowerBuilder data type (type=%1).

13004 0 Cannot find the specified argument %1 in the argument list.

13005 0 Stored procedure syntax cannot be empty or null.

13006 0 Failed to analyze the stored procedure syntax, due to %1.

13007 0 Register parameter error: index = %1, jdbcType = %2, value = %3.

13008 0 Client parameter of the UpdateBlob statement cannot be null.

13009 0 Both the PB type and JDBC type of the parameter are invalid.

13010 10 DataObject name cannot be empty.

13011 0 This column's data type %1 requires the use of an embedded SQL
statement.

13012 0 User SQL cannot have parameters in Verify SQL Command.

13013 2 Failed to parse the result meta of the Select statement, due to %1.

13014 2 Failed to parse parameter meta of stored procedure, due to %1

13015 10 Failed to get DataWindow SQL from Appeon Server (Application =
%1, DataObject = %2, DBType = %3). Please make sure you have
deployed your application correctly.

13016 10 Cannot find the following embedded SQL in AppeonDB:
ApplicationName =%1 and SQLKey =%2.

13017 10 The value of Application Name is empty or null.

13018 10 The value of DataWindow Name is empty or null.

13019 10 The value of DWSyntaxString is empty or null.

13020 10 Call an unused method.

13021 10 Errors in deleting all DataWindows.

13022 1 The application %1 is being deployed by another user.

13023 10 The value for SqlKey cannot be empty or null.

13024 10 The value for embedded SQL cannot be empty or null.
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13025 2 Cannot find the following DataWindow syntax in AppeonDB:
ApplicationName =%1 and DataWindowName =%2.

13026 2 Parameter error: the value for %1 is empty or null.

13027 10 Unsupported database type. The DBMS code is %1.

13028 2 Blob or Clob variable for UpdataBlob cannot be empty.

14001 2 License has expired on %1.

14002 2 Unable to validate license key "%1". The number has exceeded the
limit of your current license.

14003 2 Error in validating license signature!

14004 2 Missing license file.

14005 2 Invalid software license file %1.

14006 2 Unable to validate the current license file.

14009 2 Error in validating hash code!

14016 2 The license file installed to the machine hosting Appeon Server
allows only %1 CPU(s), but %2 CPUs are detected.

14017 2 Appeon Server is configured for the network card with physical
address %1, but the network card on the Appeon Server is %2.

14018 2 Your Appeon Server %1-day trial license expired on %2.

14019 2 Cannot connect to AppeonDB. Appeon Server failed to start.

14020 2 The application cannot be run because the product license
information cannot be found.

14021 2 An error occurred when validating the license for cluster version.

14022 2 Server failed to start, because the CPU number exceeds the license
limit.

14023 2 The remote Appeon Server is not a cluster version.

14024 2 The license of the remote Appeon Server does not match with the
license of the local server.

14025 2 The license in use is for the %1 platform.

14026 2 The license is not for the application server %1.

14027 2 The current operating system is %1. But the license is for the
platform other than Windows, Solaris, AIX, Red-Linux, and HP-
Unix.

14028 2 The remote Appeon Server is a cluster version.

14501 10 System error.

14502 1 The specified HTTP header does not exist.

15001 2 Failed to connect to EAServer. Please check connection settings.

15002 2 Data source name cannot be null.

15003 2 Failed to add/modify data source.
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15004 2 Failed to get the specified data source information.

15005 2 Failed to delete the specified data source.

15006 2 Failed to refresh the specified data source.

15007 2 Failed to get all data source names.

15008 2 Failed to connect to WebLogic. Please check the connection settings.

15009 2 Failed to add the data source.

15010 2 Failed to modify the data source.

15011 2 Failed to get the specified data source information.

15012 2 Failed to delete the specified data source.

15013 2 Failed to refresh the specified data source.

15014 2 Failed to get all data source names.

15015 2 Failed to test the data source.

15016 2 Failed to test the data source.

15017 2 Failed to import NVO components.

15018 2 Failed to export NVO components.

15019 2 Failed to get all EAServer packages.

15020 2 Failed to get all components from the specified package.

15021 2 Failed to delete the specified component.

15022 2 Failed to import the AEM configuration settings.

15023 2 Failed to export the AEM configuration settings.

15051 2 Failed to add the transaction object.

15052 2 Failed to delete the transaction object.

15053 2 Failed to modify the transaction object.

15054 2 Failed to get all transaction objects.

15055 2 Failed to get the specified transaction object information.

7.2.3 Error 20001-20035

Table 7.4: Error list

Errors Priorities Error Messages

20001 2 RegMultiString, RegLink and RegBinary data are unsupported in the
server execution mode of RegistryGet. For more help, please consult
the Appeon Help.

20002 2 RegMultiString data are unsupported in the client execution mode
of RegistryGet. For more help, please consult the Appeon User
Documents.
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20003 2 RegMultiString data are unsupported in the client execution mode
of RegistrySet. For more help, please consult the Appeon User
Documents.

20004 2 The thread pool settings cannot have a value less then zero or a value
exceeding the maximum allowed number. For more help, please
consult the Appeon User Documents.

20005 2 The specified variable type is incorrect. For more help, please
consult the Appeon User Documents.

20006 2 The class name of the object to be created does not exist. For more
help, please consult the Appeon User Documents.

20007 2 No transaction object is specified when declaring cursor or stored
procedure. For more help, please consult the Appeon user document.

20008 2 when declaring cursor or stored procedure, DynamicStagingArea
object is not instantiated. For more help, please consult the Appeon
user document.

20009 2 You are not logged into the mail system yet! For more help, please
consult the Appeon user document.

20010 2 Transaction object is not connected. For more help, please consult
the Appeon user document.

20011 2 Transaction object is already connected. It cannot be connected
again. For more help, please consult the Appeon user document.

20012 2 Menu file is invalid. Failed to create the file! For more help, please
consult the Appeon user document.

20013 2 Cannot create the WSDLReader object. For more help, please
consult the Appeon user document.

20014 2 Failed to load the WSDL file. For more help, please consult the
Appeon user document.

20015 2 Cannot get the Service definition from the WSDL file. For more
help, please consult the Appeon user document.

20016 2 Cannot get the Port definition from the WSDL file. For more help,
please consult the Appeon user document.

20017 2 Cannot get the Operation definition from the WSDL file. For more
help, please consult the Appeon user document.

20018 2 Cannot get the Part definition from the WSDL file. For more help,
please consult the Appeon user document.

20019 2 Cannot get the definition of SoapClient from the WSDL file. For
more help, please consult the Appeon user document.

20020 2 Failed to initialize SoapClient. For more help, please consult the
Appeon user document.

20021 2 Failed to load DLL file. For more help, please consult the Appeon
user document.



Error Messages Appeon® for PowerBuilder® 2016

Troubleshooting Page 147

Errors Priorities Error Messages

20023 2 DataWindow description file does not exist. For more help, please
consult the Appeon user document.

20024 2 Failed to parse the DataWindow description file. For more help,
please consult the Appeon user document.

20025 2 Failed to apply data memory. For more help, please consult the
Appeon user document.

20026 2 Failed to parse SyntaxFromSQL. For more help, please consult the
Appeon user document.

20027 0 Cannot find the image file. For more help, please consult the Appeon
user document.

20028 2 Print error. For more help, please consult the Appeon user document.

20029 2 Failed to create RichText DataWindow. Incorrect information of
RichText control in the local system. For more help, please consult
the Appeon user document.

20030 2 Cannot parse the invalid RTF file. For more help, please consult the
Appeon user document.

20031 2 Information of InputField in RichText DataWindow is incomplete.
For more help, please consult the Appeon user document.

20032 2 Failed to print RichText DataWindow. No default printer in the local
machine. For more help, please consult the Appeon user document.

20033 2 Print Preview failed. No default printer in the local machine. For
more help, please consult the Appeon user document.

20034 2 InputField information does not match the DataWindow column
information. For more help, please consult the Appeon user
document.

20035 2 Settings of InputField location are incorrect. Need to adjust the
location. For more help, please consult the Appeon user document.

7.2.4 Solutions

7.2.4.1 Error 00001

Priority1

Error Message

Appeon Server profile name is empty.

Possible Cause

When configuring the Appeon Server profile, no profile name is provided.

7.2.4.2 Error 00002

Priority1
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Error Message

Appeon Server name is empty.

Possible Cause

When configuring the Appeon Server profile, no machine name or IP address of the Appeon
Server is provided.

7.2.4.3 Error 00003

Priority1

Error Message

Appeon Server port is empty.

Possible Cause

When configuring Appeon Server profile, no Appeon Server port is provided.

7.2.4.4 Error 00004

Priority1

Error Message

Appeon Server port is out of the valid range.

Possible Cause

The specified Appeon Server port is not between 1 and 65535.

7.2.4.5 Error 00005

Priority1

Error Message

Failed to parse the source code. Line: %1

Possible Cause

The PBL list added to the Appeon configuration is incomplete, or the object is defined in the
PBD file.

Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer > Appeon Profile
Configuration window is complete. 3) Verify that no reference is made to the object
defined in PBD.

7.2.4.6 Error 00006

Priority1

Error Message

AEM URL is empty.

Possible Cause
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When configuring the Appeon Server profile, the AEM URL is empty.

Solution

Please input the correct URL.

7.2.4.7 Error 00007

Priority1

Error Message

Deployment user name is empty.

Possible Cause

When configuring the Appeon Server profile, the deployment security is enabled, but no
deployment username is provided.

7.2.4.8 Error 00008

Priority1

Error Message

Data source name is empty.

Possible Cause

When configuring the data source, no data source name is specified.

7.2.4.9 Error 00009

Priority1

Error Message

Data source name already exists.

Possible Cause

When configuring the data source, the provided data source name already exists in the
Appeon Server.

7.2.4.10 Error 00010

Priority1

Error Message

The database server is empty.

Possible Cause

When configuring the transaction object, no database server address is provided.

7.2.4.11 Error 00011

Priority1

Error Message
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Transaction object name is empty.

Possible Cause

When configuring the transaction object, the transaction object name is not provided.

Solution

Please input the correct name of the transaction object.

7.2.4.12 Error 00012

Priority1

Error Message

No database type is specified for the transaction object.

Possible Cause

When configuring the transaction object, no database type is specified for it.

7.2.4.13 Error 00013

Priority1

Error Message

No data source is specified for the transaction object.

Possible Cause

When configuring the transaction object, no data source is assigned to it.

7.2.4.14 Error 00014

Priority1

Error Message

Web server profile name is empty.

Possible Cause

When configuring the Web server profile, no profile name is specified.

7.2.4.15 Error 00015

Priority1

Error Message

Web server name is empty.

Possible Cause

When configuring the Web server profile, no machine name or IP address of the Web server
is specified.

7.2.4.16 Error 00016

Priority1
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Error Message

Web server port is empty.

Possible Cause

Web server port is not specified when configuring the Web server profile.

Solution

Specify a valid Web server port.

7.2.4.17 Error 00017

Priority1

Error Message

Web server port is out of range.

Possible Cause

When configuring the Web server profile, the specified port is not between 1 and 65535.

7.2.4.18 Error 00018

Priority1

Error Message

Web root is empty.

Possible Cause

When configuring the Web server profile, the local file transfer is selected, but no Web root
is specified.

7.2.4.19 Error 00019

Priority1v

Error Message

The FTP server is empty.

Possible Cause

When configuring the Web server profile, the FTP file transfer is selected, but no FTP server
is specified.

7.2.4.20 Error 00020

Priority1

Error Message

The Web server profile name already exist.

Possible Cause

When configuring the Web server profile, the provided profile name already exists.



Error Messages Appeon® for PowerBuilder® 2016

Troubleshooting Page 152

7.2.4.21 Error 00021

Priority1

Error Message

FTP Port is incorrect.

Possible Cause

The FTP Port was not specified when configuring the Web server profile.

Solution

Specify a valid FTP port.

7.2.4.22 Error 00022

Priority1

Error Message

FTP Port is invalid.

Possible Cause

When configuring the Web server profile, the specified FTP port is not between 0 and
65535.

Solution

Specify a valid port ranging from 0~65535.

7.2.4.23 Error 00023

Priority1

Error Message

No selected ODBC data source.

Possible Cause

No data source is selected when configuring the ODBC interface.

Solution

Select a data source from the list.

7.2.4.24 Error 00024

Priority1

Error Message

Failed to log into application server.

Possible Cause

The user name and password used to connect to the application server are incorrect.

Solution

Provide the correct user name and password.



Error Messages Appeon® for PowerBuilder® 2016

Troubleshooting Page 153

7.2.4.25 Error 00025

Priority2

Error Message

Failed to get detailed information of the specified cache.

Possible Cause

Failed to get the detailed information of the specified cache from the application server.

7.2.4.26 Error 00026

Priority2

Error Message

Failed to add the transaction object.

Possible Cause

Failed to add a transaction object in the application server.

7.2.4.27 Error 00027

Priority 2

Error Message

Failed to edit the transaction object.

Possible Cause

Failed to edit a transaction object in the application server.

7.2.4.28 Error 00028

Priority 2

Error Message

Failed to delete the data source.

Possible Cause

Failed to delete a data source in the application server.

7.2.4.29 Error 00029

Priority 2

Error Message

Failed to add the data source.

Possible Cause

Failed to add a data source in the application server.

7.2.4.30 Error 00030

Priority 2
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Error Message

Failed to edit the data source.

Possible Cause

Failed to edit a data source in the application server.

7.2.4.31 Error 00031

Priority 1

Error Message

Duplicate transaction object name.

Possible Cause

A transaction object with the same name already exists.

Solution

Save the new transaction object with a different name.

7.2.4.32 Error 00032

Priority 2

Error Message

Failed to get the cache list from the application server.

Possible Cause

1) The network connection is unstable. 2) The application server shuts down.

7.2.4.33 Error 00051

Priority 1

Error Message

Failed to get object %1 from the memory stack.

Possible Cause

1) Appeon Developer failed to export the object. 2) The PBL list added to the Appeon
Developer configuration window is incomplete or the object is defined in the PBD file,
which causes the object to be ruined.

Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer | Appeon Profile
Configuration window is complete. 3) Verify that the script makes no reference to the object
defined in the PBD file.

7.2.4.34 Error 00052

Priority 1

Error Message
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The child object %1 of %2 cannot find the parent object %3.

Possible Cause

The PBL list added to the Appeon Developer configuration is incomplete or the script makes
reference to the object defined in the PBD file.

Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer | Appeon Profile
Configuration window is complete. 3) Verify that the script makes no reference to the object
defined in the PBD file.

7.2.4.35 Error 00053

Priority 2

Error Message

Remove the garbage control %1 in the %2 object.

Possible Cause

PowerBuilder object contains some garbage objects. Appeon Developer will automatically
remove these garbage objects. This is only a prompt. It will not affect the parsing result, and
you can disregard it.

7.2.4.36 Error 00054

Priority 1

Error Message

Cannot find the container object %2 for %1.

Possible Cause

1) Appeon Developer failed to export the object. 2) The PBL list added to the Appeon
Developer configuration window is incomplete or the script makes reference to the object
defined in the PBD file.

Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer | Appeon Profile
Configuration window is complete. 3) Verify that the script makes no reference to the object
defined in the PBD file.

7.2.4.37 Error 00055

Priority 1

Error Message

Cannot find %1 data type of %2 variable in %3.

Possible Cause

The PBL list added to the Appeon Developer configuration window is incomplete or the
script makes reference to the object defined in the PBD file.
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Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer > Appeon Profile
Configuration window is complete. 3) Verify that the script makes no reference to the
object defined in the PBD file.

7.2.4.38 Error 00056

Priority 2

Error Message

Cannot find the function object in the template using event ID %1.

Possible Cause

The event ID is not defined in the Appeon Developer template.

7.2.4.39 Error 00057

Priority 1

Error Message

Failed to get Appeon Server information.

Possible Cause

1) Appeon Server is not started. 2) Appeon Server Profile was configured incorrectly.

Solution

1) Start Appeon Server. 2) Verify that the Appeon Server Profile is configured correctly.

7.2.4.40 Error 00058

Priority 1

Error Message

Cannot find %1's ancestor object %2.

Possible Cause

The PBL list added to the Appeon Developer configuration window is incomplete or the
script makes reference to the object defined in the PBD file.

Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer > Appeon Profile
Configuration window is complete. 3) Verify that the script makes no reference to the
object defined in the PBD file.

7.2.4.41 Error 00059

Priority 1

Error Message

Cache name ""%1"" contains illegal characters.
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Possible Cause

Cache name can only contain a combination of letters, underscores ("_"), dot ("."), and
numbers.

7.2.4.42 Error 00060

Priority 1

Error Message

The database port for the data source exceeds the valid range.

Possible Cause

The port must range from 0 to 65535.

7.2.4.43 Error 00901

Priority 1

Error Message

Cannot connect to DSN. The database server is %1.

Possible Cause

Failed to connect to the database configured for the application.

Solution

Configure the database connection settings correctly and make sure that the connection test
is successful.

7.2.4.44 Error 00902

Priority 1

Error Message

Failed to get syntax of %1 DataWindow in %2.

Possible Cause

1) There are syntax errors in DataWindow. 2) The PBL file version does not match the
specified PowerBuilder version.

Solution

1) Full build the application in the PowerBuilder IDE. 2) Fix the syntax errors in
DataWindow. 3) Verify that the PBL file version is the same as the specified PowerBuilder
version.

7.2.4.45 Error 00904

Priority 1

Error Message

Failed to load the file: %1.

Possible Cause
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1) The file format is corrupt or the file is incomplete. 2) The login account has no read
permission on the file.

Solution

1) Delete the file and re-deploy the application. 2) Assign the read permission to the current
login user.

7.2.4.46 Error 00905

Priority 1

Error Message

Failed to save the file: %1.

Possible Cause

1) No disk space is available. 2) The current login user has no write permission on the file.

Solution

1) Prepare enough disk space. 2) Assign the write permission to the current login user.

7.2.4.47 Error 00906

Priority 1

Error Message

You need to configure a proper database connection for the application before deploying it.

Possible Cause

The application connects to databases and uses DataWindows, but no database connection is
configured.

Solution

Configure a proper DB profile in the application profiles configuration page.

7.2.4.48 Error 01001

Priority 1

Error Message

Failed to generate %1 %2.

Possible Cause

This error is caused by another error which occurred previously.

Solution

Please check the log file and fix the previous error.

7.2.4.49 Error 01002

Priority 1

Error Message

It is unsupported to generate %1 %2.
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Possible Cause

PowerBuilder source code contains some Appeon unsupported features.

Solution

Remove or workaround the Appeon unsupported features in the source code.

7.2.4.50 Error 01003

Priority 1

Error Message

Failed to analyze %1 %2.

Possible Cause

The PBL list added to the Appeon Developer configuration window is incomplete or the
script makes reference to the object defined in the PBD file.

Solution

1) Verify that the PBL list added to the Appeon Developer | Appeon Profile Configuration
window is complete. 2) Verify that the script makes no reference to the object defined in the
PBD file.

7.2.4.51 Error 01004

Priority 1

Error Message

It is unsupported to analyze %1 %2.

Possible Cause

The PowerBuilder object contains Appeon unsupported features.

Solution

View the unsupported features in the UFA report and remove or workaround them.

7.2.4.52 Error 01005

Priority 1

Error Message

Configuration for Web service object (%1) is incorrect.

Possible Cause

1) The Web service was not configured. 2) The WSDL file, service or port for the Web
server was configured incorrectly.

Solution

Specify the correct settings for Web service, including the WSDL file, service and port.

7.2.4.53 Error 01006

Priority 1
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Error Message

Error in loading XML file %1.

Possible Cause

The user erroneously modified or deleted the RuleTemplate.xml file under the Appeon
Developer directory.

Solution

Please reinstall Appeon Developer.

7.2.4.54 Error 02002

Priority 2

Error Message

Failed to initialize Appeon Server.

Possible Cause

Failed to open the adtconfig.xml file. adtconfig.xml is corrupt or modified manually.

7.2.4.55 Error 02003

Priority 1

Error Message

Appeon Server configuration is incorrect.

Possible Cause

adtconfig.xml is corrupt or manually modified.

Solution

Please re-configure the Appeon Server Profile in Appeon Developer.

7.2.4.56 Error 02004

Priority 1

Error Message

Format returned from Appeon Server is incorrect.

Possible Cause 1:

The Appeon Server version and the Appeon Developer version are not the same.

Solution 1:

Please use Appeon Server and Appeon Developer of the same version.

Possible Cause 2:

Certain DataWindow syntax has not been deployed successfully. This happens only for
very large applications with an excessive number of DataWindow SQL (say over 10,000) or
embedded SQL (say over 3,000).

Solution 2:
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Step 1: Adjust the value of the following parameters in the AppeonDev.ini file (located
under C:\Program Files\Appeon\Developer2016\ and will be copied to the "bin" folder of
application package by Appeon Package Wizard):

[DeployConfig]
BatchDWSynLen= 10000000
BatchDWSynNum= 200
BatchDWSqlNum= 500
BatchESqlNum=500

BatchDWSynLen specifies the length (in byte) of the DataWindow syntax, which when
reached the deployment tool will commit to Appeon Server at one time.

BatchDWSynNum specifies the number of DataWindow syntax, which when reached the
deployment tool will commit to Appeon Server at one time.

BatchDWSqlNum specifies the number of DataWindow SQL, which when reached the
deployment tool will commit to Appeon Server at one time.

BatchESqlNum specifies the number of embedded SQL, which when reached the
deployment tool will commit to Appeon Server at one time.

By increasing the value of the above parameters (typically BatchDWSqlNum and
BatchESqlNum) according to the number of DataWindow SQL and embedded SQL used
in your application, this will reduce the server calls so it eliminates the chance of failing
to commit certain syntax. If you have no idea of the number of DataWindow SQL and
embedded SQL, you can increment the value by 200 each time and then full deploy the
application to see if this error disappears.

Step 2: Modify the IIS web.config xml file.

Go to C:\Inetpub\wwwroot\appeon\AEM, and add the following code to the web.config
XML file. By default, the value of the Execution Timeout is 100 seconds, and the value
of the Max Request Length is 4096K. You can use larger values for these two properties
according to the specific needs.

..............

<system.web>

<httpRuntime executionTimeout="30000" maxRequestLength = "102400" />

<httpHandlers>

...............

Restart the IIS server to make this change take effect.

7.2.4.57 Error 02005

Priority 1

Error Message

Error in deploying %1 file.

Possible Cause

1) The file is not generated or deleted. 2) A file with the same name already exists and is
read-only. 3) The file is in use.
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Solution

Full deploy the application with the "Full Application Deployment" option in Appeon
Developer.

7.2.4.58 Error 02006

Priority 1

Error Message

Failed to delete Web files.

Possible Cause

1) The files on the Web server were modified to be Read-only. 2) The administrator
changed the permission. 3) The Web server is being used. 4) The Application Profile for this
application is removed.

Solution

Check that the Web files exist and are not read-only, and that the Web server is not being
used and the application profile is not removed from Appeon Developer.

7.2.4.59 Error 02007

Priority 1

Error Message

Cannot connect to the Web server: %1.

Possible Cause

1) The Web server IP, port, user name or password is incorrect. 2) The Web server Web root
is empty.

7.2.4.60 Error 02010

Priority 1

Error Message

Error in generating the WAR file.

Possible Cause

Appeon Developer is corrupted. Please reinstall Appeon Developer.

7.2.4.61 Error 02011

Priority 1

Error Message

Unable to find the destination directory.

Possible Cause

Cannot write to the Web server. Please contact the administrator and grant proper rights to
the login user.
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7.2.4.62 Error 02012

Priority 1

Error Message

Cannot connect to Appeon Server: %1.

Possible Cause

1) The server name, port or password is incorrect. 2) The Deployment Security setting in
AEM is enabled.

Solution

Please check that the Appeon Server server name and port. If deployment security in AEM
is enabled, you must also check the deployment username and password.

7.2.4.63 Error 02013

Priority 1

Error Message

Connection to Appeon Server is terminated.

Possible Cause

If the number of DataWindows exceeds 4000, deploying the DataWindow syntax under
Windows XP may encounter connection failure. Appeon Developer will resume the
connection after this error and the running of the Web application will not be affected.

Solution

Reducing the number of DataWindows to less than 2000 can totally eliminate this problem.

7.2.4.64 Error 03001

Priority 1

Error Message

File %1 is invalid.

Possible Cause

The file is destroyed or the file format is incorrect.

Solution

1) Re-deploy the application using the "Full Application Deployment" option in Appeon
Developer. 2) Reinstall Appeon Developer.

7.2.4.65 Error 03002

Priority 1

Error Message

File %1 is not found.

Possible Cause

The specified file does not exist.
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Solution

1) Re-deploy the application using the "Full Application Deployment" option in Appeon
Developer. 2) Reinstall Appeon Developer.

7.2.4.66 Error 03003

Priority 1

Error Message

Invalid registry information!

Possible Cause

The registry information is incorrect. For example, the format is incorrect, or the registry
information is incomplete.

Solution

Reinstall Appeon Developer.

7.2.4.67 Error 03004

Priority 1

Error Message

Flow module is already loaded.

Possible Cause

The flow module cannot be loaded repeatedly.

Solution

Close the program that is loading the flow module and then start the program again.

7.2.4.68 Error 03501

Priority 1

Error Message

Cannot find the PBL file.

Possible Cause

The PBL files have been deleted or moved to a different location.

Solution

Locate the correct PBL files and re-deploy the application.

7.2.4.69 Error 03502

Priority 1

Error Message

PBL files have been changed. Please re-deploy the application under the debug mode.

Possible Cause
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The PBL files on the local machine have been changed. But the files in the Web server are
not changed correspondingly and the debug information is not updated with these changes.

Solution

Re-deploy the application under the debug mode.

7.2.4.70 Error 03503

Priority 1

Error Message

Files in the Web server are not updated. Please re-deploy the application under the debug
mode.

Possible Cause

The PBL files on the local machine have been changed. But the files in the Web server are
not changed correspondingly and the debug information is not updated with these changes.

Solution

Re-deploy the application under the debug mode.

7.2.4.71 Error 03504

Priority 1

Error Message

The default Web server is not started. Please start Web server.

Possible Cause

Web server is not started.

Solution

Start Web server.

7.2.4.72 Error 03505

Priority 1

Error Message

The default Appeon Server is not started. Please start Appeon Server.

Possible Cause

Appeon Server is not started.

Solution

Start Appeon Server.

7.2.4.73 Error 03506

Priority 1

Error Message

Web server configuration settings error. Please check and correct the settings.
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Possible Cause

The port or name settings in the Web server configuration file is incorrect. Please check the
settings and test them.

Solution

Correct the configuration settings for the Web server.

7.2.4.74 Error 03507

Priority 1

Error Message

Appeon Server configuration settings error. Please check and correct the settings.

Possible Cause

The port or name settings in the Appeon Server configuration file is incorrect. Please check
the settings and test them.

Solution

Correct the configuration settings for the Appeon Server.

7.2.4.75 Error 03508

Priority 1

Error Message

No access rights to the Web server. Please check the Web server permission settings.

Possible Cause

The current user account cannot write to the Web server. Please use a different user account
or grant Write permission to the current user.

Solution

Enable the Write permission in the Web server.

7.2.4.76 Error 03509

Priority 1

Error Message

One or more files do not match. Please re-deploy the application under the debug mode.

Possible Cause

The debug information on the local machine do not match with the deployed file or other
unknown errors.

Solution

Deploy the application again under the debug mode.

7.2.4.77 Error 03510

Priority 1
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Error Message

Another Appeon Developer tool is running.

Possible Cause

When Appeon Debugger is started, it detects that another Appeon Developer tool is running.

Solution

Close the other Appeon Developer tool and start the Appeon Debugger again.

7.2.4.78 Error 03511

Priority 1

Error Message

The application deployed in the Encrypted mode cannot be debugged.

Possible Cause

When the application is deployed in the Encrypted mode, it cannot be debugged using the
Appeon Debugger.

Solution

Select the Debug mode and deploy the application again.

7.2.4.79 Error 04001

Priority 1

Error Message

Failed to load the DLL file %1.

Possible Cause

Appeon Developer is destroyed. Please reinstall Appeon Developer.

7.2.4.80 Error 04002

Priority 1

Error Message

Cannot find the SRD file %1.

Possible Cause

The SRD file for the DataWindow failed to generate.

7.2.4.81 Error 04003

Priority 1

Error Message

Cannot get Web server information from the ADTConfig.xml file.

Possible Cause
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The Web server information in the ADTConfig.xml file is ruined.

7.2.4.82 Error 04004

Priority 1

Error Message

Cannot get Appeon Server information from the ADTConfig.xml file.

Possible Cause

The Appeon Server information in the ADTConfig.xml is ruined.

7.2.4.83 Error 04005

Priority 10

Error Message

Failed to open Deploy.dll, hence failed to load the deploy module.

Possible Cause

The Deploy.dll file does not exist or the file is corrupt.

Solution

Replace with the correct Deploy.dll file. Or reinstall Appeon Developer.

7.2.4.84 Error 04006

Priority 10

Error Message

Failed to initialize the deploy module.

Possible Cause

The EonDeploy.dll file is not found or the file is corrupt.

Solution

Reinstall Appeon Developer.

7.2.4.85 Error 09999

Priority 1

Error Message

Possible Cause

The error messages returned from Windows OS, such as, Insufficient storage space,
Insufficient memory, etc.

7.2.4.86 Error 10001

Priority 1

Error Message
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Cannot find the transaction object named %1 in the current session.

Possible Cause

The transaction object is not configured in AEM.

Solution

Configure the transaction object in AEM. Refer to Appeon Server Configuration Guide for
detailed instructions.

7.2.4.87 Error 10014

Priority 2

Error Message

Internal error. Please contact the system administrator.

Possible Cause

1) The network environment is unstable, causing data to be incomplete and data protocol
errors. 2) Other unknown errors.

Solution

Contact the administrator and check the Appeon Server log files for detailed error
information. Or send the log files to Appeon technical support engineers.

7.2.4.88 Error 10015

Priority 2

Error Message

Error in connecting to AppeonDB.

Possible Cause

The JDK version is not 1.3 or above.

Solution

Check that the JDK version is 1.3 or above.

7.2.4.89 Error 10016

Priority 2

Error Message

The running Appeon Server does not support Web applications deployed in this version
(version = %1).

Possible Cause

The Appeon Server version and Appeon Developer version used to deploy the Web
application is not the same.

Solution

1) Use the Appeon Developer of the same version to deploy the application and use the
Appeon Server of the same version to run it. 2) Reinstall Appeon 5.0 for PowerBuilder.
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7.2.4.90 Error 10017

Priority 2

Error Message

Failed to connect to data source: %1. The cause is: %2.

Possible Cause

1) The database driver does not exist or the version is incorrect. 2) The settings for
connection URL or the driver are incorrect. 3) The user name and password is incorrect.

Solution

1) Check that the database driver exists and the version is compatible. 2) Check in the user
documents provided by the database driver vendor that the settings for URL and driver are
correct. 3) Check that the user name and password are correct. Specially check the cases and
spaces.

7.2.4.91 Error 10501

Priority 2

Error Message

Session is terminated by the Appeon system.

Possible Cause

The session has timed out. The session is inactive for the specified amount of time.

Solution

Specify a proper timeout period in AEM > Application > Timeout settings. A proper
timeout period would be 1.5 to 3 times of the operation interval.

7.2.4.92 Error 10502

Priority 2

Error Message

Session is terminated by AEM.

Possible Cause

The session is deleted in AEM by the system administrator.

Solution

Click Refresh in the IE toolbar and log in to the application again.

7.2.4.93 Error 10504

Priority 2

Error Message

The Web application you attempt to run was removed from the server. It cannot be run.

Possible Cause



Error Messages Appeon® for PowerBuilder® 2016

Troubleshooting Page 171

1) The application has been removed from the server. 2) The system is being updated.

7.2.4.94 Error 10505

Priority 2

Error Message

Transaction has timed out. The transaction is rolled back: %1.

Possible Cause

Transaction has timed out, due to a long transaction execution time.

Solution

1) Modify the source code and reduce the transaction execution time. 2) Increase the
transaction timeout period in AEM. However, if the time is set too long, the performance
will slow down because the database will be locked for a longer time.

7.2.4.95 Error 10506

Priority 2

Error Message

Session failed. Please run the application again.

Possible Cause

1) The server is restarted. 2) The session has timed out.

Solution

Please click Refresh on the IE toolbar and log in to the application again.

7.2.4.96 Error 10507

Priority 1

Error Message

The server status is %1.

Possible Cause

Server is still in the process of starting.

Solution

Please wait until server turns its status to "running".

7.2.4.97 Error 10508

Priority 1

Error Message

Session has timed out.

Possible Cause

The session has been idle for a specified amount of time.
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Solution

Increase the session timeout period in AEM, but do not set it too long. A long existing
session may cause security problems.

7.2.4.98 Error 10999

Priority 1

Error Message

Keyword not supported: 'dsn'.

Possible Cause

Appeon does not support using ODBC Driver to connect with the SQL Server database.

Solution

To resolve this, go to AEM, and change the ODBC driver to the Native Driver for SQL
server.

7.2.4.99 Error 11006

Priority 1

Error Message

A fatal IOException occurred when retrieving the status of the server %1.

Possible Cause

1) Cannot have I/O communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server are working, send the
log files on the local and remote machines to Appeon technical support engineers.

7.2.4.100 Error 11007

Priority 0

Error Message

The Appeon configuration file cannot be empty!

Possible Cause

The configuration file retrieved from the remote server is empty, due to a file transfer error.

Solution

1) Check that the network connection works normally. 2) Check that the Appeon Server is
running. 3) If both network and Appeon Server are working, send the log files on the local
and remote machines to Appeon technical support engineers.

7.2.4.101 Error 11008

Priority 1
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Error Message

A fatal IOException occurred when retrieving the configuration file from the remote server:
%1.

Possible Cause

1) Cannot have I/O communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server are working, send the
log files on the local and remote machines to Appeon technical support engineers.

7.2.4.102 Error 11009

Priority 0

Error Message

Failed to read the Sting array in the configuration file from the remote server.

Possible Cause

Cannot construct the object using the stream.

Solution

1) Check that the network can be connected. 2) Check that Appeon Server is running. 3)
If both network and Appeon Server are working, send the log files on the local and remote
machines to Appeon technical support engineers.

7.2.4.103 Error 11010

Priority 0

Error Message

An unexpected exception occurred when replicating Appeon configuration files!

Possible Cause

Failed to replicate the local configuration file due to an unknown error.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server are working, send the
log files on the local and remote machines to Appeon technical support engineers.

7.2.4.104 Error 11011

Priority 0

Error Message

Cannot find the file: %1.

Possible Cause
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The specified file does not exist on the server.

7.2.4.105 Error 11012

Priority 0

Error Message

An exception occurred when denying write access to the file: %1.

Possible Cause

This is a rarely occurred exception caused by enabling the Java security.

Solution

Please send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.106 Error 11013

Priority 1

Error Message

A fatal IOException occurred when writing %1 to the local disk.

Possible Cause

An IOException occurred when reading or writing the specified file.

Solution

1) Check that the specified file is not read-only. If it is read-only, reset it. 2) Please send the
log files to the Appeon technical support engineers.

7.2.4.107 Error 11014

Priority 0

Error Message

An unexpected exception occurred and caused failure to write Appeon configuration files to
the local disk!

Possible Cause

An unknown error occurred when writing the specified file to the local disk.

Solution

Please send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.108 Error 11015

Priority 1

Error Message

A fatal IOException occurred when communicating with servlet I/O.

Possible Cause

Cannot have I/O communication with the remote server through HTTP.
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Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) Send the log files on the local machine and the remote
server to the Appeon technical support engineers.

7.2.4.109 Error 11016

Priority 0

Error Message

An unexpected exception occurred and caused failure to read the local Appeon configuration
files!

Possible Cause

An unknown error occurred when reading the local configuration file.

Solution

Please send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.110 Error 11017

Priority 1

Error Message

An IOException occurred when reading the file: %1.

Possible Cause

An IOException occurred when reading the local configuration file.

Solution

Please send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.111 Error 11020

Priority 0

Error Message

An error occurred when synchronizing the method: %1. The remote server called is: %2.

Possible Cause

1. Cannot have I/O communication with the remote server using HTTP. 2. Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1. Check that the server is running and can be connected. 2. Check that Appeon Server
residing in the server is started. 3. If both network and Appeon Server work correctly, send
the log files on the local and the remote servers to the Appeon technical support engineers.

7.2.4.112 Error 11021

Priority 0
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Error Message

An unexpected exception occurred and caused failure to synchronize the method: %1.

Possible Cause

An unknown error occurred when synchronizing the AEM configuration settings on the
local Appeon Server to the remote Appeon Servers.

Solution

Send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.113 Error 11022

Priority 1

Error Message

A fatal IOException occurred when synchronizing method: %1!

Possible Cause

1) Cannot have I/O communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server work correctly, send
the log files on the local and the remote servers to the Appeon technical support engineers.

7.2.4.114 Error 11023

Priority 0

Error Message

A ClassNotFoundException occurred when synchronizing method: %1.

Possible Cause

Cannot construct the object by using the stream from Servlet.

Solution

Send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.115 Error 11024

Priority 0

Error Message

An unexpected exception occurred and caused failure to synchronize method: %1.

Possible Cause

An unknown error occurred when synchronizing sessions on the local Appeon Server from
the remote Appeon Servers.

Solution

Send the Appeon Server log files to the Appeon technical support engineers.
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7.2.4.116 Error 11025

Priority 1

Error Message

A fatal IOException occurred when calling the specified remote server: %1.

Possible Cause

1) Cannot have I/O communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server work correctly, send
the log files on the local machine and the remote server to the Appeon technical support
engineers.

7.2.4.117 Error 11026

Priority 0

Error Message

An unexpected exception occurred and caused the ClusterNotify thread to stop!

Possible Cause

An unknown error terminated the HTTP communication.

Solution

Send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.118 Error 11027

Priority 1

Error Message

An unexpected exception occurred and resulted in failure to retrieve status of the server: %1.

Possible Cause

An unknown exception caused the failure to get the server status.

Solution

Please send Appeon Server log files to the Appeon technical support engineers for in-depth
investigation.

7.2.4.119 Error 11028

Priority 10

Error Message

Application server connection error!

Possible Cause

The network is disconnected. Or the application server is shut down.
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Solution

Check that the network can be connected, and application server can be accessed.

7.2.4.120 Error 11029

Priority 10

Error Message

Appeon Server is in the process to start. Please refresh the page later.

Possible Cause

Appeon Server is in the "process to start" state, not in the "running" state.

Solution

Wait until Appeon Server turns to the "running" state.

7.2.4.121 Error 11502

Priority 0

Error Message

Failed to get session information from the specified server %1.

Possible Cause

1) Cannot have I/O communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server work correctly,
send the log files on the local and the remote machines to the Appeon technical support
engineers.

7.2.4.122 Error 11503

Priority 0

Error Message

Failed to get transaction information from the specified server %1.

Possible Cause

1) Cannot have I/O communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) Send the log files on the local machine and the remote
server to the Appeon technical support engineers.

7.2.4.123 Error 11509

Priority 1
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Error Message

AEM could not interface with the specified Appeon Server. Please verify that your Appeon
Server is running and that the settings are correct.

Possible Cause

1) Cannot have I/O communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) Send the log files on the local machine and the remote
server to the Appeon technical support engineers.

7.2.4.124 Error 11512

Priority 0

Error Message

Error occurred when updating AEM settings on the local machine. Please read the log for
more details.

Possible Cause

1) Cannot update the AEM new settings to the server because the configuration file is read-
only. 2) Cannot read or write the file because the file is corrupt.

Solution

1) Remove the Read-only property of files in the %Appeon Server%\AEM\config folder. 2)
Send the log files to the Appeon technical support engineers.

7.2.4.125 Error 11514

Priority 0

Error Message

Please enter the IP address or machine name of the Appeon Server.

Possible Cause

The IP address or machine name of the Appeon Server is not specified.

Solution

Input the IP address or machine name of the Appeon Server.

7.2.4.126 Error 11515

Priority 0

Error Message

Please enter the port number of the Appeon Server.

Possible Cause

The port number of the Appeon Server is not specified.
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Solution

Input the port number of the Appeon Server.

7.2.4.127 Error 11516

Priority 0

Error Message

Please input a valid port number with a range from 0 to 65535.

Possible Cause

The specified port number is out of the invalid range.

7.2.4.128 Error 11517

Priority 0

Error Message

IP address or machine name cannot be localhost or 127.0.0.1!

Possible Cause

IP address or machine name cannot be localhost or 127.0.0.1!

Solution

Please input the IP address or machine name.

7.2.4.129 Error 11519

Priority 0

Error Message

The interval should be a positive integer, greater than 0 and less than 2147483648.

Possible Cause

The specified interval is invalid.

Solution

Input the interval between 0 and 2147483648.

7.2.4.130 Error 11520

Priority 0

Error Message

You must select one option between "Enable Remote Backup" and "Enable Local Backup".

Possible Cause

If Heartbeat Backup is selected, you must select between "Enable Remote Backup" and
"Enable Local Backup"

Solution

Select "Enable Remote Backup" or "Enable Local Backup"
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7.2.4.131 Error 11521

Priority 1

Error Message

Errors occurred when synchronizing AEM configuration information to the specified remote
server: %1. The method is: %2.

Possible Cause

1) Cannot communicate with the remote server using HTTP protocol. 2) Exceptions in
calling methods in the remote server. Data cannot be returned.

Solution

1) Verify that the target server is running and can be connected. 2) Verify that the Appeon
Server residing on the target server is running. 3) If both network and Appeon Server work
correctly, send log files for the local machine and the target server to the Appeon technical
support engineers for in-depth investigation.

7.2.4.132 Error 11522

Priority 1

Error Message

Errors occurred in calling the remote method. The method is: *; the remote server is: *

Possible Cause

1) Cannot communicate with the remote server using HTTP protocol. 2) Exceptions in
calling methods in the remote server. Data cannot be returned.

Solution

1) Verify that the target server is running and can be connected. 2) Verify that the Appeon
Server residing on the target server is running. 3) Send log files for the local machine and
the target server to the Appeon technical support engineers for in-depth investigation.

7.2.4.133 Error 11523

Priority 2

Error Message

It exceeds the CPU count in the license.

Possible Cause

The number of CPUs on the current machine exceeds the CPU count specified in the license
file.

Solution

Please purchase a new license with more CPUs.

7.2.4.134 Error 11524

Priority 2
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Error Message

The license of the remote Appeon Server does not match with the license on the local server.

Possible Cause

The license of the remote Appeon Server does not match with the license on the local server.

Solution

Replace the license file in the remote Appeon Server with the license file on the local server.

7.2.4.135 Error 12001

Priority 10

Error Message

Failed to get the transaction information from the Appeon Server configuration file
(transaction object name = %1). Please make sure you have configured this transaction
object in AEM correctly.

Possible Cause

1) Transaction object is not configured in AEM. 2) The configuration file is corrupt.

Solution

Re-configure the transaction object in AEM.

7.2.4.136 Error 12008

Priority 0

Error Message

Application name is null.

Possible Cause

The value of application name passed to the method is null.

Solution

1) Check that the network can be connected. 2) Restart Appeon Server. 3) If the error still
occurs, send the log files to the Appeon technical support engineers.

7.2.4.137 Error 12009

Priority 0

Error Message

Property %1 has already been defined.

Possible Cause

The application name passed to the method already exists.

Solution

1) Check that the newly added application does not have the same name with the existing
application. 2) The network can be connected. 3) Restart Appeon Server. 4) If the error still
occurs, send the log files to the Appeon technical support engineers.



Error Messages Appeon® for PowerBuilder® 2016

Troubleshooting Page 183

7.2.4.138 Error 12010

Priority 0

Error Message

Argument cannot be null or empty string.

Possible Cause

The argument passed to the method is empty.

Solution

1) Check that the network can be connected. 2) Restart Appeon Server. 3) If the error still
occurs, send the log files to the Appeon technical support engineers.

7.2.4.139 Error 12011

Priority 1

Error Message

Error occurred when loading the application configuration file!

Possible Cause

Error occurred when loading the application configuration from the configuration file.

Solution

Check that ApplicationsConfig is not corrupt and the format is correct. Delete it if it is
corrupt or the format is incorrect.

7.2.4.140 Error 12012

Priority 1

Error Message

Error occurred when loading the server configuration information!

Possible Cause

Error occurred when loading the server configuration from the configuration file.

Solution

Check that ServerConfig is not corrupt and the format is correct. Delete it if it is corrupt or
the format is incorrect.

7.2.4.141 Error 12013

Priority 1

Error Message

Error occurred when loading %1 file!

Possible Cause

Error occurred when loading the server configuration from the configuration file.

Solution



Error Messages Appeon® for PowerBuilder® 2016

Troubleshooting Page 184

1. Check that ServerConfig exists and is not corrupt. If it does not exist or it is corrupt, copy
it from the other clustered machine. 2. Send the log files to the Appeon technical support
engineers.

7.2.4.142 Error 12015

Priority 0

Error Message

ServerConfig object is null.

Possible Cause

The argument passed to the method is empty.

Solution

1) Check that the network can be connected. 2) Restart Appeon Server. 3) If the error still
occurs, send the log files to the Appeon technical support engineers.

7.2.4.143 Error 12016

Priority 0

Error Message

ApplicationsConfig is null.

Possible Cause

The argument passed to the method is empty.

Solution

1) Check that the network can be connected. 2) Restart Appeon Server. 3) If the error still
occurs, send the log files to the Appeon technical support engineers.

7.2.4.144 Error 12017

Priority 1

Error Message

Errors occurred when writing the ServerConfig file.

Possible Cause

The ServerConfig file is corrupt.

Solution

Check that the file is intact. If it is corrupt, delete it.

7.2.4.145 Error 12018

Priority 1

Error Message

Errors occurred when writing the ApplicationsConfig file.
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Possible Cause

The ApplicationsConfig file is corrupt.

Solution

Check that the file is intact. If it is corrupt, delete it.

7.2.4.146 Error 12019

Priority 1

Error Message

Errors occurred when loading the application configuration.

Possible Cause

Exceptions occurred when loading the application configuration from the file.

Solution

1) Check that the file is not read-only. Reset it if it is read-only. 2) Send the log files to the
Appeon technical support engineers.

7.2.4.147 Error 12020

Priority 1

Error Message

Failed to load the ServerConfig object!

Possible Cause

Errors occurred when loading the server configuration from the configuration file.

Solution

1. Check that ServerConfig exist and is not corrupt. If it does not exist or it is corrupt, delete
it. 2. Send the log files to the Appeon technical support engineers.

7.2.4.148 Error 12021

Priority 1

Error Message

Failed to load the ThreadQueues Config object from file %1!

Possible Cause

Errors occurred when loading the ThreadQueues configuration from the configuration file.

Solution

1. Check that ServerConfig exist and is not corrupt. If it does not exist or it is corrupt, copy
it from the other clustered machine. 2. Send the log files to the Appeon technical support
engineers.

7.2.4.149 Error 12025

Priority 1
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Error Message

The selected application %1 does not exist in the Appeon Server.

Possible Cause

1) The Web application is undeployed. 2) The Web application is manually removed.

7.2.4.150 Error 12026

Priority 2

Error Message

The application number exceeds the license limit %1.

Possible Cause

The application number exceeds the maximum number allowed in license.

Solution

Purchase a valid Appeon for PowerBuilder edition.

7.2.4.151 Error 12027

Priority 0

Error Message

Error: AEMConfig is empty.

Possible Cause

The parameter passed into the method is empty.

Solution

Send the log files to the Appeon technical support engineers.

7.2.4.152 Error 12028

Priority 1

Error Message

Failed to write the web.config file.

Possible Cause

web.config is corrupt.

Solution

Check that the web.config file is intact. If it is corrupt, delete it.

7.2.4.153 Error 12029

Priority 0

Error Message

ConnectionCacheConfig is empty.

Possible Cause
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Errors in passing the internal parameters.

Solution

Send the log files to Appeon technical support engineers.

7.2.4.154 Error 12030

Priority 1

Error Message

Errors in writing the data-source.config file.

Possible Cause

The data-source.config file is corrupt.

Solution

Delete the file if it is corrupt.

7.2.4.155 Error 12501

Priority 10

Error Message

Post data is null!

Possible Cause

Network exceptions caused the data passed by Appeon Developer to be empty.

Solution

1) Re-deploy the application using Appeon Developer. 2) Check that the network is stable.

7.2.4.156 Error 12502

Priority 10

Error Message

Session is not found!

Possible Cause

1) The Appeon Developer version is different from the Appeon Server version. 2) An
invalid user calls the server interface.

Solution

Check that the Appeon Developer version and the Appeon Server version are the same.

7.2.4.157 Error 12503

Priority 10

Error Message

Cannot read the Msg's total!

Possible Cause
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The data format passed by Appeon Developer is incorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution

1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.158 Error 12504

Priority 10

Error Message

Call parseAndExecuteCommand: Cannot read FuctionType!

Possible Cause

The data format passed by Appeon Developer is incorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution

1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.159 Error 12505

Priority 2

Error Message

Authority is required!

Possible Cause

1) Deployment username and password were not configured in Appeon Developer. 2) The
Appeon Developer version and the Appeon Server version are different.

Solution

1) Check that the deployment user name and password are correctly configured in Appeon
Developer. 2) Check that the Appeon Developer version and the Appeon Server version are
the same.

7.2.4.160 Error 12506

Priority 10

Error Message

The input function type (%1) is invalid. No code can be found to match this type!

Possible Cause

The data format passed by Appeon Developer is incorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution

1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.
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7.2.4.161 Error 12507

Priority 10

Error Message

%1: Cannot read the parameter count!

Possible Cause

The data format passed by Appeon Developer is incorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution

1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.162 Error 12508

Priority 10

Error Message

%1: Parameter count mismatch!

Possible Cause

The data format passed by Appeon Developer is incorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution

1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.163 Error 12509

Priority 10

Error Message

%1: Cannot read the parameter length!

Possible Cause

The data format passed by Appeon Developer is incorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution

1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.164 Error 12510

Priority 10

Error Message

%1: Cannot read the Parameter value!
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Possible Cause

The data format passed by Appeon Developer is incorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution

1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.165 Error 12511

Priority 10

Error Message

Appeon Server is in the process to start. Please refresh the page later.

Possible Cause

Appeon Server is starting. AEM cannot be accessed.

Solution

Please wait until Appeon Server is started.

7.2.4.166 Error 13001

Priority 0

Error Message

The original DataWindow parameters are not compatible with the client parameters.

Possible Cause

The number of the original DataWindow parameters is different from the number of the
client parameters.

Solution

1) Check that the network can be connected. 2) Check that Appeon Server is started and
works properly. 3) If the error still occurs, send the Appeon log files and SQL statements to
the Appeon technical support engineers.

7.2.4.167 Error 13002

Priority 0

Error Message

Unsupported stored procedure syntax: %1.

Possible Cause

1) Errors in parsing the stored procedure. 2) The stored procedure syntax is unsupported.

Solution

Make sure that none of the following script is used: 1) execute sp_test
to_date( :ls_date ), :li_id ; // Argument contains functions 2) execute sp_test
"2001-02-12", :li_id + 100 ; // Argument contains expressions
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7.2.4.168 Error 13003

Priority 10

Error Message

Unsupported PowerBuilder data type: %1.

Possible Cause

Unsupported PowerBuilder data type is used.

Solution

1) Comment out the data type in the PowerBuilder source code. 2) Send the log files to the
Appeon technical support engineers.

7.2.4.169 Error 13004

Priority 0

Error Message

Cannot find the specified argument %1 in the argument list.

Possible Cause

When parsing the argument position in SQL statement, Appeon Developer failed to match
the SQL argument name with the argument name passed by the Appeon Xcelerator.

Solution

1) Check that the network is connected. 2) Check that Appeon Server is started and works
properly. 3) If the error still occurs, send the Appeon log files and SQL statements to the
Appeon technical support engineers.

7.2.4.170 Error 13005

Priority 0

Error Message

Stored procedure syntax cannot be empty or null.

Possible Cause

The stored procedure syntax passed by Appeon Xcelerator is empty or null.

Solution

Check whether the stored procedure is empty in the PowerBuilder source code. If it is
empty, it must be caused by an Appeon internal error, please send the Appeon log files and
SQL statements to the Appeon technical support engineers.

7.2.4.171 Error 13006

Priority 0

Error Message

Failed to analyze the stored procedure syntax, due to %1.

Possible Cause
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The stored procedure syntax is invalid or the syntax format is incorrect.

Solution

1) Verify that the stored procedure syntax is correct 2) Verify that the stored procedure is
supported by Appeon.

7.2.4.172 Error 13007

Priority 0

Error Message

Register parameter error: index = %1, jdbcType = %2, value = %3.

Possible Cause

The unsupported data type causes failure to register the parameter.

Solution

1) Check that the parameter type is supported by Appeon. 2) If the parameter type is
supported, ask the Appeon technical support engineers for help.

7.2.4.173 Error 13008

Priority 0

Error Message

Client parameter of the UpdateBlob statement cannot be null.

Possible Cause

The network is unstable or the Appeon Serve encountered exceptions which caused data
lost.

Solution

1) Check the network is connected. 2) Check that Appeon Server is started and works
properly. 3) If the error still occurs, send the log files to the Appeon technical support
engineers.

7.2.4.174 Error 13009

Priority 0

Error Message

The PB type of the parameter is invalid.

Possible Cause

1) The stored procedure does not exist in the database. 2) The stored procedure parameter
uses instance variables.

7.2.4.175 Error 13010

Priority 10

Error Message
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DataObject name cannot be empty.

Possible Cause

Appeon Server failed to get the DataObject name.

Solution

1) Check that the PowerBuilder source code is correct. 2) Check that the network is
connected. 3) Check that Appeon Server is starting and works properly.

7.2.4.176 Error 13011

Priority 0

Error Message

This column's data type %1 requires the use of an embedded SQL statement.

Possible Cause

The column in the SQL statement used to dynamically create a DataWindow contains
unsupported data type.

Solution

Check that the column data type can be used to create DataWindows and ensure that it can
be executed in the PowerBuilder

7.2.4.177 Error 13012

Priority 0

Error Message

User SQL cannot have parameters in Verify SQL Command.

Possible Cause

When using SetSQLSelect in the DataWindow to modify the SQL statement, SetSQLSelect
cannot contain parameters.

7.2.4.178 Error 13013

Priority 2

Error Message

Failed to parse the result meta of the Select statement, due to %1.

Solution

Please contact the Appeon technical support engineers and provide them with the log files.

7.2.4.179 Error 13014

Priority 2

Error Message

Failed to parse parameter meta of stored procedure, due to %1

Solution
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Please send log files to the Appeon technical support engineers.

7.2.4.180 Error 13015

Priority 10

Error Message

Failed to get DataWindow SQL from Appeon Server (Application = %1, DataObject = %2,
DBType = %3). Please make sure you have deployed your application correctly.

Possible Cause

Failed to get DataWindow SQL from AppeonDB, possibly because 1) AppeonDB is shut
down or failed to work. 2) The DataWindow has not been deployed correctly. View the
deploy log for the error. 3) The database type used by the PowerBuilder application and the
database type used by the Web application are not the same.

Solution

1) Check that AppeonDB is started and works properly. 2) Check that the DataWindow was
deployed successfully. 3) Check that the database type selected for deployment in Appeon
Developer and the database type selected for running in AEM are the same.

7.2.4.181 Error 13016

Priority 10

Error Message

Cannot find the following embedded SQL in AppeonDB: ApplicationName =%1 and
SQLKey =%2.

Possible Cause 1

The AppeonDB database is closed or failed to work.

Solution 1

Verify that AppeonDB works correctly.

Possible Cause 2

The embedded SQL has not been deployed successfully. This happens only for very large
applications with an excessive number of DataWindow SQL (say over 10,000) or embedded
SQL (say over 3,000).

Solution 2

Step 1: Adjust the value of the following parameters in the AppeonDev.ini file (located
under C:\Program Files\Appeon\Developer2016\ and will be copied to the "bin" folder of
application package by Appeon Package Wizard):

[DeployConfig]
BatchDWSynLen= 10000000
BatchDWSynNum= 200
BatchDWSqlNum= 500
BatchESqlNum=500

BatchDWSynLen specifies the length (in byte) of the DataWindow syntax, which when
reached the deployment tool will commit to Appeon Server at one time.
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BatchDWSynNum specifies the number of DataWindow syntax, which when reached the
deployment tool will commit to Appeon Server at one time.

BatchDWSqlNum specifies the number of DataWindow SQL, which when reached the
deployment tool will commit to Appeon Server at one time.

BatchESqlNum specifies the number of embedded SQL, which when reached the
deployment tool will commit to Appeon Server at one time.

By increasing the value of the above parameters (typically, BatchDWSqlNum and
BatchESqlNum) according to the number of DataWindow SQL and embedded SQL used
in your application, this will reduce the server calls so it eliminates the chance of failing
to commit certain syntax. If you have no idea of the number of DataWindow SQL and
embedded SQL, you can increment the value by 200 each time and then full deploy the
application to see if this error disappears.

Step 2: Modify the IIS web.config xml file.

Go to C:\Inetpub\wwwroot\appeon\AEM, and add the following code to the web.config
XML file. By default, the value of the Execution Timeout is 100 seconds, and the value
of the Max Request Length is 4096K. You can use larger values for these two properties
according to the specific needs.

..............

<system.web>

<httpRuntime executionTimeout="30000" maxRequestLength = "102400" />

<httpHandlers>

...............

Restart the IIS server to make this change take effect.

7.2.4.182 Error 13017

Priority 10

Error Message

The value for Application Name is empty or null.

Possible Cause

The Application Name argument passed from the client is empty.

Solution

Check that the application name and the deployment configuration are correct.

7.2.4.183 Error 13018

Priority 10

Error Message

The value of DataWindow name is empty or null.

Possible Cause
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The DataWindow Name argument passed from the client is empty.

Solution

1) Check that the DataWindow settings in Appeon Developer are correct. 2) Check that
Appeon Developer deployment process is successful. 3) Check that the network connection
is stable. 4) Check that Appeon Server is running and works properly.

7.2.4.184 Error 13019

Priority 10

Error Message

The value for DWSyntaxString is empty or null.

Possible Cause

The DWSyntaxString parameter values passed from the client are empty.

Solution

1) Check that the DB settings in Appeon Developer are correct. 2) Check that Appeon
Developer deployment process is successful. 3) Check that the network connection is stable.
4) Check that Appeon Server is running and works properly.

7.2.4.185 Error 13020

Priority 10

Error Message

Call an unused method.

Possible Cause

Call an obsolete method.

7.2.4.186 Error 13021

Priority 10

Error Message

Errors in deleting all DataWindows.

Possible Cause

Cannot delete the DataWindow syntax, possibly because 1) The AppeonDB database is
closed. 2) The parameter passed by Appeon Developer is incorrect.

Solution

1) Check that the network connection is stable. 2) Check that Appeon Server is running and
works correctly.

7.2.4.187 Error 13022

Priority 1

Error Message
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The application %1 is being deployed by another user.

Possible Cause

Another user is deploying an application with the same name to the same Appeon Server.

Solution

Please wait until the deployment is finished. If you want to terminate the deployment, delete
the deployment session in AEM.

7.2.4.188 Error 13023

Priority 10

Error Message

The value for SqlKey cannot be empty or null.

Possible Cause

The SQL Key passed from the client is empty.

Solution

1) Check that the Appeon Developer deployment process is successful. 2) Check that the
network connection is stable. 3) Check that Appeon Server is running and works correctly.

7.2.4.189 Error 13024

Priority 10

Error Message

The value for embedded SQL cannot be empty or null.

Possible Cause

Embedded SQL passed from the client is empty.

Solution

1) Check that the Appeon Developer deployment process is successful. 2) Check that the
network is stable. 3) Check that Appeon Server is running and works properly.

7.2.4.190 Error 13025

Priority 2

Error Message

Cannot find the following DataWindow syntax in AppeonDB: ApplicationName =%1 and
DataWindowName =%2.

Possible Cause

1) The AppeonDB database is closed. 2) The passed application name and SQLKey is
incorrect.

Solution

1) Check that the Appeon Developer deployment is successful. 2) Check that the network
is stable. 3) Check that Appeon Server is running and works properly. 4) If the error still
persists, ask the Appeon technical support engineers for help.
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7.2.4.191 Error 13026

Priority 2

Error Message

Parameter error: the value for %1 is empty or null.

Possible Cause

The first parameter passed from the client is empty. The application name, version type etc.
cannot be empty.

Solution

1) Check that the Appeon Developer deployment is successful. 2) Check that the network
is stable. 3) Check that Appeon Server is running and works properly. 4) If the error still
persists, ask the Appeon technical support engineers for help.

7.2.4.192 Error 13027

Priority 10

Error Message

Unsupported database type. The DBMS code is %1.

Possible Cause

Possibly because the database type dynamically set in PowerScript does not conform to the
Appeon conventions.

Solution

Refer to the Appeon Help for how to dynamically set database type.

7.2.4.193 Error 13028

Priority 2

Error Message

Blob or Clob variable for UpdataBlob cannot be empty.

Possible Cause

There is no parameter passed from the client or the passed parameter is null when executing
the UpdataBlob statement.

Solution

Verify that the argument is not empty or null.

7.2.4.194 Error 14001

Priority 2

Error Message

License has expired on %1.

Possible Cause

Trial license has expired.
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Solution

Please contact Appeon to purchase a proper license.

7.2.4.195 Error 14002

Priority 2

Error Message

Unable to validate license key "%1". The number has exceeded the limit of your current
license.

Possible Cause

The session number has exceeded the limit specified in the license file.

Solution

Kill other active sessions to make the session number within the license limit or contact
Appeon to purchase a more powerful edition.

7.2.4.196 Error 14003

Priority 2

Error Message

Error in validating license signature!

Possible Cause

The license file is incorrect due to some reasons.

Solution

Please provide us the following information to fix this issue.

1. Click the Activate button to generate the license.activation.bin file and send it to us.

2. Provide us the screenshot of the Licensing page.

3. Provide us the appeonserver.log and appeonerror.log files, here is the article stating how
to generate the log files: http://support.appeon.com/index.php?/Knowledgebase/Article/
View/50/11/what-you-can-provide-to-us-for-further-debugging-when-you-run-into-the-
appeon-server-related-issues.

7.2.4.197 Error 14004

Priority 2

Error Message

Missing license file.

Possible Cause

The license file is missing. The license file has been moved or deleted.

Solution

1. Please reinstall Appeon. 2. Please apply for a new license.
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7.2.4.198 Error 14005

Priority 2

Error Message

Invalid software license file %1.

Possible Cause

1. The license.appeon file is empty. 2. The license.appeon file is corrupt.

Solution

1. Check that license.appeon exists in the appeon\AEM\bin folder (eg. C:\Inetpub\wwwroot
\appeon\AEM) 2. Update the license file. 3. Please reinstall Appeon.

7.2.4.199 Error 14006

Priority 2

Error Message

Unable to validate the current license file.

Possible Cause

1. The license file is corrupt. 2. The license file is not for this Appeon version.

Solution

1. Please reinstall Appeon Server. 2. Update the license file.

7.2.4.200 Error 14009

Priority 2

Error Message

Error in validating hash code!

Possible Cause 1

The Appeon file is corrupt.

Solution 1

Please reinstall Appeon.

Possible Cause 2

The Windows system setting "System cryptography: use FIPS compliant algorithms for
encryption, hashing and signing" is enabled on the server machine. This setting is available
in Windows 7 and Windows Server 2008 only.

Solution 2

Please go to the Windows system setting: Local Security Policy > Security Options, and
disable the option "System cryptography: use FIPS compliant algorithms for encryption,
hashing and signing".

7.2.4.201 Error 14010

Priority 2
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Error Message

The user (%1) has no access rights to the application (%2).

Possible Cause

The user's access rights to the application were restricted in AEM by the administrator.

Solution

On the AEM > Application > Client Security page, assign the user with proper rights to
access the application.

7.2.4.202 Error 14016

Priority 2

Error Message

The license file installed to the machine hosting Appeon Server allows only %1 CPU(s), but
%2 CPUs are detected.

Possible Cause

The CPU number on the machine exceeds the maximum allowed number in the license file.

Solution

Please provide us the following information to fix this issue.

1. Click the Activate button to generate the license.activation.bin file and send it to us.

2. Provide us the license.appeon file you are currently using.

3. Provide us the screenshot of the Licensing page.

4. Provide us the appeonserver.log and appeonerror.log files, here is the article stating how
to generate the log files: http://support.appeon.com/index.php?/Knowledgebase/Article/
View/50/11/what-you-can-provide-to-us-for-further-debugging-when-you-run-into-the-
appeon-server-related-issues.

7.2.4.203 Error 14017

Priority 2

Error Message

The Server ID in your license is not match with the one on your server.

Possible Cause

The server ID does not match the one binding in the license file.

Solution

Case 1: If you transfer to different machine, then you need to follow up the license
re-activation process to provide us the license.reactivation.bin file which is generated
on the old machine as well as the license.activation.bin file generated on the new
machine, after that we will generate the correct permanent license file for your new
machine. Here is the help documentation stating the license re-activation process for
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your reference: http://www.appeon.com/support/documents/appeon_online_help/2016/
server_configuration_guide_for_j2ee/ch04s03s04.html#Re-activation.

Case 2: If you just use the virtual machine which cause the server ID to change or change
the network card, then please provide us the following information to move forward.

1. Run 'ipconfig /all' on your machine and then provide us the result.

2. Go to the Licensing page and click the Activate button to generate the
license.activation.bin file and send it to us.

7.2.4.204 Error 14018

Priority 2

Error Message

Your Appeon Server %1-day trial license expired on %2.

Possible Cause

The trial license has expired.

Solution

Please contact Appeon and purchase a proper license.

7.2.4.205 Error 14019

Priority 2

Error Message

Cannot connect to AppeonDB. Appeon Server failed to start.

Possible Cause

1. AppeonDB failed to start.

2. Several AppeonDB (a SQL Anywhere database) will be started as services in EAServer
5.5 Unix or Linux in a LAN. However, it is not allowed to start multiple SQL Anywhere
services as the same name in a LAN.

Solution

1. Restart Appeon Server and check whether errors are reported in the log files.

2. (EAServer 5.5 Unix/Linux only) Modify appeondb.sh; appeonSampledb.sh;
appeonSample2db.sh at the $EAServer$/bin folder, so to change the service name followed
after the "-n" parameter to a different one.

For example

//original content

if [ "X$JAGUAR_ASA9" != "X" ]; then
    if [ -f $JAGUAR_ASA9/bin/asa_config.sh ];then
       . $JAGUAR_ASA9/bin/asa_config.sh
    fi
    $JAGUAR_ASA9/bin/dbsrv9 -x tcpip\(serverport=6200\) -n appeonserver "$JAGUAR/
appeon/db/AppeonServer.db"
elif [ "X$JAGUAR_ASA8" != "X" ]; then
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    if [ -f $JAGUAR_ASA8/bin/asa_config.sh ];then
       . $JAGUAR_ASA8/bin/asa_config.sh
    fi
    $JAGUAR_ASA8/bin/dbsrv8 -x tcpip\(serverport=6200\) -n appeonserver "$JAGUAR/
appeon/db/AppeonServer.db"
elif [ "X$JAGUAR_ASA7" != "X" ]; then
    if [ -f $JAGUAR_ASA7/bin/asa_config.sh ];then
       . $JAGUAR_ASA7/bin/asa_config.sh
    fi
    $JAGUAR_ASA7/bin/dbsrv7 -x tcpip\(serverport=6200\) -n appeonserver "$JAGUAR/
appeon/db/AppeonServer.db"
elif [ "X$JAGUAR_ASA90" != "X" ]; then
    if [ -f $JAGUAR_ASA90/bin/asa_config.sh ];then
       . $JAGUAR_ASA90/bin/asa_config.sh
    fi
    $JAGUAR_ASA90/bin/dbsrv9 -x tcpip\(serverport=6200\) -n appeonserver "$JAGUAR/
appeon/db/AppeonServer.db"
elif [ "X$JAGUAR_ASA80" != "X" ]; then
    if [ -f $JAGUAR_ASA80/bin/asa_config.sh ];then
       . $JAGUAR_ASA80/bin/asa_config.sh
    fi
    $JAGUAR_ASA80/bin/dbsrv8 -x tcpip\(serverport=6200\) -n appeonserver "$JAGUAR/
appeon/db/AppeonServer.db"
fi

//modified content

If [ "X$JAGUAR_ASA9" != "X" ]; then
    if [ -f $JAGUAR_ASA9/bin/asa_config.sh ];then
            . $JAGUAR_ASA9/bin/asa_config.sh
    fi
    $JAGUAR_ASA9/bin/dbsrv9 -x tcpip\(serverport=6200\) -n appeonserver1 "$JAGUAR/
appeon/db/AppeonServer.db"
elif [ "X$JAGUAR_ASA8" != "X" ]; then
    if [ -f $JAGUAR_ASA8/bin/asa_config.sh ];then
            . $JAGUAR_ASA8/bin/asa_config.sh
    fi
    $JAGUAR_ASA8/bin/dbsrv8 -x tcpip\(serverport=6200\) -n appeonserver1 "$JAGUAR/
appeon/db/AppeonServer.db"
elif [ "X$JAGUAR_ASA7" != "X" ]; then
    if [ -f $JAGUAR_ASA7/bin/asa_config.sh ];then
            . $JAGUAR_ASA7/bin/asa_config.sh
    fi
    $JAGUAR_ASA7/bin/dbsrv7 -x tcpip\(serverport=6200\) -n appeonserver1 "$JAGUAR/
appeon/db/AppeonServer.db"
elif [ "X$JAGUAR_ASA90" != "X" ]; then
    if [ -f $JAGUAR_ASA90/bin/asa_config.sh ];then
            . $JAGUAR_ASA90/bin/asa_config.sh
    fi
    $JAGUAR_ASA90/bin/dbsrv9 -x tcpip\(serverport=6200\) -n appeonserver1
 "$JAGUAR/appeon/db/AppeonServer.db"
elif [ "X$JAGUAR_ASA80" != "X" ]; then
    if [ -f $JAGUAR_ASA80/bin/asa_config.sh ];then
            . $JAGUAR_ASA80/bin/asa_config.sh
    fi
    $JAGUAR_ASA80/bin/dbsrv8 -x tcpip\(serverport=6200\) -n appeonserver1
 "$JAGUAR/appeon/db/AppeonServer.db"
fi

7.2.4.206 Error 14020

Priority 2
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Error Message

The application cannot be run because the product license information cannot be found.

Possible Cause

Cannot find the license file.

Solution

Check that the license file exists in the Appeon Server installation directory.

7.2.4.207 Error 14022

Priority 2

Error Message

Server failed to start, because the CPU number exceeds the license limit.

Possible Cause

The CPU number exceeds the maximum allowed number in the license.

Solution

Purchase a new license with larger CPU number.

7.2.4.208 Error 14024

Priority 2

Error Message

The license of the remote Appeon Server does not match with the license of the local server.

Possible Cause

The license files on the remote Appeon Server and the local Appeon Server do not match.

Solution

Replace the license on the remote Appeon Server with the license on the local server.

7.2.4.209 Error 14025

Priority 2

Error Message

The license in use is for the %1 platform.

Possible Cause

Use an incorrect license file. For example, use a license for UNIX in Windows.

Solution

Please contact Appeon to have the correct license.

7.2.4.210 Error 14026

Priority 2
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Error Message

The license is not for the application server %1.

Possible Cause

Use an incorrect license file.

Solution

Please contact Appeon for the correct license.

7.2.4.211 Error 14027

Priority 2

Error Message

The current operating system is %1. But the license is for the platform other than Windows,
Solaris, AIX, Red-Linux, HP-Unix.

Possible Cause

The current platform is Windows, Solaris, AIX, Red-Linux, or HP-Unix. But the license is
not for this platform.

Solution

Please contact Appeon for the correct license.

7.2.4.212 Error 14028

Priority 2

Error Message

The remote Appeon Server is a cluster version.

Possible Cause

The license on the local server is not for cluster version, while the license on the remote
Appeon Server is for cluster version.

Solution

To use the Appeon cluster functionality, all servers in the cluster must use the same license.
You can replace the local license with the remote license, so all servers use the license
for cluster version. If you do not want to use the Appeon cluster functionality, replace the
remote license with the local license, so all servers use the license for single server version.

7.2.4.213 Error 14029

Priority 10

Error Message

The current user has no permission to write the local license file.

Possible Cause

The current login account does not have write permission to files under the system folder.

Solution
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Ask the administrator to assign proper rights to the current account or log in to the system
using another account with proper rights.

7.2.4.214 Error 14030

Priority 10

Error Message

The local license file has been destroyed.

Possible Cause

Failed to access the local license file, probably because the file does not exist or the user has
no permission to access it.

Solution

Ask the administrator to assign proper rights to the current account or log in to the system
using another account with proper rights.

7.2.4.215 Error 14031 (.NET only)

Priority 1

Error Message

The license data initialize failed.

Possible Cause

Fail to initialize Appeon license file if the proper permission of using .Net framework and
IIS server is not set.

Solution

Step 1: Execute the command line in a Windows prompt window:

            C:\WINDOWS\Microsoft.NET\Framework\2.0.**** aspnet_regiis -ga users
            C:\WINDOWS\Microsoft.NET\Framework\2.0.**** aspnet_regiis -i
            

Step 2: Grant proper rights to the Internet Guest Account and IIS Process Account so to
manipulate the Web Root folder.

1. Right click the C:\Inetpub\wwwroot folder, select the Properties items and select the
Security tab page;

2. Add IIS_WPG group if it is not listed in the box "Group or user names";

3. Grant Full Control permission to the IIS_WPG group.

7.2.4.216 Error 14032

Priority 2

Error Message

Failed to obtain the Server ID. Your Appeon Server will stop working in % days. Please
seek technical support in % days to resolve this issue.
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Possible Cause

There are two reasons below:

1. Appeon Server failed to find the network interface card address due to the malfunction of
the network interface card.

2. The network interface card address and the address in the license file don't match.

Solution

Please check whether the network interface card address and the address in the license
file match. If they don't match, please send the network interface card address to Appeon
technical support so that they can create a new license for you.

7.2.4.217 Error 14033

Priority 2

Error Message

Failed to obtain the Server ID. % days remain to fix the problem.

Possible Cause

There are two reasons below:

1. Appeon Server failed to find the network interface card address due to the malfunction of
the network interface card.

2. The network interface card address and the address in the license file don't match.

Solution

Please check whether the network interface card address and the address in the license
file match. If they don't match, please send the network interface card address to Appeon
technical support so that they can create a new license for you.

7.2.4.218 Error 14501

Priority 10

Error Message

System error.

Possible Cause

1. The application configuration is incorrect. 2. The file is corrupt or the disk space is
insufficient.

Solution

1. Check that no Appeon files are missing. Refer to Appeon Help for instructions if you
need to configure the application settings again. 2. Reinstall Appeon Server. 3. Check that
the available disk space is over 100 M.

7.2.4.219 Error 14502

Priority 1
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Error Message

The specified HTTP header does not exist.

Possible Cause

An incorrect parameter value is specified.

Solution

Verify that the parameter value is correct.

7.2.4.220 Error 15002

Priority 2

Error Message

Data source name cannot be null.

Possible Cause

Data source name is empty.

Solution

Specify the data source name.

7.2.4.221 Error 15003

Priority 2

Error Message

Failed to add/modify data source.

Possible Cause

The format of the configuration file for storing the data source information was destroyed.

Solution

Remove the configuration file of the data source.

7.2.4.222 Error 15004

Priority 2

Error Message

Failed to get the specified data source information.

Possible Cause

The format of the configuration file for storing the data source information was destroyed.

Solution

Remove the configuration file of the data source.

7.2.4.223 Error 15005

Priority 2
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Error Message

Failed to delete the specified data source.

Possible Cause

The format of the configuration file for storing the data source information was destroyed.

Solution

Remove the configuration file of the data source.

7.2.4.224 Error 15006

Priority 2

Error Message

Failed to refresh the specified data source.

Possible Cause

The format of the configuration file for storing the data source information was destroyed.

Solution

Remove the configuration file of the data source.

7.2.4.225 Error 15007

Priority 2

Error Message

Failed to get all data source names.

Possible Cause

The format of the configuration file for storing the data source information was destroyed.

Solution

Remove the configuration file of the data source.

7.2.4.226 Error 15009

Priority 2

Error Message

Failed to add the data source.

Possible Cause

The specified data source settings are incorrect.

Solution

Check that the input data source settings are correct.

7.2.4.227 Error 15010

Priority 2
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Error Message

Failed to modify the data source.

Possible Cause

The specified data source settings are incorrect.

Solution

Check that the input data source settings are correct.

7.2.4.228 Error 15011

Priority 2

Error Message

Failed to get the specified data source information.

Possible Cause

The specified data source settings are incorrect.

Solution

Check that the input data source settings are correct.

7.2.4.229 Error 15012

Priority 2

Error Message

Failed to delete the specified data source.

Possible Cause

The specified data source settings are incorrect.

Solution

Check that the input data source settings are correct.

7.2.4.230 Error 15013

Priority 2

Error Message

Failed to refresh the specified data source.

Possible Cause

The specified data source settings are incorrect.

Solution

Check that the input data source settings are correct.

7.2.4.231 Error 15016

Priority 2
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Error Message

Failed to test the data source.

Possible Cause

The specified data source settings are incorrect.

Solution

Check that the input data source settings are correct.

7.2.4.232 Error 15020

Priority 2

Error Message

Failed to get all components from the specified package.

Possible Cause

Exceptions occurred when getting all components from the specified package. Appeon
Server may encounter runtime errors.

Solution

1. Check that the input package settings are correct. 2. Contact the Appeon Server
administrator and make sure that Appeon Server runs correctly.

7.2.4.233 Error 15021

Priority 2

Error Message

Failed to delete the specified component.

Possible Cause

Exceptions occurred when deleting the specified component. Appeon Server may encounter
runtime errors.

Solution

1. Check that the input component settings are correct. 2. Contact the Appeon Server
administrator and make sure that Appeon Server runs correctly.

7.2.4.234 Error 15022

Priority 2

Error Message

Failed to import the AEM configuration settings.

Possible Cause

1) ApplicationsConfig does not exist. 2) ApplicationsConfig has an incorrect file format. 3)
ApplicationsConfig does not contain the settings for the current application.

Solution

Check that the application is correctly configured in AEM.



Error Messages Appeon® for PowerBuilder® 2016

Troubleshooting Page 212

7.2.4.235 Error 15023

Priority 2

Error Message

Failed to export the AEM configuration settings.

Possible Cause

1) ApplicationsConfig does not exist. 2) ApplicationsConfig has an incorrect file format. 3)
ApplicationsConfig does not contain the settings for the current application.

Solution

Check that the application is correctly configured in AEM.

7.2.4.236 Error 15051

Priority 2

Error Message

Failed to add the transaction object.

Possible Cause

1. ApplicationsConfig has an incorrect XML format. 2. ApplicationsConfig does not contain
the information for the current application.

Solution

1. Check that the ApplicationsConfig file is correct and intact. If the file is corrupt, delete it.
2. Provide the log files to the Appeon technical support engineers.

7.2.4.237 Error 15052

Priority 2

Error Message

Failed to delete the transaction object.

Possible Cause

ApplicationsConfig has an incorrect XML format.

Solution

1. Check that the ApplicationsConfig file is correct and intact. If the file is corrupt, delete it.
2. Provide the log files to the Appeon technical support engineers.

7.2.4.238 Error 15053

Priority 2

Error Message

Failed to modify the transaction object.

Possible Cause

1. ApplicationsConfig has an incorrect XML format. 2. ApplicationsConfig does not contain
the information for the current application.



Error Messages Appeon® for PowerBuilder® 2016

Troubleshooting Page 213

Solution

1. Check that the ApplicationsConfig file is correct and intact. If the file is corrupt, delete it.
2. Provide the log files to the Appeon technical support engineers.

7.2.4.239 Error 15054

Priority 2

Error Message

Failed to get all transaction objects.

Possible Cause

ApplicationsConfig has an incorrect XML format.

Solution

1. Check that the ApplicationsConfig file is correct and intact. If the file is corrupt, delete it.
2. Provide the log files to the Appeon technical support engineers.

7.2.4.240 Error 15055

Priority 2

Error Message

Failed to get the specified transaction object information.

Possible Cause

ApplicationsConfig has an incorrect XML format.

Solution

1. Check that the ApplicationsConfig file is correct and intact. If the file is corrupt, delete it.
2. Provide the log files to the Appeon technical support engineers.

7.2.4.241 Error 20001

Priority 2

Error Message

RegMultiString, RegLink and RegBinary data are unsupported in the server execution mode
of RegistryGet. For more help, please consult the Appeon Help.

Possible Cause

RegMultiString, RegLink and RegBinary data are unsupported in the server execution mode
of RegistryGet.

Solution

Use the supported data types, such as RegString, RegExpandString, RegULong,
RegULongBigEndian, to save the data.

7.2.4.242 Error 20002

Priority 2
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Error Message

RegMultiString data are unsupported in the client execution mode of RegistryGet. For more
help, please consult the Appeon User Documents.

Possible Cause

RegMultiString data are not supported in the client execution mode of RegistryGet.

Solution

Use the supported data types, such as RegString, RegExpandString, RegULong,
RegULongBigEndian, or RegBinary, to save the data.

7.2.4.243 Error 20003

Priority 2

Error Message

RegMultiString data are unsupported in the client execution mode of RegistrySet. For more
help, please consult the Appeon User Documents.

Possible Cause

RegMultiString data are not supported in the client execution mode of RegistrySet.

Solution

Use the supported data types, such as eRegString, eRegExpandString, eRegULong,
eRegULongBigEndian, eRegBinary, or RegLink to save the data.

7.2.4.244 Error 20004

Priority 2

Error Message

The thread pool settings cannot have a value less then zero or a value exceeding the
maximum allowed number. For more help, please consult the Appeon User Documents.

Possible Cause

The thread number configured in AEM is invalid.

Solution

Configure a proper thread number in AEM. Refer to  Appeon Server Configuration Guide
for help.

7.2.4.245 Error 20005

Priority 2

Error Message

The specified variable type is incorrect. For more help, please consult the Appeon User
Documents.

Possible Cause

When creating the proxy object, the variable type is not set to CORBA or NonVisualObject.



Error Messages Appeon® for PowerBuilder® 2016

Troubleshooting Page 215

Solution

Specify the variable type to CORBA or NonVisualObject when creating the proxy object.

7.2.4.246 Error 20006

Priority 2

Error Message

The class name of the object to be created does not exist. For more help, please consult the
Appeon User Documents.

Solution

1) Check that class name exists. 2) Check that the component was successfully deployed to
the server.

7.2.4.247 Error 20007

Priority 2

Error Message

No transaction object is specified when declaring cursor or stored procedure. For more help,
please consult the Appeon user document.

Possible Cause

1) The transaction object is not specified in the PowerBuilder source code. 2) The Appeon
Developer deployment contains errors.

Solution

1) Verify that the transaction object is specified in the PowerBuilder source code. 2) Verify
that the Appeon Developer deployment is successful.

7.2.4.248 Error 20008

Priority 2

Error Message

when declaring cursor or stored procedure, DynamicStagingArea object is not instantiated.
For more help, please consult the Appeon user document.

Possible Cause

When using Dynamic SQL Format 4, make sure to instantiate the DynamicStagingArea
object before declaring the cursor or stored procedure.

7.2.4.249 Error 20009

Priority 2

Error Message

You have not been logged into the mail system yet! For more help, please consult the
Appeon user document.
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Possible Cause

Use functions in the MailSession object when you have not been logged into the system or
login failed.

Solution

Use the MailLogon function to log in to the system.

7.2.4.250 Error 20010

Priority 2

Error Message

Transaction object is not connected. For more help, please consult the Appeon user
document.

Possible Cause

Commit or Rollback a transaction when the transaction object is not connected.

Solution

1) Check that the transaction object is connected. 2) Check that the transaction object is
configured in AEM.

7.2.4.251 Error 20011

Priority 2

Error Message

Transaction object is already connected. It cannot be connected again. For more help, please
consult the Appeon user document.

Possible Cause

Transaction object has already connected with the database while it is used to connect to the
database again.

Solution

Modify the PowerBuilder source code and avoid using a transaction object to connect the
database repeatedly.

7.2.4.252 Error 20012

Priority 2

Error Message

Menu file is invalid. Failed to create the file! For more help, please consult the Appeon user
document.

Possible Cause

The menu file is not a valid XML file. It may be corrupt. The Loadxml function failed to
work.

Solution
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1) Check that the menu file is a valid XML file. 2) Refer to Appeon Help and verify that no
unsupported features are used. 3) Re-generate the application and fix the errors if there are
any.

7.2.4.253 Error 20013

Priority 2

Error Message

Cannot create the WSDLReader object. For more help, please consult the Appeon user
document.

Possible Cause

1) SoapToolkit3.0 is not installed. 2) Memory is insufficient.

Solution

1) Install SoapToolkit3.0. 2) Close the other programs to release memory.

7.2.4.254 Error 20014

Priority 2

Error Message

Failed to load the WSDL file. For more help, please consult the Appeon user document.

Possible Cause

1) The specified WSDL file does not exist. 2) The network is unstable.

Solution

1) Check that the WSDL file is configured before deployment. 2) Check that the WSDL
file resides in the corresponding folder on Web server after deployment. 3) Check that the
network connection is stable.

7.2.4.255 Error 20015

Priority 2

Error Message

Cannot get the Service definition from the WSDL file. For more help, please consult the
Appeon user document.

Possible Cause

1) The WSDL file content is invalid 2) The WSDL file is incomplete.

Solution

1) Check that the WSDL file is correct. 2) Re-deploy the application using Appeon
Developer.

7.2.4.256 Error 20016

Priority 2
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Error Message

Cannot get the Port definition from the WSDL file. For more help, please consult the
Appeon user document.

Possible Cause

1) The WSDL file content is invalid. 2) The WSDL file is incomplete.

Solution

1) Check that the WSDL file is correct. 2) Re-deploy the application using Appeon
Developer.

7.2.4.257 Error 20017

Priority 2

Error Message

Cannot get the Operation definition from the WSDL file. For more help, please consult the
Appeon user document.

Possible Cause

1) The WSDL file content is invalid. 2) The WSDL file is incomplete.

Solution

1) Check that the WSDL file is correct. 2) Re-deploy the application using Appeon
Developer.

7.2.4.258 Error 20018

Priority 2

Error Message

Cannot get the Part definition from the WSDL file. For more help, please consult the
Appeon user document.

Possible Cause

1) The WSDL file content is invalid. 2) The WSDL file is incomplete.

Solution

1) Check that the WSDL file is correct. 2) Re-deploy the application using Appeon
Developer.

7.2.4.259 Error 20019

Priority 2

Error Message

Cannot get the definition of SoapClient from the WSDL file. For more help, please consult
the Appeon user document.

Possible Cause

SoapToolkit3.0 was not installed.

Solution
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Install SoapToolkit3.0.

7.2.4.260 Error 20020

Priority 2

Error Message

Failed to initialize SoapClient. For more help, please consult the Appeon user document.

Possible Cause

1) The specified WSDL file does not exist. 2) The specified WSDL file contains incorrect
values. 3) The network is unstable.

Solution

1) Check that the WSDL file exists and is correct. 2) Check that the WSDL file is
configured before deployment. 3) Check that the network connection is stable.

7.2.4.261 Error 20021

Priority 2

Error Message

Failed to load DLL file. For more help, please consult the Appeon user document.

Possible Cause

1) The DLL files were not deployed when the application was deployed. 2) The DLL file
was not downloaded to the correct location.

Solution

1) Check that the DLL files are configured for deployment before deploying the application.
2) Manually copy the file to the correct location.

7.2.4.262 Error 20023

Priority 2

Error Message

DataWindow description file does not exist. For more help, please consult the Appeon user
document.

Possible Cause

The DataWindow description file does not exist or the DataWindow description file was
removed.

Solution

Re-deploy the application and ensure that the DataWindow description file is correctly
deployed.

7.2.4.263 Error 20024

Priority 2
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Error Message

Failed to parse the DataWindow description file. For more help, please consult the Appeon
user document.

Possible Cause

The DataWindow template is not of the correct version or the DataWindow description file
is corrupt.

Solution

Check that the Appeon Developer deployment reports no errors.

7.2.4.264 Error 20025

Priority 2

Error Message

Failed to apply data memory. For more help, please consult the Appeon user document.

Possible Cause

There are many running programs which occupy large amount of memory. The memory left
is insufficient for applying the data memory.

Solution

Close the other programs.

7.2.4.265 Error 20026

Priority 2

Error Message

Failed to parse SyntaxFromSQL. For more help, please consult the Appeon user document.

Possible Cause

The stored procedure for the corresponding database has not been installed.

Solution

Check that the stored procedure for the corresponding database has been correctly installed
before dynamically creating the DataWindow. For detailed instructions, refer to Appeon
Server Configuration Guide for .NET or Appeon Server Configuration Guide for J2EE.

7.2.4.266 Error 20027

Priority 0

Error Message

Cannot find the image file. For more help, please consult the Appeon user document.

Possible Cause

1) The image file was not correctly uploaded to the server. 2) The image file cannot be
found on the specified local directory.

Solution
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1) Check that the image file location settings in Appeon Developer are correct and that the
image file exists on the local machine. 2) Redeploy the application using Appeon Developer.

7.2.4.267 Error 20028

Priority 2

Error Message

Print error. For more help, please consult the Appeon user document.

Possible Cause

No printer is installed on the local machine or the default printer does not work.

Solution

Check that the printer works correctly.

7.2.4.268 Error 20029

Priority 2

Error Message

Failed to create RichText DataWindow. Incorrect information of RichText control in the
local system. For more help, please consult the Appeon user document.

Possible Cause

The riched20.dll file does not exist in the system32 folder or riched20.dll is not registered.

Solution

Check that the riched20.dll file exists in the system32 folder and has been registered.

7.2.4.269 Error 20030

Priority 2

Error Message

Cannot parse the invalid RTF file. For more help, please consult the Appeon user document.

Possible Cause

The format file information in the source code of RichText DataWindow has been manually
modified.

Solution

Re-create the RichText DataWindow. Avoid manually changing the RTF file in the source
code.

7.2.4.270 Error 20031

Priority 2

Error Message

Information of InputField in RichText DataWindow is incomplete. For more help, please
consult the Appeon user document.
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Possible Cause

The InputField information in the source code of RichText DataWindow has been manually
modified.

Solution

Re-create the RichText DataWindow. Avoid manually changing the RTF text in the source
code.

7.2.4.271 Error 20032

Priority 2

Error Message

Failed to print RichText DataWindow. No default printer in the local machine. For more
help, please consult the Appeon user document.

Possible Cause

No printer is installed on the local machine or no default printer is set.

Solution

Set a printer as the default printer on the local machine.

7.2.4.272 Error 20033

Priority 2

Error Message

Print Preview failed. No default printer in the local machine. For more help, please consult
the Appeon user document.

Possible Cause

No printer is installed on the local machine or no default printer is set.

Solution

Set a printer as the default printer on the local machine.

7.2.4.273 Error 20034

Priority 2

Error Message

InputField information does not match the DataWindow column information. For more help,
please consult the Appeon user document.

Possible Cause

The InputField information in the source code of the RichText DataWindow has been
manually modified.

Solution

Re-create the RichText DataWindow and avoid manually changing the InputField name in
RTF in the source code.
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7.2.4.274 Error 20035

Priority 2

Error Message

Settings of InputField location are incorrect. Need to adjust the location. For more help,
please consult the Appeon user document.

Possible Cause

The InputField location in the source code of RichText DataWindow has been manually
modified. This is an invalid operation.

Solution

Re-create the RichText DataWindow. Avoid manually changing the element location of
RTF documents in the source code.

7.2.4.275 Error 20037

Priority 2

Error Message

Failed to write to the INI file! Verify that the current user account has access to the
Windows system directory. For more help, please consult the Appeon user document.

Possible Cause

The current user account has no access right to the Windows system directory.

Solution

Use an account with proper rights to log in to the Windows or ask the administrator to
assign proper rights to the current account.

7.2.4.276 Error 20038

Priority 2

Error Message

RegMultiString, RegLink and RegBinary data is not supported in server execution mode of
RegistrySet. For more help, please consult the Appeon user document.

Possible Cause

RegMultiString, RegLink and RegBinary data is not supported in server execution mode of
RegistrySet.

Solution

Change the server execution mode to the client mode in AEM.
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8 Technical Support
If your Appeon for PowerBuilder copy is directly purchased from Appeon Limited, please
contact our Technical Support at support@appeon.com for help. Please be prepared to
provide the following files listed in the following table to Appeon Technical Support. This
will aid debugging.

Table 8.1: Files for technical support

File Type File Name

Application Server
Configuration File

For EAServer:

<EASERVER>\Repository\Instance\com\sybase\djc\server
\ApplicationServer\{INSTANCE_NAME}.properties

<EASERVER>\\bin\run_server.bat

<EASERVER>\\bin\djc-setenv.bat

For WebLogic:

<WL_Domain>\setEnv.sh

<WL_Domain>\startWebLogic.sh

<WL_Domain>\config.xml

<WL_Domain> indicates the domain path of WebLogic
server.

For WebSphere:

<WAS_HOME>\startServer.sh

<WAS_HOME> indicates the home directory of WebSphere
server.

For JEUS:

<JEUS_HOME>\bin\jeus.properties.cmd

<JEUS_HOME>\jeus.cmd

<JEUS_HOME>\datasources.xml

<JEUS_HOME> indicates the installation path of JEUS.

For JBoss:

<JBOSS_HOME>\bin\run.bat

<JBOSS_HOME>\bin\run.conf

<JBOSS_HOME>\bin\service.bat

All XML files in the <JBOSS_HOME>\server
\<instancename>\conf folder.

<JBOSS_HOME> indicates the home path of WildFly or
JBoss EAP application server.

Application server log file For EAServer:

mailto:support@appeon.com
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File Type File Name
<EASERVER>\logs \ {INSTANCE_NAME} .log

For WebLogic:

<WL_Domain>\mydomain.log and all <WL_Domain>
\mydomain.log* files

* indicates the sequence number of the log files.

For WebSphere:

All files in the <WAS_HOME>\logs\server1 folder

For JEUS:

All files in the <JEUS_HOME>\logs folder.

For JBoss:

All files in <JBOSS_HOME>\server\<instancename>\log
folder.

Appeon Server configuration
file

For Appeon Server installed to EAServer, WebLogic,
WebSphere, JBoss or JEUS:

All files in the <appeonserver>\repository\<instancename>
\config folder.

For Appeon Server installed to IIS:

All files in the <appeonserver>\AEM\config folder.

<appeonserver> indicates the Appeon Server installation
path.

Appeon Server log file For Appeon Server installed to EAServer, WebLogic,
WebSphere, JBoss or JEUS:

All files in the <appeonserver>\repository\<instancename>
\log folder.

For Appeon Server installed to IIS:

All files in the <appeonserver>\AEM\Log folder.

<appeonserver> indicates the Appeon Server installation
path.

Appeon Server Repository
DB

For Appeon Server installed to EAServer:

<appeonserver>\db\AppeonServer.db

For Appeon Server installed to WebLogic, WebSphere,
JBoss or JEUS:

<appeonserver>\repository\<instancename>\db
\appeondb.script

For Appeon Server installed to IIS:

All files in the <appeonserver>\AEM\db folder.
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File Type File Name
<appeonserver> indicates the Appeon Server installation
path.

Appeon license file Appeon Server installed to EAServer, WebLogic,
WebSphere, JBoss, and JEUS:

<appeonserver>\license.appeon

For IIS:

<appeonserver>\AEM\bin\license.appeon

Web Server configuration file httpd.conf

Web Page file Web Server path\application name\window name.html

Web Server path\application name\window name.js

Web Server path\application name\all DataWindows on
window.xml

Note: If the window named includes inheritance, then also
supply all ancestors.html and ancestors.js files.

PowerBuilder exported
source code file

PowerBuilder application path\exported window name.srw

PowerBuilder application path\exported DataWindow
names.srd

Note: Exported windows should include exported ancestor
windows and exported ancestor user objects.
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Index
Symbols

"ADT is already running" error, 24
"Are you sure you want to navigate away
from this page?" warning message, 67
"Automation server could not create object"
error on some clients, 58
"Bad interpreter: No such file or directory"
error, 20
"Cannot find the language resource file
(dblgzh11.dll, dblgen11.dll)", 130
"com.sybase.jaguar.util.JException:
[Microsoft][SQLServer 2000 Driver for
JDBC]Error establishing socket.", 116
"Component Not Registered" error, 28
"Connection failed:..." error when installing
EAServer in a 64-bit OS, 130
"Could not Initialize JavaVM!", 65
"Create appeon component failed" error, 133
"Create Session failed", 56
"DLL function call crashed" error when
launching an Appeon setup program, 2
"EonToolset60 Load resource failed", 68
"Error converting data type A to B", 76
"Error launching LoadConfig", 25, 38
"Error loading ADTObjectList.xml", 26
"Error loading command string", 26, 39
"Error occurred while creating an object
instance" on the status box, 66
"Error opening DLL Library adtxml.dll for
external function" Error, 28
"Error: Failure in adding an application to
[Server Name]", 40
"Error: Failure in exporting XML file", 37
"Error: Unable to upload INI file", 41
"Exception at: CString CparseEngine...", 39
"Fail to analyze application" and "Fail to
analyze Menu Object A in the B application"
Errors, 40
"Failed to get DataWindow syntax from
Appeon Server", 65
"Failed to get resource from Appeon Server"
error, 48
"Failed to invoke remote procedure" error, 57
"Failed to load the remote interface" error,
100
"Failed to transfer command", 39

"java.sql.SQLException:[Microsoft][ODBC
SQL Server Driver]Connection is busy with
results for another hstmt " Error when using
the Microsoft SQLServer database, 117
"License error: 10999 ..." when starting
Appeon Server in 64-bit OS, 128
"Load application failed", 57
"Object doesn't support this property or
method" Error, 58
"ORA-01461" error in AEM when test a data
source, 117
"oracle 9i failed: System.Data.OracleClient
requires Oracle client software version 8.1.7
or greater", 118
"Predefined error_message pfc_dwdberror",
67
"Remote connection failed:
java.io.IOException: Message data for non-
existent channel", 97
"Script Debugger Component Not Found"
error, 28
"Script Debugger Disabled" error, 29
"Stack overflow error", 65
"Table already exists" error, 102
"Table or view not found" error, 101
"The XML page cannot be displayed" when
opening a UFA report, 25
"This application has requested the Runtime
to terminate it in an unusual way" error,
when you deploy or analyze an application,
27
"Unable to cast object of type 'System.String'
to type 'System.Byte[]'", 42
"Unable to validate current license file.
Please reinstall Appeon Server", 50

A
AEM cannot access WebSphere data sources
when global security is on, 97
AEM cannot interface with a particular
Appeon Server, 99
AEM Web page cannot display or cannot
display correctly in IE 9, 82
An item which usually requires one click
must be clicked twice to be selected, 81
Appeon Debugger, 28
Appeon Developer Configuration, 25
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Appeon Developer toolbar does not respond
when run by a non-administrator, 24
Appeon File Server Installation Incomplete,
20
Appeon Performance Analyzer continually
popping up, 77
Appeon Server, 93
Appeon Server Cluster, 123
Appeon Server is dead when dynamically
creating a DataWindow, 98
Appeon Server responds to user requests
slowly, 99
Appeondb is not started when EAServer
starts, 102
ASA/SQL Anywhere engine crashes when
you insert data into AppeonDB, 80
ASE Chained mode issue, 78

B
Blob data cannot be correctly manipulated if
it over 4MB, 73

C
Cannot connect to DSN, 34
Cannot log into AEM in IE 10, 82
Cannot start EAServer Manager, 131
Cannot update Transaction Objects for
WebLogic servers, 63
Corrupt Chinese characters are displayed in a
DataWindow, 59

D
Data missing in some DataWindows, 72
Data operation, 69
Data range issue with n-Tier NVOs, 127
Database lock, 72
DataWindows do not respond, 73
Demo Web application fails to call EJB
component, 67
Demo Web applications do not load in
Internet Explorer, 53
Deployment Performance, 32
Display errors, 59
Distributed DataWindows are not displayed,
59
DropDownDataWindow value incorrectly
selected, 67
DropDownListBox does not display
completely, 60

E
EAServer 6.x startup error, 118
EAServer cannot be started after Appeon
Server install, 16
EAServer cannot start with the prompt that
"the system 'admin' password has not yet
been set", 132
EAServer issues, 127
Empty/Null value update error if SQL
Anywhere/ASE, 100
Enable 32-bit .NET framework on 64-bit
Windows, 13
Error "500 Servlet jspservlet: ...", 92
Error "Connect EAServer failed" when
loading Appeon demo applications, 54
Error "Could not read object", 40
Error "Create instance failed" when loading
n-Tier NVO Web applications, 55
Error 00001-09999, 137
Error 10001-15055, 139
Error 10999 - Failed to start new
transaction..., 93
Error 10999 - Keyword not supported: 'dsn',
62
Error 1155, 2
Error 14004 "The license file is missing", 21
Error 1607 or 1628, 1
Error 20001-20035, 145
Error 404 - File or directory not found, 63
Error converting data type varchar to
datetime, 117
Error Message Formats, 136
Error Message Numbers and Descriptions,
136
Error Message Priority, 136
Error occurs when running Distributed
DataWindow in Appeon Code Examples
Demo, 68
Errors occur when calling n-Tier application
of EAServer with 64-bit JDK, 130
Exiting Appeon Developer completely after
an error, 25
Extra space or padding between MDI client
area and toolbar, 61

F
Fail to log into AEM with the default user
name and password, 92
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Fail to parse the result meta of the Select
statement, 75
Fail to ping appeondb data source, 102
Fail to ping appeonsample data source, 109
Fail to ping data sources for SQL Server
2000, 116
Fail to pre-compile AEM, 92
Fail to start Appeon Server on JEUS, 119
Fail to update data, 75
Fail to update DataWindows with newly
entered Korean characters, 76
Fail to update dynamically generated
DataWindow, 75
Failed to create new data sources, 134
Failed to deploy applications, 32
Failed to deploy applications in server
console, 33
Failed to deploy Web applications in 64-bit
JEUS server, 34
Failed to generate DWSQL, 34
Failed to initialize Appeon Weblibrary
Component, 52
Failed to install the Download Center plug-
in, 51
Failed to manually download Appeon
ActiveX, 51
Failed to update database due to
java.sql.SQLException... cannot insert the
value NULL..., 75
Failure in Incremental Deployment, 38
Feature Analysis, 25
Feature Analysis and deployment freezes, 40
Feature analysis or deployment comes to a
standstill, 27
Frequently Asked Questions, 21
Full access rights to IIS Web root, 11

H
How much better is the performance when
multiple instances are used?, 22
How to bind server instance to CPU?, 21
How to create EAServer instances?, 22
How to install Appeon Server to multiple
EAServer instances?, 21
How to locate problematic objects in an
application, 36
How to solve the messy code issue when
retrieving data in Oracle, 76

How to start the server instance?, 22
Http 404 not found error occurs when using
WebSphere as the Application Server, 64

I
IE 7 reports "Internet Explorer cannot open
the Internet site. Operation aborted." Error,
48
IE browser fails to open Web applications,
53
IE shows "done" status and then stays blank,
43
IIS 6.0, 4, 15
IIS 7.0 or 7.5, 3, 13
IIS configuration, 3
Install Appeon File Server, 20
Install Appeon Server to .NET IIS, 3
Install Appeon Server to EAServer, 16
Install Appeon Server Web Component, 20
Install Appeon Workspace, 17
InstallShield Errors, 1
IWA issues, 77

J
JBoss console hangs during startup process,
97
JBoss console reports #...Stopped
deployment appeonserver.jar...# error, 96
JDBC/ODBC TDS data type discrepancy on
SQL Anywhere, 100

L
Launch Web applications, 43
Library used incorrectlyLibrary used
incorrectly, 122
Loading AEM, 82
Loading application is slow when Appeon
Cluster works in virtual machines, 123

M
Manipulation on BLOB files, 73
Manipulation on BLOB files for Adaptive
Server Enterprise (ASE), 74
Manipulation on BLOB files for SQL
Anywhere, 74
MDI windows do not display in full, 61

N
Nested reports over 50 rows do not display,
60
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Nested reports over five pages do not
display, 60, 127

O
Object reference not set to an instance of an
object, 90
Others, 77

P
Package Tool, 29
Pinging data source fails when using the
ASA/SQL Anywhere JDBC driver, 133
PowerBuilder issues, 127
Procedure 'appeon_procdataobjects' not
found, 118

R
Receiving "Server busy" error, 66
Retrieved data does not display in
DataWindows, 69
Retrieving data is slow when Appeon Cluster
works in virtual machines, 123
Runtime issues, 62

S
Security settings in AEM do not take effect,
93
SelectBlob and UpdateBlob have different
results for non-binary fields, 76
Server Error in '/Servlet' Application, 82
Server NVO cannot be activated when the
Web application is running, 80
Source Code Export process aborts with a
fatal error, 36
Special characters in URL cause missing
parameters when being redirected, 81
Starting EAServer fails, 132
Status Monitor exits after restarting Appeon
Server for WebLogic in Linux, 121
Support for non-JDBC drivers, 134

T
Task 1: Application Source Code Export, 34
Task 2: Application File Generation, 38
Task 3: Application Deployment, 40
Testing connection fails during DB Type
Profile configuration, 25
Text displays in large size and is cut off, 62
Text does not display or text is grayed out,
60

The AEM Web page cannot be displayed, 92
The data source test will fail if the Shared
memory is checked, 121
The SQL statement cannot perform correctly
when the Web server is separated from the
Appeon Server, 68
Third-party Web Server problems with the
SAP Sybase redirector plug-in, 20
Troubleshooting Appeon Developer, 24
Troubleshooting Appeon Install, 1
Troubleshooting Appeon Server, 82
Troubleshooting PowerBuilder and
EAServer, 127
Troubleshooting Web Applications, 43
Troubleshooting Web Deployment, 32
Truncated display of data or controls in a
DataWindow or Window, 61

U
Unable to display the double-byte characters,
62
Unable to retrieve data from database, 70
Unable to write to FTP Server: "Error:
Unable to find the destination directory", 41
Unusual deployment duration, 32
Upgrade Installation, 20, 24
Upgrading to a different Build of
PowerBuilder, 127

W
Warning 61537, 38
Web application deployment to remote
servers does not work, 41
Web application does not run when the
database is disconnected by exception, 100
Web application is very slow if use SQL
Anywhere 10 and Appeon Server for .NET,
79
Web applications do not load in Internet
Explorer, 53
Weblibrary and cedownloadcenter DLLs
cannot be updated, 81
Window loses focus of I-beam cursor, 66
Windows open relatively slow, 79
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